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Chapter 1 – Getting Started

Introduction

The Myriad Manager application is part of the standard Myriad suite of 
products and is installed with automatically alongside all derivations of the 
Myriad Playout system. The primary role of Myriad Manager is to provide a 
separate management interface to allow you to view and extract key 
information about your Myriad system and the way it is being used as well as 
the Users who have access to your system. The key roles for Myriad Manager 
are summarised below:

 Rip / Import Audio In To Myriad – Myriad Manager offers access to 
the Myriad Audio Import Wizard which is used to one or more audio 
Cart in to the Myriad Audio Wall from either a music CD inserted in to 
the PC’s CD-ROM drive or audio data files from a local or network 
drive.

 Cart Reports – Cart Reports allow you to get summary reports about 
the Carts on your Audio Wall. You can run pre-configured Cart 
Reports, add new Cart Reports and conduct ‘one off’ custom reports.

 Audio Play Log Reports – You can get detailed reports about the 
Carts that you Myriad system has played using this facility in Myriad 
Manager. You can add use the pre-defined report, add custom reports 
and run ‘one off’ reports so see who’s playing what on your system.

 Copyright Reports – Generate detailed reports for copyright agencies 
such as PRS / PPL in the UK. These reports are based on Myriads 
play logs so they are always accurate (well except for music you play 
off CD etc).

 Contacts / Users – Manage the users on your Myriad system, assign 
access rights and contact details for the people who use Myriad at your 
station.

 User History – Spy ‘big brother’ style on what the users of your Myriad 
system are doing. Myriad tracks a number of key movements and 
events in Myriad and keeps an extensive database which allows you to 
browse through what people are doing with your system.

 Web Sites – You can add and maintain a list of web sites that you can 
then browse to in Myriad Manager. These web sites are then visible in 
some other P Squared products such as Scoop Edit.

 Myriad Menu System – Myriad Manager also offers access to many of
the menu options you will find in Myriad which allow you to customise 
the way Myriad looks and works on a ‘per user’ basis as well as 
configure the system. You can also access the Myriad Audio Wall and 
play Carts using the built in Cart Players.
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Myriad Manager is not designed to be used by general presenters but rather 
is intended as a powerful management tool for your station’s management 
staff or trusted presenters. Although Myriad Manager goes out of it’s way to 
aid you when you are working with it’s powerful features, it is important to 
keep in mind that some of the facilities the system offers can have a profound 
effect on your system (mass delete anyone?) and should be treated with 
respect.

The Myriad Manager General Screen Layout

The Myriad Manager general layout is very similar to Myriad and other P 
Squared products such as AutoTrack Pro and Scoop so if you are familiar 
with Myriad or any of our other products, you should find your way around 
fairly easily. The diagram below shows the general layout of the Myriad 
Manager screen along with a brief description of what each area is used for.
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In brief, the role of each of these areas is outlined below:

 Audio Tab – The Audio Tab offers access to four main Audio Wall 
related reporting tools. These are:

o Import Audio Wizard – provides access to the import audio 
wizard which is used to import one or more audio files from a 
data source, or to rip one or more tracks from an audio CD in 
the computers CD-ROM drive.

o Cart Reports – Provides a range of reports regarding the Carts 
that are stored on your systems Audio Wall. These reports can 
be customised and the saved for future use and the report 
results are displayed in the Audio Reports window which also 
offers access to a number of mass manipulation tools such as 
mass moving or changing of Carts and mass deleting.

o Audio Play Logs Reports – This section allows you to gather 
information about the Carts that have been played using your 
Myriad system. Reports can be customised and saved for future 
use. This facility also makes producing a ‘chart’ of the most (or 
least) played Cart on your system.

o Copyright Reports – Finally, you can generate specialist play 
reports formatted for copyright report agencies such as PRS / 
PPL in the UK. These reports are based on actual play 
information in Myriad and include any copyright details that are 
entered on the Carts that have been played.

 Contacts / Users – The Contacts and Users tab performs two primary 
roles. Firstly it is used to add, review and maintain the Users on your 
Myriad system (and other P Squared products), allowing you to set the 
various user permissions and access within Myriad. The second role is 
to allow you to maintain a shared contact directory that expands 
beyond the Users on the system to include all of the important contact 
details for your station. The contacts element is not used so much in 
Myriad but is used extensively in Scoop.

 Web Sites – The Web Sites section allows you to manage and 
maintain a list of web sites that are accessible from within Myriad 
Manager. Again, this feature is used more heavily at stations where 
Scoop is also used to provide integrated playout and news facilities.
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 Menu System – This provides access to many of the menu options 
available on the main Myriad system and allows you to customise 
Myriad on a ‘per User’ basis and configure the system as a whole.

 General Workspace – The General Workspace is used to show 
results of reports you run, display any wizards and interact with the 
tools that the Myriad Manager provides.

 Cart Players – The Cart Players are used to play and review Carts 
from your systems Audio Wall and if you have access rights, you can 
also use the Record Cart Player to record audio directly on to the Audio 
Wall.

We will now look at each of these major areas in more detail.

Chapter 2 - The Audio Tab

As mentioned in the previous Chapter, the Audio Tab provides access to 
range of tools and reports that all relate to the Myriad Audio Wall or Carts in 
one way or another. The Audio Tab can be broken down in to four key areas.

 Import Audio Wizard – provides access to the import audio wizard 
which is used to import one or more audio files from a data source, or 
to rip one or more tracks from an audio CD in the computers CD-ROM 
drive.

 Cart Reports – Provides a range of reports regarding the Carts that 
are stored on your systems Audio Wall. These reports can be 
customised and the saved for future use and the report results are 
displayed in the Audio Reports window which also offers access to a 
number of mass manipulation tools such as mass moving or changing 
of Carts and mass deleting.

 Audio Play Logs Reports – This section allows you to gather 
information about the Carts that have been played using your Myriad 
system. Reports can be customised and saved for future use. This 
facility also makes producing a ‘chart’ of the most (or least) played Cart 
on your system.

 Copyright Reports – Finally, you can generate specialist play reports 
formatted for copyright report agencies such as PRS / PPL in the UK. 
These reports are based on actual play information in Myriad and 
include any copyright details that are entered on the Carts that have 
been played.
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These Options are made available using the Audio tab expandable tree view 
option which allows you to review and access the tools and reports available 
via the Audio Tab. To view the options / tools / reports available under each 
main section of the tree view, click on the ‘+’ icon to the left of the option to 
‘expand’ the branch and view the sub-options.
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Import Audio Wizard

The Import Audio Using Wizard  option on the Audio Tab provides access to 
the Audio Import Wizard which is used to import digital files in to your Myriad 
Audio Wall or to ‘rip’ audio tracks from audio CDs in the computers CD-ROM 
drive.

Both of these options have already been covered in the Myriad manual and 
the same procedure is used in Myriad Manager to either import digital audio 
or ‘rip CD’s.

Rip Tracks From CD

The rip Tracks From CD option is used to digitally transfer audio tracks from 
an audio CD in the computers CD-ROM drive, in to the Audio Wall on Myriad. 
This normally happens at much faster than ‘real time’ (a 3 minute song may 
only take 30 seconds) and a number of additional functions can be performed 
on the Cart being added at the same time.

To access this facility either double click on the Rip Tracks From CD option or 
highlight it and click on the Open button to the bottom of the tree view.
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Please note that the following section is a direct copy of the equivalent section 
in the main Myriad User Guide as both Myriad and Myriad Manager use the 
same Import Audio Wizard. If you are familiar with the process in Myriad then 
you can probably skip over this section.

Rip Audio Tracks From CD Wizard

The Rip Audio Tracks From CD Wizard contains a number of settings and 
options. The diagram below shows a general overview of the layout of the 
page and the individual options are examined in more detail below.
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The most obvious section of the page is the Track Listing section. When you 
first move on to this page, Myriad Manager will automatically scan the CD that 
is in the CD ROM drive with the lowest drive number. It will read how many 
tracks are available on the CD and put an entry for each in the Track Listing 
area.

Beside each tracks is the Individual Track Selector which is a tick box option 
that allows you to indicate whether the track should be imported as part of the 
CD ripping process.
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In the above example, tracks 1,2,4 & 5 will be imported and all other tracks 
will be, ignored. This option is very useful when you are working with albums 
that only have a few tracks that you want to install.

Related to this feature are the Select All and De-select All buttons. As you 
would expect, these buttons allows you to select ‘tick’ all of the tracks on the 
CD to be imported or to de-select any that have already been selected.

The Get Titles button is only enabled if your Myriad system has been 
configured to use a web connection to ‘look up’ Title and Artist information for 
CD’s using one of the CD databases available on the web (FreeDB or CDDB 
are the most common).

Once enabled, this option will make Myriad submit the unique ID number for 
the CD, to the online database and will then display any Title and Artist 
information listed in the database for the CD.
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Please note that the information stored on the online databases are 
maintained by the general public and as such the information my not be 
available or accurate. It is always worth checking that the information is both 
relevant and accurate. 

Once the information has been gathered, Myriad will do it’s best to sort the 
information in to the correct fields in the Track Listing area. The problem is 
that there is no standard for entering the data on to the online databases so 
sometimes the Artist and Title appear in the wrong order. To make matters 
worse, the character used to separate the Artists and Title is not always the 
same so you could end up seeing something like the screen shot below.
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This is where the Track Details Import Options come in to play to allow you to 
work around information that has been listed in correctly or in the wrong 
format.

We can see from this example that the ‘/’ character is used to separate the 
Artist and Title but we are using the ‘-‘ or ‘_’ characters to separate them so 
Myriad is not able to separate the information correctly. This is simple to fix 
however using the Separators drop down lists to select the correct character.
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By selecting the ‘/’ character as one of the separators, the problem is sorted.



24

The Item Title Order drop down list is used if the Title & Artist information 
appears the wrong way round in the Track Listing area.
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In this situation, you can use the Item Title Order to switch the Title and Artist 
to be displayed correctly.

The Force Title / Artist options allow you to overrule the information supplied 
by the online database with your own information.
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Once you have Title and Artist information that you are happy with, you can 
get Myriad to check the Audio Wall for existing Carts with similar Artist or Title 
information to avoid duplication, using the Scan Audio Wall For Similar button.
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This will scan the Audio Wall and display all Carts with similar information to 
the selected tracks in the Track Listing Area.
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As you can see from the example above, similar Carts were found for both 
Christina Milian and Anastacia but not the same track Titles to so that means 
that importing the Christina Milian and Anastacia tracks from this CD should 
be OK.

The final option on this page is the Automatically Trim The Silence From The 
Start Of The Audio (‘Top’) option which as the name suggests, automatically 
removes any silence from the beginning of the audio track as it is imported. 
This option is highly recommended as without it you would have to manually 
trim the silence from the beginning of tracks using SmoothEdit or Myriad 
would play the silence each time the Cart was played in a Cart Player.

When you are happy with the tracks that Myriad will import and that the 
additional information will be imported as correctly as possible, click on the 
Next button to continue.

Select Destination Carts Page

The next page on the Import Audio File Wizard allows you to select the Cart 
Slot Number that you want the first audio track in the list to be ripped in to and 
also how to deal with the subsequent tracks in the list.
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The top section allows you to choose between automatically assigning a Cart 
Slot Number on the Audio Wall starting from the selected point (which by 
default is the Cart you right clicked on originally).

The second option allows you to select whether to overwrite Carts that 
already exits in that range. Let’s say we were importing 10 tracks starting at 
Cart number 3092 (as above) then they would each imported in sequence 
between Carts 3092 and 2102 on the Audio Wall. Now let’s say we already 
had a Cart at 3100 then if this option were ticked then the Cart at 3100 would 
be overwritten with the new imported Cart. If you leave this option unticked 
then the Cart at 3100 would remain and the position of the imported files after 
that would be shuffled up by one so the imported Carts would actually end at 
3103. Basically, if you leave this option unticked then the import process will 
stop over any existing Carts on your Audio Wall which is probably the way you 
will usually want it.

When you are happy, click on the Next button.

Import Audio Format

The next stage in the Import Wizard allows you to control the format of the 
audio tracks that you are importing and also the audio level of the audio within 
the tracks.
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From this screen you can opt to convert all the imported tracks to a pre-set 
format and compression scheme or to convert them to a User specified 
format. You can also set whether to ‘normalise’ the audio and if so what level 
to normalise it to.

If you select the Convert The Audio To Match The Audio Wall Format option 
then (if possible) Myriad will convert the audio to the audio quality (e.g. 
44,100Khz stereo) and format (e.g. WAV, ADPCM etc) that has been set as 
the default for the Audio Wall - see Settings>Audio Settings menu and the 
Record / Edit tab – as seen below.
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This is the most commonly used setting as it ensures that the audio is 
converted in to the same format and quality as the other audio on the Audio
Wall. It should be noted that Myriad cannot convert all file types and formats. 
If you import a file in quality or format that Myriad can not convert, you will be 
notified as it attempts the conversion.

The Convert Audio To A Specified Format option allows you to set the audio 
format and quality for the import batch you are working on. To use this option, 
select it and then click on the Select button to choose the format you want to 
use.

This will open the Choose Audio Format window which allows you to select 
from the available audio formats and quality options. The available options do 
differ from format to format but in general, the options are listed below.
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 Audio Format – This allows you to select the basic audio format to 
convert the audio to. In Myriad v3, this is restricted to just Windows 
Wav files but in Myriad v3.1 this option is expanded to allow you to 
select from MP2, MP3, WMA (windows media format), Ogg (ogg 
vorbis) and WAV files in Myriad v3.1.

 Format (WAV only) – This option allows you to select between PCM 
(uncompressed WAV files) or ADPCM (4:1 compressed WAV files).

 Sample Rate – This allows you to select the sample rate on which the 
audio is based. N.B. This is not a configurable option on some formats.

 Bit Rate – This option allows you to set the bit rate at which to encode 
the audio. This options is only applicable to MP2, MP3, Ogg and WMA 
formats. The high the bit rate, the higher the quality but the larger the 
file size. It is usually accepted the 256Kbit MP3 or WMA give a 
comparable audio quality to CD’s but you must set the bit rate that best 
suits the balance between audio quality and file size that you station 
needs.

 Stereo / Mono – This option allows you to select whether the audio 
should be imported as a stereo or mono audio file. This option may not 
be available on all formats.

Many of the above options are only available in Myriad v3.1 so if you do not 
have all the options, please check that you are on the latest version of Myriad 
before contacting P Squared. Myriad v3.1 is scheduled for release in Autumn 
2005 so it is possible that not all the features will be available before this date.

The final option on the Import Audio Format page of the Import Audio Wizard 
is to do normalising the audio as it is imported. But what de we mean by 
normalising?

The basic idea is simple. An audio file or wave form is a graph of peaks and 
troughs and like any graph, there is always a point in the wave form that is the 
loudest single point. When you perform a normalisation, Myriad scans through 
the wave form to find this point. It then works out how much it would need to 
amplify this point by in order to reach the percentage level that you have 
specified when setting up the Normalisation. It then applies the same level of 
amplification to the entire wave form. This is important because as the loudest 
point is used to calculate the amplification level and this level is applied to the 
rest of the wave form, you avoid distortion by over amplification. It is also 
important because if multiple audio files are normalised to the same level, 
they should be pretty even in terms of volume as the loudest point in each file 
will always be at the same level.

If you tick the Normalise The Audio After It’s Imported option then Myriad will 
scan through the audio after it has imported it, find the loudest point and then 
work out how much it will need to amplify or reduce the volume by in order for 
this point to make it the same as the Percentage To Normalise To. Once it 
has this value, it will then apply the same amplification / reduction to the rest 
of the file and hence the file will be normalised. The important thing is if all the 
audio files imported or ripped in to the Audio Wall are normalised to the same 
value then the loudest point in each file will be exactly the same.
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You can alter the Percentage To Normalise To value as part of the normalise 
procedure. The value represents the entire range of volume of the sampled 
audio with 100% representing full volume (e.g. wave form reaches top of 
scale) and 0% presenting silence. The default of 63% has been calculated to 
provide audio normalised to -14Db which is the technically correct level for 
digital audio. It is worth experimenting to get the right level for your station. 
The Audio Wall Default button resets this value to the pre-set default 
normalise level which can be altered using the Setting>Audio Wall File 
Settings menu and selecting the Importing Audio tab.

When you are happy with the Import Audio Format setting, click on the Next 
button to advance to the next page of the wizard.

Import Audio Summary

The Import Audio Summary page displays an overview of the CD tracks that 
are going to be imported and the destination Carts they will be imported in to.
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Click on the Next button to start the CD ripping process, you will then be 
asked to confirm that you want to proceed.

Click Yes to start the process.

Once the import process has been completed, the final page of the wizard will 
be displayed.
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Click on the Close button to close the Import Wizard and return to the Audio 
Wall.

Import Audio Files

The Import Audio Files option is used to access the Import Audio Files wizard 
which is used to import one or more digital audio (wav) files located on a local 
or networked disk, resource or server. In essence, this facility allows you to 
work on a bunch of wav files at home, bring them in on a portable hard disk 
and then mass import them in to the Myriad Audio Wall. 

To access this facility, either double click on the Import Audio Files option or 
make sure that it is highlighted and then click on the Open button located 
below the tree view section.
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Please note that the following section is a direct copy of the equivalent section 
in the main Myriad User Guide as both Myriad and Myriad Manager use the 
same Import Audio Wizard. If you are familiar with the process in Myriad then 
you can probably skip over this section.

Select Audio Files

When you select the Import Audio Files option, Myriad Manager opens up the 
Import Audio wizard which will guide you through the import audio process. 
The first stage of that process is to select the file or files that you wish to 
import.
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This page of the wizard allows you to select the file or files that you want to 
import. There are a number of options on this screen so we will go through 
them in turn.

The Select Single File button allows you to browse your computer and 
network to select a single file to be added to the list of file to be imported. 
When you click on the Select Single File button, the standard windows file 
selection window appears.
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You can use this window to select a single WAV or Transport (zip) file to be 
imported or (as in the example above) you can select multiple files by holding 
down the <Ctrl> key and clicking on the ones you want (other standard 
windows selection tricks also work). Click on the Open button and the files are 
added to the Files To Import list.

You can click on the Import Single File button multiple times to select files 
from different folders or location to build up a list of files that you want to 
import.
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Note the tick by each file. Only the ticked files will be imported so even if you 
add a file to the list by mistake, you can still exclude it from the import 
process.

Below the Select Single File button is the Select Folder button which offers a 
simple ay of adding all of the suitable audio files within a folder, to the list of 
file to be imported. Clicking on this button allows you to select the folder whos 
content you want to import.
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The tick boxes to the left of the file in the Files To Import list is even more 
useful when you are adding a folders worth at a time because you can add 
the entire folder and then go through and exclude any you don’t want to 
import.

But how would you know?

The answer lies in the next button which is called the Check For Similar 
button. What this does is searches the Audio Wall and looks for any Carts that 
match the Title or Artist information for the files that you are planning to 
import. Obviously, this option will only be useful if the Title and Artist 
information is present which basically means that it is either embedded in to 
the filename (e.g. Overprotected – Britney Spears) or the information is 
hidden inside the file itself (i.e. it is CartChunk compliant which all Carts 
exported from Myriad are).

If you click on the Check For Similar button, the results are displayed in a 
separate panel underneath the Files To Import list.
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As you can see from the screen shot above, several of the Songs we are 
trying to import already exist on our Audio Wall so we may wish to exclude 
them from the import process by un-ticking the conflicting songs.

The File Name Processing options allow you alter the way in which Myriad 
interprets the file name when it is using it to title the files it is importing. 
Consider the following.

Overprotected – Britney Spears
Britney Spears – Overprotected
Overprotected / Britney Spears

To a human, it is clear that they are all the same track (i.e. Overprotected by 
Britney Spears) but because software is not as intelligent as your average 
person, it can get confused by this type of situation. Myriad will always 
attempt to interrupt the file name as best it can but the File Name Processing 
options allow you to give it a hand by telling it which order it should be using 
for Title and Artists and also what character is being used to separate them.
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Use the drop down lists to select the options that best suit the files that you 
are trying to import. If you have several different filename formats within the 
list of files to import, it may be impossible to resolve the situation in which 
case it is advisable to import them in small batches of similarly formatted files.

The final option on this page is the Delete The File After Importing option 
which does exactly what it says. CAUTION – If you tick this option and then 
run the import process, there will be no way to recover the audio files that 
Myriad deletes.

Finally, when you are happy with all of the options on Select Audio Files page, 
click on the Next button to proceed.

Select Destination Carts Page

The next page on the Import Audio File Wizard allows you to select the Cart 
Slot Number that you want the first audio file in the list to be imported to and 
also how to deal with the subsequent files in the list.
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The top section allows you to choose between automatically assigning a Cart 
Slot Number on the Audio Wall starting from the selected point (which by 
default is the Cart you right clicked on originally) or to attempt to interpret the 
destination Cart Number from the file name (e.g. MYR05467.wav would be 
imported in to Cart number 5467).

The second option allows you to select whether to overwrite Carts that 
already exits in that range. Let’s say we were importing 10 files start at Cart 
number 2941 (as above) then they would each imported in sequence between 
Carts 2941 and 2951 on the Audio Wall. Now let’s say we already had a Cart 
at 2950 then if this option were ticked then the Cart at 2650 would be 
overwritten with the new imported Cart. If you leave this option unticked then 
the Cart at 2950 would remain and the position of the imported files after that 
would be shuffled up by one so the imported Carts would actually end at 
2952. Basically, if you leave this option unticked then the import process will 
stop over any existing Carts on your Audio Wall which is probably the way you 
will usually want it.

When you are happy, click on the Next button.

Import Audio Format
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The next stage in the Import Wizard allows you to control the format of the 
audio files that you are importing and also the audio level of the audio within 
the files.

From this screen you can opt to convert all the imported files to a pre-set 
format and compression scheme, leave the files in their current format 
(regardless of whether it is compatible with Myriad) or to convert them to a 
User specified format. You can also set whether to ‘normalise’ the audio and if 
so what level to normalise it to.

If you select the Convert The Audio To Match The Audio Wall Format option 
then (if possible) Myriad will convert the audio to the audio quality (e.g. 
44,100Khz stereo) and format (e.g. WAV, ADPCM etc) that has been set as 
the default for the Audio Wall - see Settings>Audio Settings menu and the 
Record / Edit tab – as seen below.
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This is the most commonly used setting as it ensures that the audio is 
converted in to the same format and quality as the other audio on the Audio 
Wall. It should be noted that Myriad cannot convert all file types and formats. 
If you import a file in quality or format that Myriad can not convert, you will be 
notified as it attempts the conversion.

The Import Audio In It’s Current Format option does exactly as the name 
suggest. Audio is imported in to the destination Cart but is left in the original 
format and quality. This option is not advisable as it could lead to Cart on the 
Audio Wall that Myriad can not play.

The Convert Audio To A Specified Format option allows you to set the audio 
format and quality for the import batch you are working on. To use this option, 
select it and then click on the Select button to choose the format you want to 
use.
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This will open the Choose Audio Format window which allows you to select 
from the available audio formats and quality options. The available options do 
differ from format to format but in general, the options are listed below.

 Audio Format – This allows you to select the basic audio format to 
convert the audio to. In Myriad v3, this is restricted to just Windows 
Wav files but in Myriad v3.1 this option is expanded to allow you to 
select from MP2, MP3, WMA (windows media format), Ogg (ogg 
vorbis) and WAV files in Myriad v3.1.

 Format (WAV only) – This option allows you to select between PCM 
(uncompressed WAV files) or ADPCM (4:1 compressed WAV files).

 Sample Rate – This allows you to select the sample rate on which the 
audio is based. N.B. This is not a configurable option on some formats.

 Bit Rate – This option allows you to set the bit rate at which to encode 
the audio. This options is only applicable to MP2, MP3, Ogg and WMA 
formats. The high the bit rate, the higher the quality but the larger the 
file size. It is usually accepted the 256Kbit MP3 or WMA give a 
comparable audio quality to CD’s but you must set the bit rate that best 
suits the balance between audio quality and file size that you station 
needs.

 Stereo / Mono – This option allows you to select whether the audio 
should be imported as a stereo or mono audio file. This option may not 
be available on all formats.

Many of the above options are only available in Myriad v3.1 so if you do not 
have all the options, please check that you are on the latest version of Myriad 
before contacting P Squared. Myriad v3.1 is scheduled for release in Autumn 
2005 so it is possible that not all the features will be available before this date.

The final option on the Import Audio Format page of the Import Audio Wizard 
is to do normalising the audio as it is imported. But what de we mean by 
normalising?

The basic idea is simple. An audio file or wave form is a graph of peaks and 
troughs and like any graph, there is always a point in the wave form that is the 
loudest single point. When you perform a normalisation, Myriad scans through 
the wave form to find this point. It then works out how much it would need to 
amplify this point by in order to reach the percentage level that you have 
specified when setting up the Normalisation. It then applies the same level of 
amplification to the entire wave form. This is important because as the loudest 
point is used to calculate the amplification level and this level is applied to the 
rest of the wave form, you avoid distortion by over amplification. It is also 
important because if multiple audio files are normalised to the same level, 
they should be pretty even in terms of volume as the loudest point in each file 
will always be at the same level.

If you tick the Normalise The Audio After It’s Imported option then Myriad will 
scan through the audio after it has imported it, find the loudest point and then 
work out how much it will need to amplify or reduce the volume by in order for 
this point to make it the same as the Percentage To Normalise To. Once it 
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has this value, it will then apply the same amplification / reduction to the rest 
of the file and hence the file will be normalised. The important thing is if all the 
audio files imported or ripped in to the Audio Wall are normalised to the same 
value then the loudest point in each file will be exactly the same.

You can alter the Percentage To Normalise To value as part of the normalise 
procedure. The value represents the entire range of volume of the sampled 
audio with 100% representing full volume (e.g. wave form reaches top of 
scale) and 0% presenting silence. The default of 63% has been calculated to 
provide audio normalised to -14Db which is the technically correct level for 
digital audio. It is worth experimenting to get the right level for your station. 
The Audio Wall Default button resets this value to the pre-set default 
normalise level which can be altered using the Setting>Audio Wall File 
Settings menu and selecting the Importing Audio tab.

When you are happy with the Import Audio Format setting, click on the Next 
button to advance to the next page of the wizard.

Import Audio Summary

This next page in the wizard provides an overall summary of the audio files 
that you want to import, along with destination Carts, Title & Artists 
information and length of audio.



48

If you are not happy with the displayed summary, click on the Back button 
until the relevant page is displayed and make whatever alterations are 
needed. If you are happy, click on the Next button to proceed.

You will then be asked to confirm that you want to proceed.

Importing Audio

Once you have confirmed that you want to proceed, Myriad starts the import 
process. The Importing Audio screen shows you a summary of the progress 
made along with a log of the actions it has performed.
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You can stop the import process at any time by clicking on the Stop Importing 
Audio button. If you do this then any audio files that have been successfully 
imported will remain on the Audio Wall but the current audio file and any 
remaining in the list to import will be discarded.

Once the import process has been completed, the final page of the wizard will 
be displayed.
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And that is that. Remember that if the imported files did not include embedded 
timing information, you will need to use SmoothEdit to set the Intro and Extro 
for the Carts in order for them to be sound good in an automated segue. If you 
have imported Songs or Links, you will also have to add them to your 
scheduling system as even when you are using AutoTrack or AutoTrack Pro, 
they will not automatically be added to the scheduling system.

Cart Reports

The Cart Reports section allows you to search and review the Carts that are 
on your systems Audio Wall using a vast range of criteria. You can also use 
the Audio report Results window to perform a range of additional functions on 
selected Carts including mass changing, mass move / copy and mass delete.

The Cart Reports section of the Audio tab provides you with all the tools you 
need to review and manage your Audio Wall in Myriad.

The Cart Report section can be expanded by clicking on the ‘+’ icon (if it is not 
expanded) and is divided in to three key areas.
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 Run A Custom Cart Report – This option allows you to run a ‘one off’  
Cart Report using the criteria you set. Once you have finished with the 
report and closed the Audio Report window, the Cart Report is 
discarded.

 Previously Saved Cart Reports – In addition  to running ‘one off’ Cart 
Reports, you can also save Cart Reports and then re-use them the 
next time you are in Myriad Manager. You can have as many 
previously saved Cart Reports as you like. By default, Myriad Manager 
comes with a few commonly used Cart Reports as can be seen in the 
screen shot above.

 Add A New Cart Report – Finally, you can add in new Cart Reports 
that will be saved in to the tree view list for use next time you are using 
Myriad Manager. These saved Cart Reports are listed in the Previously 
Saved Cart Reports section.

Run A Custom Cart Report

To run a Custom Report, double click on the Custom Report option on the 
tree view or highlight the Run Custom Report option and click on the Open 
button (below the tree view). 

This will then open the Audio Browser Options window which is used to set 
the criteria that you wish to use for your Cart Report.
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The Audio Browser Options window contains a number of options to allow you 
to customise your Cart report. You can combine two or more criteria for a 
more specific Cart report.

The Audio Browser Options window is divided in to four tabs.

Audio Browser Options – The General Tab

The General tab is used to set the more general criteria that you wish to use 
when running a Cart Report.
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The options available are briefly outlined below.

 Audio File Format – This drop down option allows you to select 
whether to include:

o All Carts – all Carts regardless of format or compression.
o Linear Carts – Only include Carts that are not compressed.
o Compressed Carts – Only include Carts that are compressed.
o Carts That Are XXXX – Only include Carts of the specified 

format (use drop down list to select format).
o Carts That Are Not XXXX – Only Carts that are not of the 

specified format (use drop down list to select format).
 Only Show Carts With Extros Greater Than XX Seconds – Only 

includes Carts that have Extros that are longer than the specified 
period in seconds.

 Only Show Carts From XX to XX Seconds In Duration – Only 
include Carts that fall within the specified duration in length.

 Only Show Carts With Timing Discrepancies Or Have Not Been 
Seen Before – This option does two different things, firstly it shows 
any Carts on the Audio Wall that are either longer or shorter than 
Myriad believes them to be. This can happen if the audio file behind a 
Cart is edited using an external audio editor (not SmoothEdit in Myriad 
or through the external editor launch button on the SmoothEdit tab). 
Myriad does not double check Cart durations by default for speed 
reasons, rather, it assumes that the duration has not change since the 
last time it edited it. If you are having problems running to time then this 
report is useful to see if the reason is that Myriad has some Carts down 
as the wrong length. If you tick the ‘Automatically Correct These 
Discrepancies’ option then Myriad will automatically fix these as it finds 
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them. This report will also list any audio files that exist in the folder that 
the Audio Wall resides in but are not listed on the Audio Wall.

 Ending Type XXXX – Only list Carts that have the selected End Type 
(use the drop down list to select Ends, Fades, Slow Fade, Sustain or 
Not Specific).

Audio Browser Options – The Played Tab

The Played Tab allows you to set a number of criteria for your Cart report, all 
of which relate to when Carts have been played on your Myriad system. This 
allows you to restrict the results that are displayed to just show Carts that 
have been plays over a floating time period (i.e. Carts played in the past X 
days) or a fixed date range (Carts played between X date and X date).

The options on the Played tab are outlined below.

 Do Not Check The Played Dates – When this option is checked, 
Carts will not be excluded from the Cart Report based when they have 
been played in Myriad. This is the default option.

 Only Show Carts Played XXXX – This option allows you to select a 
‘floating’ period within which Carts played should be included in the 
Cart Report.
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Use the drop down list to select the ‘floating’ time period that you wish 
to use. This option is great for a quick report to see what has been 
played at your station in the last week!

 Only Show Carts Played Between XXXX and XXXX – This option 
allows you to set a fixed start and end date between which, any Carts 
played will be included.
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Use the ‘drop down’ calendar options to select the start and end dates 
that you wish to use.

Remember, you can combine options on the Played tab with other criteria for 
more specific Cart Reports.

Audio Browser Options – The Last Modified Tab

The Last Modified tab allows you to add criteria that restricts the Carts 
displayed in the Cart Report to only include Carts modified in within the 
selected time / date range.
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The options are outlined below:

 Do Not Check The Last Modified Date – When this option is 
checked, Myriad does not restrict the Carts included in the Cart Report 
by last modified date / time.  This is the default option.

 Only Show Carts Last Modified In The Last XXXX – This option 
allows you to select a ‘floating’ period so that the Cart report will only 
include Carts that have been modified with the selected time frame.
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Use the drop down list to select the time frame that you are interested 
in.

 Only Show Carts Last Modified Between XXXX and XXXX – This 
option allows you to select a fixed date period using the ‘drop down’
calendars. Once you have selected the time range that you wish to 
use, the Cart Report will only include Carts that have been modified 
inside of the selected period.

Audio Browser Options – The Advanced Tab

The Advanced Tab allows you to ‘fine tune’ the Carts listed in the Cart Report 
to include Carts that either have or have not got one or more data attributes 
set on the on the SmoothEdit Screen.
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Basically, this allows you to either list all Carts that have data in a particular 
field on the SmoothEdit Screen or those Carts that have data missing from the 
SmoothEdit Screen. 

The Advanced Tab is divided in to two columns.

 Only Show Carts That Have XXXX – In this column there is a list of all 
of the different data fields available on the SmoothEdit Screen and a 
tick box by each item in the list. As you will see, the first item in the list 
is ‘Description Line 1’. If  you ticked this option and then click on OK 
then the Cart Report would include each Cart on the Audio Wall that 
has something typed in to the ‘Description Line 1’ (Title) on SmoothEdit 
Screen (which would probably be all of them). As you scroll down the 
list, you will see a great many options but if you are familiar with the 
Myriad Audio Wall then you should also be familiar with this list. You 
can tick more than one option if you are after more specific results.

 Only Shows Carts That Do Not Have XXXX -  The second column 
works in a similar way in that all of the attributes on the SmoothEdit 
Screen are listed but in this case, if you tick an option then the Cart 
report will include any Carts on the Audio Wall that do not have that 
attribute set. So in our example, if we ticked the ‘Description Line 1’ 
option in this column then the Cart Report would only include Carts that 
had nothing typed in for Description Line 1 (Title).

You can combine these options with others to get more specific Cart 
reports if you wish.
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In all cases, when you are happy with the Audio Browser Options, click on the 
Ok button to proceed to the Cart Report.

Audio Report

Once you have selected the report criteria that you wish using the Audio 
Browser Options window, or if you select on of the Previously Saved Cart 
reports, the Carts that meet your search criteria are displayed in the Audio 
Report window.

This window has three main functions:

1. Display Your Cart Report Results – shows a list of Carts that meets 
the criteria set in the Audio Browser Options window or specified in the 
Previously Saved Cart Report.

2. Perform A Range Of Mass Manipulation Operations To Selected 
Ranges Of Carts – The Audio Report window allows you to select 
multiple Carts and then perform a range of operations on the selected 
Carts (see Edit Drop Down Menu),.

3. Refine Your Cart Report Search Further – You can refine your Cart 
Report further by adding keywords and Cart ranges as well as editing 
the Audio Browser options originally used.
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Audio Report General Screen Layout

The Audio Report screen is divided in to two main areas, the upper Tool Bar 
Area provides access to the tools and search criteria options that allows you 
to customise the Cart Report and perform operations on the selected Carts.

The lower section displays the Carts that meet the Cart Report criteria and 
can be used to select one or more Carts to perform operations on (using the 
tool bar options). You can also sort the Carts listed in the lower section by any 
of the column headers by clicking on the column header title. By default the 
Carts are listed numerically, but click on the Artists column header and the 
results will be sorted alphabetically by Artist.

The Upper Tool Bar General Layout

The upper Tool Bar Area contains a number of options to allow you to refine 
the results listed in the Cart Report or to affect changes to one or more 
selected Carts. The diagram below shows the general layout of the Tool Bar 
Area.

There are a lot of options spread over three rows so to make it a little clearer, 
the general layout diagram has been split in to two parts. The diagram below 
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outlines the functions of the tool buttons on the top row. The diagram below 
outlines the options on the lower two rows.

Save Report Settings

The Save Reports button on the Audio Report allows you to save the criteria 
that you have used to generate the Cart Report. The saves report is then 
added to the Cart Reports Tree View and a Previously Saved Cart Report.

When you click on this option, you are asked to provide a name for your Cart 
Report. Type in the name you wish to use and click on OK.



63

Your Cart Report is then added to the Previously Saved Cart Reports section 
to allow you to use it again next time you log in to Myriad Manager.

Refresh Report

The Refresh Report option causes the Audio Report window to re-list the 
Carts in the Audio Report Results section. If you make changed to the search 
criteria then you can use this button to force the Audio Report window to 
update the list of Carts to reflect the changes you have made.

Audio Browser Options

The Audio Browser button opens the Audio Browser Options window which is 
used to set the criteria that the Cart report is based on.
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The Audio Browser Options window is covered in detail earlier in this Chapter 
so we will not recover now. For more details, please refer to The Audio 
Browser Option section of the documentation.

Print The Selected Carts

You can highlight one or more Carts in the Audio Report Results section of 
the window using either the <Ctrl> key and clicking on items in the list or by 
using the <Shift> key and the up and down arrows. You can also select 
everything in the list by pressing <Ctrl> + <A>.
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Once you have selected two more Carts in the list (see picture above), you 
can click on the Print Selected Carts button to print the details using the 
default printer for your computer.

Once the print job has completed, you will receive a message box letting you 
know.

N.B. If no Cart is selected or just one Cart is selected then all Carts in 
the list will be included in the print out. If two or more Carts are selected 
the only the selected Carts details will be printed.

Export To CSV File

The Export To CSV File option is used to export the details for the selected 
Carts in to a specially formatted text file called a CSV (comma separated 
variable) file. In this file, the data is separated by commas and therefore can 
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be imported in to most popular third party applications such as Microsoft Excel 
or Access.

To use this facility, select two or more Carts using the method outlined above 
(In the Print Selected Carts section) and then click on the Export To CSV File 
button.

You will then need to select a file name and location to save the CSV file to.

After Myriad Manager has finished exporting the information, you will see a 
message box confirming the save location.

N.B. If no Cart is selected or just one Cart is selected then all Carts in 
the list will be included in the exported file. If two or more Carts are 
selected the only the selected Carts details will be exported.

Play Options
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The Play Options button is split in to two sections, the main button is used to 
manually play the last selected Cart in the Audio Report Results section, 
using one of the Cart Players in Myriad Manager.

To the right of the Play Option button is the Play Options Button drop down list 
which is used to list a range of additional options.

The options on the Play Options buttons are outlined below.

Play Options - Play Last Selected Cart

Play – Click on the main Play Options button to play the most recently 
selected Cart using a Cart Player.
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The Cart will automatically be Cued in to the first free Cart Player in Myriad 
Manager.

Play Options – Add Selected Cart(s) To A Pad Run

You can use this option to add one or more selected Carts to a standard 
Myriad Pad.

Once the Carts are in the Pad, the order can be changed by dragging the 
Carts within the Pad and you can also save the Pad run using the Pad tool 
bar at the top of the Pad.
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Edit Options Button & Drop Down Menu

Just like the Play Options drop down, the Edit Options drop down button can 
be used in two different ways. Clicking on the button section will open the 
Myriad SmoothEdit Screen for the Cart last selected in the Audio Report 
results window. Clicking on the drop down arrow section of the button will 
access the Edit Drop Down menu which offers an extended range of edit 
related tools and options.

The Edit Last Selected button section.

The Edit Drop Down Menu section.

The options on the edit Drop Down Menu option are outlined below.

Edit Options – Edit The Last Selected Cart



70

By clicking on the main section of the button, Myriad Manager will open the 
SmoothEdit Screen for the last Cart selected in the Audio Results Display 
Window.

Edit Options – Change The Colours (Mass Colour Change)

The Change Colour option is used to mass change the text and background 
colour for the Cart or Carts that you have selected in the Audio Results 
window. To use this option, first select the Cart or Carts that you want to mass 
change the colours for.
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Next, click on the Edit Options Drop Down Menu and select the Change The 
Colours option.
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You will be prompted to select the colour that you want to set the background 
colour to first.

Select the colour that you wish to set the background to using the colour 
palette window.

Then click on OK.

Next you will be prompted to select the colour that you want to change the 
text to.

Again, select the colour you want to using the colour palette and then click on 
OK.
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Finally, you will be asked to confirm that you want to change the colours for 
the selected Carts.

Click Yes to confirm. Once Myriad Manager has performed the mass colour 
change, it will inform you.

Click on OK to return to the Cart Report window.

Edit Options – (Mass) Update Cart Chuck Information
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This option is usually only needed for older Myriad systems that have recently 
upgraded to Myriad v3 or if you are using an Audio Wall that has some very 
old Carts on it. Cart Chunk is an international standard for imbedding title, 
artists and timing information in to the ‘header’ for WAV files so that the 
important information is stored as part of the actual audio file. This means that 
if Myriad (or another supporting system) imports a WAV file with Cart Chuck 
information, that information will be automatically used as the Cart is added to 
the Audio Wall. Cart Chuck functionality was introduced in Myriad v2.6 so any 
Carts recorded or imported on to your Audio Wall using Myriad v2.6 or higher 
will automatically contain Cart Chuck information but any Carts created or 
imported using an older version may not include this information. 

The reason that this is important is that if your station has been using Myriad 
for a number of years or you have imported Carts from a station that used an 
older version of Myriad then your Audio Wall may contain a mixture of Carts 
that do and don’t include Cart Chuck information. It is desirable for all of your 
Carts to include this information because if the Cart Chuck information is 
complete on all Carts then Myriad can ‘rebuild’ the Audio Wall just from the 
WAV files should the Cart List files become corrupted or accidentally deleted.

This option can be used to add Cart Chunk information to one or more 
selected Carts which helps prevent potential data loss in the event of the 
worst happening.

To use this function, run a Cart Report and then select one or more Carts that 
you wish to update Cart Chunk information on.
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The use the Edit Options Drop Down Menu to select Update Cart Chunk 
Information.

You will then be asked to confirm you actions.

Click on Yes to continue. Myriad Manager will then update the Cart Chuck 
information on the selected Carts. This may take a few moments depending 
on how many you have selected. The progress is shown as a bar along the 
bottom of the Audio Reports window.

Once the process is complete, Myriad Manager will summarise how many 
Carts it has updated.
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Edit Options – (Mass) Copy The Selected Carts

The Copy Selected Cart option on the Edit Options Drop Down Menu is used 
to copy one or more Carts to another location on your systems Audio Wall.

To use this facility, follow these steps.

Select one or more Carts that you want to copy to another location on the 
audio wall and then use the Edit Options Drop Down Menu to select the Copy 
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You will then be asked where you want the first Cart to be copied to.

In the example above the first Cart will be copied to Cart Slot number 500.

You will then be asked to confirm the action.

You will then be asked how to deal with Cart Slots that already have Carts in 
them.
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The options are outlined below:

 Yes – Any existing Carts will be overwritten by the Carts you are 
copying. The Carts overwritten will be permanently lost.

 No – Existing Carts will be preserved and the copied Carts will ‘step 
over’ any existing Carts.

 Cancel – Abandon the process.

Once you have made your choice (Yes or No) then Myriad Manager will copy 
the selected Carts. Progress is displayed as a bar along the bottom of the 
Audio Report window.

Once the copy has finished, the Audio report is refreshed to reflect the 
changes you have made. You will then see a summary of the amount of Carts 
copies.



79

Edit Options – (Mass) Move The Selected Carts

This option is used to move one or more Carts from one location on the Audio 
Wall to another.

Caution: You should not use this facility if you are also using AutoTrack 
or AutoTrack Pro as moving Carts in Myriad Manager will not 
automatically move the reference to the Cart in your scheduling system. 
If you are using AutoTrack or AutoTrack Pro then you should use the 
Mass Move Cart options to move Carts linked to the Scheduling system. 
You can move Carts that are not linked to entries in AutoTrack or 
AutoTrack Pro using this facility if you wish.

To use this facility, follow these steps.

First, select the Carts that you wish to be moved.
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Then use the Edit Options Drop Down Menu to select the Move The Selected 
Carts option.
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Next type in the Cart Slot Number that you wish to move the first of the 
selected Carts to. In the example below, the first of the selected Carts will be 
moved to Cart Slot number 525.

You will then be asked to confirm your actions. Note that you will also be 
reminded that if you will need to update you scheduling system as well.

If you wish to proceed, click on the Yes button.

You will then be asked how you want Myriad Manager to deal with Cart Slots 
that already contains Carts. The options are:

 Yes – Any existing Carts will be overwritten by the Carts you are 
moving. The Carts overwritten will be permanently lost.

 No – Existing Carts will be preserved and the moved Carts will ‘step 
over’ any existing Carts.

 Cancel – Abandon the process.

If you select Yes then Myriad Manager will move the selected Carts to the 
desired location. As this happens, a progress bar along the bottom of the 
Audio Report window will display progress. Once the move has finished, the 
Audio report will be updated to reflect the changes you have made.
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Finally, Myriad Manager will display a summary of the amount of Carts that it 
has moved.

Edit Options – (Mass) Delete The Selected Carts

CAUTION – Whenever the words ‘mass’ and delete are used in any 
combination with reference to the Carts on your Audio Wall it is worth 
paying attention. When Carts are deleted from your Audio Wall there is 
no way that they can be recovered other than from your ongoing backup 
procedure, which of course you do regularly 

The ‘Delete The Selected Carts’ option on the Edit Options Drop Down List is 
used to delete one or more Carts from your systems Audio Wall. Once Carts 
have been deleted from the system, there is no way to restore them other 
than your regular backup.

To use this feature, follow these steps.

First select one or more Carts in the usual way (Ctrl + click or Shift and cursor 
keys).
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Next, use the Edit Options Drop Down List to select the Delete The Selected 
Carts option.

You will then be asked to confirm that you wish to delete the selected Carts.
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Click on Yes to continue.

You will then be asked to confirm again.

And again,
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And again….but this is really your very last chance to back out. Click on Ok of 
you wish to continue.

Myriad Manager will now delete the Carts that you selected in the Audio 
Report window. As it does so, a progress bar along the bottom of the Audio 
report window will show progress. After the Carts have been deleted, the 
Audio Report will be refreshed to reflect the changes you have made.

Finally, you will see a summary of how many Carts Myriad Manager has 
deleted.

Edit Options – (Mass) Export To Transport Files

The Export To Transport Files option is used to export one or more selected 
Carts to individual Myriad Transport files. 

Transport files are special zipped files that are created by Myriad and that 
contain all the information about a Cart on the Audio Wall. Transport files 
include the audio (wav) file for a Cart as well as all the title and timing 
information, copyright info, notes and even pictures for a Cart. Transport files 
can be imported in to Myriad which makes them a handy way of transferring 
Carts between different Myriad systems.
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When you use the Export To Transport Files option, a new zipped Transport 
File is created for each of the highlighted Carts and all the Cart information is 
copied in to the Transport file ready to be transferred to another Myriad 
system.

To use this facility, follow these steps.

Select one or more Carts that you want to use to create Transport files.

Next, use the Edit Option Drop Down List to select the Export To Transport 
Files option.



87

You can then select the folder that you want to export the Transport Files to. 
Note that you can use the ‘Make New Folder’ button to add a new folder to 
your system.

When you are happy with the location, click on Ok.
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Myriad Manager will then create each of the Transport Files in turn with a 
progress being displayed via the window above. Once the process has 
finished, Myriad Manager will return to the Audio Report window.

As you can see, the Transport Files are created in the selected folder and are 
ready to be transferred to another Myriad system.

Edit Options – (Mass) Export To WAV File

The Export To WAV File option on the Edit Option Drop Down List is used to 
export one or more Carts as standard WAV files so that they can be edited or 
imported in to a wide range of 3rd party applications. Please note that Myriad 
also imbeds title, artists and timing information in to the WAV files using the 
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Cart Chunk standard so WAV files that are exported from Myriad and then 
imported in to another Myriad system will retain the title, artist and timing 
information. 

To use this facility, first select one or more Carts to export using the Audio 
Report window.

Next, use the Edit Options Drop Down List top select the Export To WAV File 
option.
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Next, select the folder that you want to export the Carts in to. You can use the 
‘Make New Folder’ button to create a new folder.

When you are happy, click on the Ok button to export the selected files.
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As Myriad Manager exports the files, progress is displayed using a progress 
bar along the bottom of the Audio Report window.

If Myriad Manager encounters a WAV file that already exists, it will ask 
whether you wish to overwrite the existing file.
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Create A New Cart Button & Drop Down Menu

The Create A New Cart button on the Audio Report window is used to either 
create a new Cart on the Audio Wall that you can then record in to, or to 
import a WAV file or audio CD track in to the system as a Cart. 

As with the Edit Options button, the Create A New Cart button is split in to two 
sections.

The main button is used to create a new Cart. Clicking on this button will allow 
you to select the Cart Slot that you want to create your new Cart in, then open 
the SmoothEdit Screen to allow you to record and edit the details for your 
Cart.

The second part of the button is used to access the Import Drop Down Menu 
which is used to import WAV files in to the system or to ‘rip’ audio tracks from 
CD’s.

Clicking on the down arrow section of the button will expand the Import Drop 
Down Menu.

Create A New Cart

The Create A New Cart button is used to add a new Cart to the system. To 
use this facility, click on the Create A New Cart button.
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You will then be asked to specify the Cart Slot Number that you want to use to 
create your Cart.

Please note that Myriad Manager will automatically assign the next empty 
Cart on from the highlighted Cart in the Audio report window by default. If you 
want to use this Cart Slot Number then click on Ok, otherwise, type in the Cart 
Slot Number you want to use and then click on the Ok button.
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Myriad Manager will then open the Myriad SmoothEdit Screen for the Cart 
Slot Number you specified. You can then record audio in and edit the Cart 
Details in the normal way.

N.B. Using the SmoothEdit Screen to record audio and edit Cart Details is 
covered in detail in the main Myriad User Guide and so is not covered again 
here.

Create A New Cart – Import WAV File

You can use the Import WAV File option on the Create A New Cart Drop 
Down Menu to import one or more WAV audio files in to the Myriad Audio 
Wall as Carts.

This is done via the Import Audio Wizard which walks you through the import 
process one stage at a time.

Please note that the following section has been copied from the main Myriad 
User Guide so if you have already read the Myriad User Guide, you should be 
familiar with the procedure.

Select Audio Files Page
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This page of the wizard allows you to select the file or files that you want to 
import. There are a number of options on this screen so we will go through 
them in turn.

The Select Single File button allows you to browse your computer and 
network to select a single file to be added to the list of file to be imported. 
When you click on the Select Single File button, the standard windows file 
selection window appears.

You can use this window to select a single WAV or Transport (zip) file to be 
imported or (as in the example above) you can select multiple files by holding 
down the <Ctrl> key and clicking on the ones you want (other standard 
windows selection tricks also work). Click on the Open button and the files are 
added to the Files To Import list.
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You can click on the Import Single File button multiple times to select files 
from different folders or location to build up a list of files that you want to 
import.
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Note the tick by each file. Only the ticked files will be imported so even if you 
add a file to the list by mistake, you can still exclude it from the import 
process.

Below the Select Single File button is the Select Folder button which offers a 
simple ay of adding all of the suitable audio files within a folder, to the list of 
file to be imported. Clicking on this button allows you to select the folder whos 
content you want to import.
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The tick boxes to the left of the file in the Files To Import list is even more 
useful when you are adding a folders worth at a time because you can add 
the entire folder and then go through and exclude any you don’t want to 
import.

But how would you know?

The answer lies in the next button which is called the Check For Similar 
button. What this does is searches the Audio Wall and looks for any Carts that 
match the Title or Artist information for the files that you are planning to 
import. Obviously, this option will only be useful if the Title and Artist 
information is present which basically means that it is either embedded in to 
the filename (e.g. Overprotected – Britney Spears) or the information is 
hidden inside the file itself (i.e. it is CartChunk compliant which all Carts 
exported from Myriad are).

If you click on the Check For Similar button, the results are displayed in a 
separate panel underneath the Files To Import list.
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As you can see from the screen shot above, several of the Songs we are 
trying to import already exist on our Audio Wall so we may wish to exclude 
them from the import process by un-ticking the conflicting songs.

The File Name Processing options allow you alter the way in which Myriad 
interprets the file name when it is using it to title the files it is importing. 
Consider the following.

Overprotected – Britney Spears
Britney Spears – Overprotected
Overprotected / Britney Spears

To a human, it is clear that they are all the same track (i.e. Overprotected by
Britney Spears) but because software is not as intelligent as your average 
person, it can get confused by this type of situation. Myriad will always 
attempt to interrupt the file name as best it can but the File Name Processing 
options allow you to give it a hand by telling it which order it should be using 
for Title and Artists and also what character is being used to separate them.
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Use the drop down lists to select the options that best suit the files that you 
are trying to import. If you have several different filename formats within the 
list of files to import, it may be impossible to resolve the situation in which 
case it is advisable to import them in small batches of similarly formatted files.

The final option on this page is the Delete The File After Importing option 
which does exactly what it says. CAUTION – If you tick this option and then 
run the import process, there will be no way to recover the audio files that 
Myriad deletes.

Finally, when you are happy with all of the options on Select Audio Files page, 
click on the Next button to proceed.

Select Destination Carts Page

The next page on the Import Audio File Wizard allows you to select the Cart 
Slot Number that you want the first audio file in the list to be imported to and 
also how to deal with the subsequent files in the list.
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The top section allows you to choose between automatically assigning a Cart 
Slot Number on the Audio Wall starting from the selected point (which by 
default is the Cart you right clicked on originally) or to attempt to interpret the 
destination Cart Number from the file name (e.g. MYR05467.wav would be 
imported in to Cart number 5467).

The second option allows you to select whether to overwrite Carts that 
already exits in that range. Let’s say we were importing 10 files start at Cart 
number 2941 (as above) then they would each imported in sequence between 
Carts 2941 and 2951 on the Audio Wall. Now let’s say we already had a Cart 
at 2950 then if this option were ticked then the Cart at 2650 would be 
overwritten with the new imported Cart. If you leave this option unticked then 
the Cart at 2950 would remain and the position of the imported files after that 
would be shuffled up by one so the imported Carts would actually end at 
2952. Basically, if you leave this option unticked then the import process will 
stop over any existing Carts on your Audio Wall which is probably the way you 
will usually want it.

When you are happy, click on the Next button.

Import Audio Format

The next stage in the Import Wizard allows you to control the format of the 
audio files that you are importing and also the audio level of the audio within 
the files.
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From this screen you can opt to convert all the imported files to a pre-set 
format and compression scheme, leave the files in their current format 
(regardless of whether it is compatible with Myriad) or to convert them to a 
User specified format. You can also set whether to ‘normalise’ the audio and if 
so what level to normalise it to.

If you select the Convert The Audio To Match The Audio Wall Format option 
then (if possible) Myriad will convert the audio to the audio quality (e.g. 
44,100Khz stereo) and format (e.g. WAV, ADPCM etc) that has been set as 
the default for the Audio Wall - see Settings>Audio Settings menu and the 
Record / Edit tab – as seen below.
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This is the most commonly used setting as it ensures that the audio is 
converted in to the same format and quality as the other audio on the Audio 
Wall. It should be noted that Myriad cannot convert all file types and formats. 
If you import a file in quality or format that Myriad can not convert, you will be 
notified as it attempts the conversion.

The Import Audio In It’s Current Format option does exactly as the name 
suggest. Audio is imported in to the destination Cart but is left in the original 
format and quality. This option is not advisable as it could lead to Cart on the 
Audio Wall that Myriad can not play.

The Convert Audio To A Specified Format option allows you to set the audio 
format and quality for the import batch you are working on. To use this option, 
select it and then click on the Select button to choose the format you want to 
use.
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This will open the Choose Audio Format window which allows you to select 
from the available audio formats and quality options. The available options do 
differ from format to format but in general, the options are listed below.

 Audio Format – This allows you to select the basic audio format to 
convert the audio to. In Myriad v3, this is restricted to just Windows 
Wav files but in Myriad v3.1 this option is expanded to allow you to 
select from MP2, MP3, WMA (windows media format), Ogg (ogg 
vorbis) and WAV files in Myriad v3.1.

 Format (WAV only) – This option allows you to select between PCM 
(uncompressed WAV files) or ADPCM (4:1 compressed WAV files).

 Sample Rate – This allows you to select the sample rate on which the 
audio is based. N.B. This is not a configurable option on some formats.

 Bit Rate – This option allows you to set the bit rate at which to encode 
the audio. This options is only applicable to MP2, MP3, Ogg and WMA 
formats. The high the bit rate, the higher the quality but the larger the 
file size. It is usually accepted the 256Kbit MP3 or WMA give a 
comparable audio quality to CD’s but you must set the bit rate that best 
suits the balance between audio quality and file size that you station 
needs.

 Stereo / Mono – This option allows you to select whether the audio 
should be imported as a stereo or mono audio file. This option may not 
be available on all formats.

Many of the above options are only available in Myriad v3.1 so if you do not 
have all the options, please check that you are on the latest version of Myriad 
before contacting P Squared. Myriad v3.1 is scheduled for release in Autumn 
2005 so it is possible that not all the features will be available before this date.

The final option on the Import Audio Format page of the Import Audio Wizard 
is to do normalising the audio as it is imported. But what de we mean by 
normalising?

The basic idea is simple. An audio file or wave form is a graph of peaks and 
troughs and like any graph, there is always a point in the wave form that is the 
loudest single point. When you perform a normalisation, Myriad scans through 
the wave form to find this point. It then works out how much it would need to 
amplify this point by in order to reach the percentage level that you have 
specified when setting up the Normalisation. It then applies the same level of 
amplification to the entire wave form. This is important because as the loudest 
point is used to calculate the amplification level and this level is applied to the 
rest of the wave form, you avoid distortion by over amplification. It is also 
important because if multiple audio files are normalised to the same level, 
they should be pretty even in terms of volume as the loudest point in each file 
will always be at the same level.

If you tick the Normalise The Audio After It’s Imported option then Myriad will 
scan through the audio after it has imported it, find the loudest point and then 
work out how much it will need to amplify or reduce the volume by in order for 
this point to make it the same as the Percentage To Normalise To. Once it 
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has this value, it will then apply the same amplification / reduction to the rest 
of the file and hence the file will be normalised. The important thing is if all the 
audio files imported or ripped in to the Audio Wall are normalised to the same 
value then the loudest point in each file will be exactly the same.

You can alter the Percentage To Normalise To value as part of the normalise 
procedure. The value represents the entire range of volume of the sampled 
audio with 100% representing full volume (e.g. wave form reaches top of 
scale) and 0% presenting silence. The default of 63% has been calculated to 
provide audio normalised to -14Db which is the technically correct level for 
digital audio. It is worth experimenting to get the right level for your station. 
The Audio Wall Default button resets this value to the pre-set default 
normalise level which can be altered using the Setting>Audio Wall File 
Settings menu and selecting the Importing Audio tab.

When you are happy with the Import Audio Format setting, click on the Next 
button to advance to the next page of the wizard.

Import Audio Summary

This next page in the wizard provides an overall summary of the audio files 
that you want to import, along with destination Carts, Title & Artists 
information and length of audio.



106

If you are not happy with the displayed summary, click on the Back button 
until the relevant page is displayed and make whatever alterations are 
needed. If you are happy, click on the Next button to proceed.

You will then be asked to confirm that you want to proceed.

Importing Audio

Once you have confirmed that you want to proceed, Myriad starts the import 
process. The Importing Audio screen shows you a summary of the progress 
made along with a log of the actions it has performed.
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You can stop the import process at any time by clicking on the Stop Importing 
Audio button. If you do this then any audio files that have been successfully 
imported will remain on the Audio Wall but the current audio file and any 
remaining in the list to import will be discarded.

Once the import process has been completed, the final page of the wizard will 
be displayed.
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And that is that. Remember that if the imported files did not include embedded 
timing information, you will need to use SmoothEdit to set the Intro and Extro 
for the Carts in order for them to be sound good in an automated segue. If you 
have imported Songs or Links, you will also have to add them to your 
scheduling system as even when you are using AutoTrack or AutoTrack Pro, 
they will not automatically be added to the scheduling system.

Create A New Cart – Rip Tracks From A CD

You can also use the Create A New Cart Drop Down Menu to access the Rip 
Tracks From A CD option which is used to digitally copy one or more audio 
tracks from an audio CD in the computers CD-ROM drive, in to the Myriad 
Audio Wall as Carts.
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Selecting this option will open the Import Audio Wizard which is used to ‘walk 
through’ the steps needed to ‘rip’ audio tracks from a CD.

Please note that the following section has been copied from the main Myriad 
User Guide so if you have already read the Myriad User Guide, you should be 
familiar with the procedure.

Rip Audio From CD Tracks Page

The first page is the main page for setting which tracks that you want to rip in 
to Myriad and also how to interpret and process the audio tracks imported. 
This page of the Wizard contains a number of settings and options. The 
diagram below shows a general overview of the layout of the page and the 
individual options are examined in more detail below.

The most obvious section of the page is the Track Listing section. When you 
first move on to this page, Myriad Manager will automatically scan the CD that 
is in the CD ROM drive with the lowest drive number. It will read how many 
tracks are available on the CD and put an entry for each in the Track Listing 
area.

Beside each tracks is the Individual Track Selector which is a tick box option 
that allows you to indicate whether the track should be imported as part of the 
CD ripping process.
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In the above example, tracks 1,2,4 & 5 will be imported and all other tracks 
will be, ignored. This option is very useful when you are working with albums 
that only have a few tracks that you want to install.

Related to this feature are the Select All and De-select All buttons. As you 
would expect, these buttons allows you to select ‘tick’ all of the tracks on the 
CD to be imported or to de-select any that have already been selected.

The Get Titles button is only enabled if your Myriad system has been 
configured to use a web connection to ‘look up’ Title and Artist information for
CD’s using one of the CD databases available on the web (FreeDB or CDDB 
are the most common).

Once enabled, this option will make Myriad submit the unique ID number for 
the CD, to the online database and will then display any Title and Artist 
information listed in the database for the CD.
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Please note that the information stored on the online databases are 
maintained by the general public and as such the information my not be 
available or accurate. It is always worth checking that the information is both 
relevant and accurate. 

Once the information has been gathered, Myriad Manager will do it’s best to 
sort the information in to the correct fields in the Track Listing area. The 
problem is that there is no standard for entering the data on to the online
databases so sometimes the Artist and Title appear in the wrong order. To 
make matters worse, the character used to separate the Artists and Title is 
not always the same so you could end up seeing something like the screen 
shot below.
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This is where the Track Details Import Options come in to play to allow you to 
work around information that has been listed in correctly or in the wrong 
format.

We can see from this example that the ‘/’ character is used to separate the 
Artist and Title but we are using the ‘-‘ or ‘_’ characters to separate them so 
Myriad is not able to separate the information correctly. This is simple to fix 
however using the Separators drop down lists to select the correct character.



113

By selecting the ‘/’ character as one of the separators, the problem is sorted.
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The Item Title Order drop down list is used if the Title & Artist information 
appears the wrong way round in the Track Listing area.
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In this situation, you can use the Item Title Order to switch the Title and Artist 
to be displayed correctly.

The Force Title / Artist options allow you to overrule the information supplied 
by the online database with your own information.
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Once you have Title and Artist information that you are happy with, you can 
get Myriad to check the Audio Wall for existing Carts with similar Artist or Title 
information to avoid duplication, using the Scan Audio Wall For Similar button.
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This will scan the Audio Wall and display all Carts with similar information to 
the selected tracks in the Track Listing Area.
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As you can see from the example above, similar Carts were found for both 
Christina Milian and Anastacia but not the same track Titles to so that means 
that importing the Christina Milian and Anastacia tracks from this CD should 
be OK.

The final option on this page is the Automatically Trim The Silence From The 
Start Of The Audio (‘Top’) option which as the name suggests, automatically 
removes any silence from the beginning of the audio track as it is imported. 
This option is highly recommended as without it you would have to manually 
trim the silence from the beginning of tracks using SmoothEdit or Myriad 
would play the silence each time the Cart was played in a Cart Player.

When you are happy with the tracks that Myriad will import and that the 
additional information will be imported as correctly as possible, click on the 
Next button to continue.

Select Destination Carts Page

The next page on the Import Audio File Wizard allows you to select the Cart 
Slot Number that you want the first audio track in the list to be ripped in to and 
also how to deal with the subsequent tracks in the list.
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The top section allows you to choose between automatically assigning a Cart 
Slot Number on the Audio Wall starting from the selected point (which by 
default is the Cart you right clicked on originally).

The second option allows you to select whether to overwrite Carts that 
already exits in that range. Let’s say we were importing 10 tracks starting at 
Cart number 3092 (as above) then they would each imported in sequence 
between Carts 3092 and 2102 on the Audio Wall. Now let’s say we already 
had a Cart at 3100 then if this option were ticked then the Cart at 3100 would 
be overwritten with the new imported Cart. If you leave this option unticked 
then the Cart at 3100 would remain and the position of the imported files after 
that would be shuffled up by one so the imported Carts would actually end at 
3103. Basically, if you leave this option unticked then the import process will 
stop over any existing Carts on your Audio Wall which is probably the way you 
will usually want it.

When you are happy, click on the Next button.

Import Audio Format

The next stage in the Import Wizard allows you to control the format of the 
audio tracks that you are importing and also the audio level of the audio within 
the tracks.
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From this screen you can opt to convert all the imported tracks to a pre-set 
format and compression scheme or to convert them to a User specified 
format. You can also set whether to ‘normalise’ the audio and if so what level 
to normalise it to.

If you select the Convert The Audio To Match The Audio Wall Format option 
then (if possible) Myriad will convert the audio to the audio quality (e.g. 
44,100Khz stereo) and format (e.g. WAV, ADPCM etc) that has been set as 
the default for the Audio Wall - see Settings>Audio Settings menu and the 
Record / Edit tab – as seen below.
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This is the most commonly used setting as it ensures that the audio is 
converted in to the same format and quality as the other audio on the Audio 
Wall. It should be noted that Myriad cannot convert all file types and formats. 
If you import a file in quality or format that Myriad can not convert, you will be 
notified as it attempts the conversion.

The Convert Audio To A Specified Format option allows you to set the audio 
format and quality for the import batch you are working on. To use this option, 
select it and then click on the Select button to choose the format you want to 
use.

This will open the Choose Audio Format window which allows you to select 
from the available audio formats and quality options. The available options do 
differ from format to format but in general, the options are listed below.
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 Audio Format – This allows you to select the basic audio format to 
convert the audio to. In Myriad v3, this is restricted to just Windows 
Wav files but in Myriad v3.1 this option is expanded to allow you to 
select from MP2, MP3, WMA (windows media format), Ogg (ogg 
vorbis) and WAV files in Myriad v3.1.

 Format (WAV only) – This option allows you to select between PCM 
(uncompressed WAV files) or ADPCM (4:1 compressed WAV files).

 Sample Rate – This allows you to select the sample rate on which the 
audio is based. N.B. This is not a configurable option on some formats.

 Bit Rate – This option allows you to set the bit rate at which to encode 
the audio. This options is only applicable to MP2, MP3, Ogg and WMA 
formats. The high the bit rate, the higher the quality but the larger the 
file size. It is usually accepted the 256Kbit MP3 or WMA give a 
comparable audio quality to CD’s but you must set the bit rate that best 
suits the balance between audio quality and file size that you station 
needs.

 Stereo / Mono – This option allows you to select whether the audio 
should be imported as a stereo or mono audio file. This option may not 
be available on all formats.

Many of the above options are only available in Myriad v3.1 so if you do not 
have all the options, please check that you are on the latest version of Myriad 
before contacting P Squared. Myriad v3.1 is scheduled for release in Autumn 
2005 so it is possible that not all the features will be available before this date.

The final option on the Import Audio Format page of the Import Audio Wizard 
is to do normalising the audio as it is imported. But what de we mean by 
normalising?

The basic idea is simple. An audio file or wave form is a graph of peaks and 
troughs and like any graph, there is always a point in the wave form that is the 
loudest single point. When you perform a normalisation, Myriad scans through 
the wave form to find this point. It then works out how much it would need to 
amplify this point by in order to reach the percentage level that you have 
specified when setting up the Normalisation. It then applies the same level of 
amplification to the entire wave form. This is important because as the loudest 
point is used to calculate the amplification level and this level is applied to the 
rest of the wave form, you avoid distortion by over amplification. It is also 
important because if multiple audio files are normalised to the same level, 
they should be pretty even in terms of volume as the loudest point in each file 
will always be at the same level.

If you tick the Normalise The Audio After It’s Imported option then Myriad will 
scan through the audio after it has imported it, find the loudest point and then 
work out how much it will need to amplify or reduce the volume by in order for 
this point to make it the same as the Percentage To Normalise To. Once it 
has this value, it will then apply the same amplification / reduction to the rest 
of the file and hence the file will be normalised. The important thing is if all the 
audio files imported or ripped in to the Audio Wall are normalised to the same 
value then the loudest point in each file will be exactly the same.
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You can alter the Percentage To Normalise To value as part of the normalise 
procedure. The value represents the entire range of volume of the sampled 
audio with 100% representing full volume (e.g. wave form reaches top of 
scale) and 0% presenting silence. The default of 63% has been calculated to 
provide audio normalised to -14Db which is the technically correct level for 
digital audio. It is worth experimenting to get the right level for your station. 
The Audio Wall Default button resets this value to the pre-set default 
normalise level which can be altered using the Setting>Audio Wall File 
Settings menu and selecting the Importing Audio tab.

When you are happy with the Import Audio Format setting, click on the Next 
button to advance to the next page of the wizard.

Import Audio Summary

The Import Audio Summary page displays an overview of the CD tracks that 
are going to be imported and the destination Carts they will be imported in to.
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Click on the Next button to start the CD ripping process, you will then be 
asked to confirm that you want to proceed.

Click Yes to start the process.
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The import process is displayed both as a progress bar and as a text log of 
the tracks imported.

You can stop the import process at any time by clicking on the Stop Importing 
Audio button. If you do this then any audio files that have been successfully 
imported will remain on the Audio Wall but the current audio file and any 
remaining in the list to import will be discarded.

Once the import process has been completed, the final page of the wizard will 
be displayed.
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Click on the close button to return to Myriad Manager.

The Lower Tool Bar General Layout

The Tool Bar on the Audio Report window include a number of options so in 
order to make the documentation as clear as possible, the Tool Bar area has 
been split in to the Upper Tool Bar (covered in the preceding section) and the 
Lower Tool Bar (covered next).

The diagram below outlines the options on the lower two rows.
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We will now cover the functions of these Lower Tool Bar options in more 
detail.

Find Criteria

The Find Criteria field is used to type in a word or phrase that you wish to use 
to restrict the Carts displayed in the Audio Report window. If for example, you 
wanted to find all the Carts with the word ‘Dannii’ in either the Title or Artists 
(or other fields but we will come to that in a moment), then you could type 
‘Dannii’ in to this field and then hit the Find button to search the Audio Wall for 
Carts that match.

You can also use the drop down option to access a list of Find Criteria that 
you have used recently. 

Find Cart
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The Find Cart button is used to start the Find Cart process. Once you have 
typed in your Find Criteria and set all the other options you wish to use then 
click on the Find Cart button to search the Audio Wall and list the results in 
the Audio Report window.

Stop Find

The Stop Find button is only enabled when Myriad Manager is searching the 
Audio Wall and is used to stop the Find procedure before the entire Audio 
Wall has been searched.
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When you click on the Stop find button, any Carts that have been found on 
the Audio Wall that match the Find Criteria will remain listed in the Audio 
Report window. This means that if Myriad Manager has already found the 
Cart you are looking for, there is no need to continue searching the Audio 
Wall.

Display Empty Carts

The Display Empty Carts option on the Lower Tool Bar allows you to toggle 
the Audio report window between displaying all Carts regardless of whether 
they are populated or empty, and only showing Cart Slot Numbers that 
contain Carts.
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Take a look at the screen shots below.

In this example, the Display Empty Carts button is depressed so Myriad 
Manager will list all Cart Slots regardless of whether they are empty or not. 
Note that there are a number of empty Cart Slots between Carts 45 and 60. 

Now check out how clicking on the Display Empty Carts button effects the 
display.

Search Cart Notes

The Search Carts Notes button is used to instruct Myriad Manager to also 
check Cart Notes (Presenter, Web, DAB etc) when performing a Find Cart 
operation. If this button is depressed, Myriad Manager will check both the 
Title, Artist and Description fields and any Cart Notes when searching for 
Carts that match the Find Criteria.

Please note that toggling this option on will slow down the Find Cart process 
as Myriad Manager needs to check a number more data fields to find Carts 
that match the Find Criteria.

Search C



131

Note that the Display Empty Carts button is no longer depressed and the 
Carts listed in the Audio report jump straight from 44 to 60 skipping all empty 
Carts in-between.

When in this mode, you may well find that searching the Audio Wall or 
refreshing after you have performed an Edit Option will be much quicker in 
this mode as Myriad Manager will not need to display all of the empty Carts 
on the Audio Wall.

Search Cart Copyright Details

This options works the same way as the Search Cart Notes option in that 
when it is depressed and you perform a search, Myriad Manager will check 
the Copyright Details for each Cart as well and the Title, Artist and Description 
looking for Carts that match the Find Criteria.

As with the Search Notes option, turning this option on will slow down the Find 
procedure because Myriad Manager will need to examine a great deal more 
data.

Jump To XXXX

The Jump To XXXX field combines with the Jump button to allow you to jump 
to a specific Cart Slot Number on your systems Audio Wall.
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To use this feature, click on the Jump To XXXX field and type in the Cart Slot 
Number that you want to jump to.

You can then click on the Jump button to jump to the Cart Slot Number.

Jump Button

The Jump Button combines with the Jump To XXXX field to allow you to type 
in a Cart Slot Number that that wish to jump to on your Audio Wall. Once you 
have typed in the Cart Slot Number that you wish to jump to in the Jump To 
XXXX field then you can click on the Jump button to jump to that location. 

See the Jump To XXXX section for details on using this facility.
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Page Up / Down Buttons

The Page Up / Down buttons allows you to move up or down the Audio Wall 
displayed in the Audio Report a page at a time. 

The amount of Carts the Page Up / Down buttons move depends on the size 
of the Audio Report window as this dictates the amount of Carts that are 
displayed on a ‘page’.

You can also use the <Page Up> / <Page Down> keys on the keyboard to 
achieve the same thing.

Cart Ranges

The Cart Ranges fields allow you to type in a start and end Cart Slot Number 
to form a Cart Range within which the Audio Report will work. This facility can 
be combined with any of the options we have looked at so for example, you 
could type ‘Black Eyed Peas’ in to the Find Criteria and 3000 to 5000 in the 
Cart Range and then hit Find Cart and the Audio Report window will show all 
Carts that contain the words ‘Black Eyed Peas’ and are located on the Audio 
Wall between Carts 3000 and 5000.

This option is really useful if you are working in a specific range (say the 
music only) and you do not want Myriad Manager to display all the other Carts 
on the Audio Wall. This can also speed up operational functionality when you 
are performing mass manipulation as each time you mass move or copy 
Carts, the Audio report display is updated to show the results and if you do 
not have any Cart Range restrictions in place, the entire Audio Wall will be re-
scanned which can take some time on some systems.

Audio Report Results

As you have probably already worked out, the Audio Report Results section of 
the window is used to display the Carts that match the criteria set when you 
first run the Custom Cart Report or if you use the tools in the Tool Bar Area to 
set the Cart report Criteria.

In Myriad Manager, the Audio Report Results section is only available in ‘list’ 
mode although you may see a similar looking window in other areas of Myriad 
and AutoTrack Pro that allows you to view the Carts in an alternative way.
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The Audio Report results section of is divided in to columns with each column 
representing a data field for the Carts listed. Initially, the Cart Report Results 
will be listed numerically by Cart number with the lowest Cart Number at the 
top of the list and the highest at the bottom but you can alter the displayed 
results to be sorted numerically or alphabetically by any of the column fields 
by clicking on the corresponding column header (just like any standard 
windows application).

You can combine this with any of the Cart Report Criteria to get the 
information you need displayed in the way most helpful for you.

The Audio Report column headers are outlined below.

Column Header Description
Cart The Cart Slot Number on the Audio 

Wall
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Title The Title of the Cart on the Audio 
Wall

Artist The Artist listed on the Audio Wall
Description The Description listed on the Audio 

Wall
Intro The length of the Intro specified on 

the Cart
Length The length of the Cart (to Extro) on 

the Audio Wall
H H shows that the Cart has a Hook 

defined
L L shows that the Cart has a Looped 

Section defined
Ending Shows the Ending Type for the Cart 

on the Audio Wall

Selecting Multiple Carts Using The Audio Report Results

A number of the tools and facilities offered by the Audio Reports Window are 
based on selecting one or more Carts from the Audio Report Results window.

In the example above, several Carts have been selected and these are 
indicated by the blue highlight bar.
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There are a number of ways that multiple Carts can be selected in this 
window.

 <Shift> + <Cursor Keys> - You can hold down the <Shift> key on your 
keyboard and then use the <Up> and <Down> buttons or the <Page 
Up> / <Page Down> button to select multiple Carts. You can also hold 
down <Shift> and then click on a Cart using the left mouse button and 
this would select all of the Carts between the currently highlighted Cart 
and the one you clicked on. This method is fine but it does not allow 
you to select Carts in more than one block so you can not select all the 
Carts between 1 and 20 excluding Cart 15.

 <Ctrl> + Left Mouse Click – If you hold down the <Ctrl> key on your 
keyboard and click on Carts in the Audio Report Results window using 
the left mouse button then the Cart you click on will toggle between 
being selected and de-selected. The advantage of this method is that 
you could use the <Shift> + <Down> method to select Carts 1 to 20 
and then hold down <Ctrl> and click on Cart 15 to de-select it. This 
would be how you could select all the Carts between 1 and 20 
excluding Cart 15.

 <Ctrl> + <A> - This will select all of the Carts in the Audio Report 
Results window, even the ones that are off the bottom of the visible 
range.

Please note that all of these methods are common to most Windows 
applications so you will probably be familiar with them all.

Run A Previously Saved Cart Report

In the previous section, we looked at how you could use Myriad Manager to 
run a custom Cart Report and how we can set the criteria for the Cart Report 
to provide the information that you need.

You may find that there are some Cart Reports that you need to run fairly 
regularly at your system and rather than have to put in the criteria for the Cart 
Report each time, Myriad Manager allows you to ‘Add A New Cart Report’ to 
the system which will then be listed as a previously saved Cart Report which 
you can then access at any time.
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To run a previously saved Cart Report in Myriad Manager, simply double click 
on the report you wish to run in the list.
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In the example above, we double clicked on the previously saved Cart Report 
entitled ‘Show Carts With Long Extros’. The Audio Report shows the results 
for the criteria that has been saved as part of the report. 

Next we will see how we add one of these previously saved Cart Reports 
using the Add A New Cart Report option.

Renaming And Deleting Previously Saved Cart Reports

You can rename and delete previously saved Cart Reports by right clicking on 
the Cart Report you want to work with then selecting the appropriate option 
from the right click menu.
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If you select the Rename option then you can type in a new name for the 
selected Cart Report.

If you select the Delete Report option then you will be asked to confirm that 
you wish to delete the selected Cart Report.

If you click on Yes then the Cart Report will be removed from the list.



140

Add A New Cart Report

The Add A New Cart Report option under Cart Reports allows you to enter the 
Cart Report criteria (just like a Custom Cart Report) but you can then save 
your Cart Report criteria using a name of your choice. You can then run this 
previously saved Cart Report any time you wish by double clicking on it in the 
list.

To add a new Cart Report, double click on the ‘Add A New Cart Report’ option 
or highlight the option and then click on the Open button.

Next, set the Cart Report criteria that you wish to use for your Cart Report 
using the Audio Browser Options window.
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The options on this window are covered in detail in the Run A Custom Cart 
Report > Audio Browser Options section earlier in this Chapter.

In this example we will add a Cart Report that shows all of the Compressed 
Carts on our Audio Wall so first we need to select the ‘Display Compressed 
Carts’ option from the Audio File Format drop down lost.
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You could also add in any additional criteria that you wish to add but for this 
example we will assume that we have set all the criteria we wish to use. So 
click on OK.

Next, Myriad Manager asks you what you want to call your Cart Report, type 
in a suitable name. 

Your Cart Report has now been added to the list and will remain there until 
you remove it. You can run it at any time by double clicking on it in the list. 
You can rename or delete it by right clicking on it and using the right click 
menu.
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Please note that Cart Reports are a global option which means if you add a 
new Cart Report in one machine, it will be accessible on Myriad Manager on 
all the workstations on your Myriad network.

Audio Play Log Reports

The Audio Play Log Reports section of Myriad Manager is used to extract 
reports about the Carts that have been played using your Myriad system over 
the specific time period.

Every time Myriad plays a Cart it keeps a record of it in the Play Logs along 
with a range of additional useful information such as how much of the Cart 
was played, where is was played and who played it (well who was logged in at 
least).

These Logs are maintained by Myriad on a indefinite basis with a small text 
file created for each day of use. In theory, this means that the longer you have 
Myriad running, the more space the Play Logs will take on your system but in 
practice, because the files are very small, it is unlikely that you will ever need 
to manually delete any Play Log (20060717.ply for example) files from your 
system.

The Audio Play Log Reports section of Myriad Manager allows you to runs a 
custom ‘one off’ Play Log Report to see what Carts were played within the 
range of criteria you set (like date range on a specific workstation etc). You 
can also add Audio Play Log Reports to the system to be accessed in the 
future, so you may create a Audio Play Log Report that listed the most played 
Carts for the last week.
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The Audio Play Log Reports section of Myriad Manager is very similar in 
layout and use to the Cart Report section we looked at in the last section.

Run A Custom Play Log Report

The ‘Run A Custom Play Log Report’ option is used to run a ‘one off’ Play Log 
Report using a set of criteria that you set prior to running the report. If you use 
this method to run a Play Log Report then the criteria you set are discarded 
by the system after it has displayed the Play Log Report results.

To use this option either double click on the ‘Run A Custom Play Report’ 
option or highlight the option and click on the Open button.
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This will open the Play Log Options window which is used to select the criteria 
you want to use for the Play Log Report.
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The Play Log Option Window

The Play Log Options window allows you to set a number of criteria that 
Myriad Manager will use when generating your Play Log Report.

The Play Log Options window is divided in to two tabs, the General tab allows 
you to set the most commonly used criteria for generating Play Log Reports 
whilst the Other Options tab allows you o expand upon these options.
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General Tab > Played Dates > Only Shows Carts Played In The Last XX 
Days

The Played Dates section of the Play Log Options screen allows you to 
restrict the Carts listed in the Play Log Report to only include Carts played 
within a specific time frame.

The top section allows you to restrict the Play Log Report to only include 
Carts played in the last XX days and you use the drop down list to select the 
date range you wish to work with.
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As you can seem the drop down range includes a number of options ranging 
from the last day to the last year.

The good thing about this feature is that whilst it allows you to set a time 
frame, it does not specify the exact dates so you can use this to add a Play 
Log Report that listed all of the Carts played in the last week and then you 
could run it on a weekly basis to allow you to see what has been happening in 
the past week.

General Tab > Played Dates > Only Show Carts Played Between XXX

Unlike the option in the previous section, this option allows you to set a 
specific date range and only Carts played between he selected dates will be 
included in the Play Log Report. 

In the example above, the Play Log Report would only include Carts played 
between 00.00am and 23.59pm on the 17th of July 2006.

To set a new date you can click on the date field and type in a date (most 
formats will be recognised) or click on the From button to access the calendar.
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To set the time, highlight the start or end time and type in the time (in hours 
and minutes) that you wish to use.

Remember that using this option will only allow you to set a single start and 
end date for the Play Log Report so if you added a Play Log Report that used 
a specific date range, every time Myriad Manager ran that report, the same 
date range would be used.

Genera Tab > Audio Range > Carts From XXX to XXX

This option allows you to set a range of Carts that will be used to generate the 
Play Log Report.
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In the example above, the Audio Range has been set to only run include 
Carts between Cart Slot 3000 and Cart 5000 which means the Play Log 
Report that is generated will only include Carts between that range.

You can combine this with the Played Date criteria for more specific results.

In this example, the Play Log Report will only list Carts ranging from Cart Slot 
3000 to Cart Slot 5000 that have also been played in the past week.

You can either type in the Cart Numbers in to applicable fields.

Or you can click on the Browse buttons to use the Audio Browser (See Audio 
Browser section of main Myriad User Guide for more details) to select the 
Carts Slot Number you want to use.

The Browse buttons will  open the Audio Browser, you can then double click 
on the Cart Slot Number that you wish to use.



151

General Tab > Computers

The Computers section allows you to limit the Carts listed in the Play Log 
Report to only include Carts played on particular workstations.

If there are no Computers listed in the Computers section then the Play Log 
Report will include all Carts played regardless of which workstation played the 
Cart. 
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If you want to restrict your Play Log Report to only include Carts played on 
one or more workstations then you can use the ‘+’ button to add a Computer 
to the list.

This will then allow you to select the Computer you want to add to the list 
using the drop down menu.

This list will be populated by the list of Computers you have set up in the 
Computer Details of Myriad Settings that can be found on the Other Settings 
tab (see Settings Menu > Myriad Settings > Other Settings Tab in the main 
Myriad User Guide for details).
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As you can see from the example above, on this system, Myriad has been 
configured to have just two workstation so ‘Illyria’ and ‘Studio 1 Playout PC’ 
are included in the Computers drop down list.

If we wanted to only include Carts played on the Studio 1 PC then we could 
select this option then click on OK.
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You may also notice that there is an additional option which is the <On-Air 
Computer> option which does not refer to a specific PC but rather will 
generate the Play Log Report to include Carts played on all workstations that 
had On-Air Control.

Let’s say you have two studios and the one that is used for ‘live’ broadcasting 
switches between them. As outlined in the Myriad documentation, you would 
use either Simple or Advanced On-Air Control to allow you to specify which 
PC has ‘On Air’ control at any point.

The <On-Air Computer> option instructs Myriad Manager to generate the Play 
Log Report to include the Carts that were played by the On-Air PC (which 
ever that might be).  

So if you broadcast from Studio 1 in the morning and then switched to Studio 
2 in the afternoon, you could use the <On-Air Computer> option to generate a 
Play Log Report that listed all the Carts played in Studio 1 in the morning and 
all the Carts played in Studio 2 in the afternoon but if the <On-Air Computer< 
was the only selected Computer option in the list then any Carts played in 
Studio 1 in the afternoon (when it did not have On-Air control) would not be 
included in the Play Log Report.

You can add several Computers to the list to get a combined Play Log Report 
if you wish.
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You can also remove Computers from the list by highlighting them and then 
clicking on the ‘x’ button.

Remember, if the Computers list is empty then the Play Log Report will 
contain all Carts played, regardless of which Computer played them.

Other Options Tab > Miscellaneous > Collate In Order (As Chart)

The Miscellaneous section of the Other Options tab contains a setting to allow 
you to automatically display the results in the Play Log Report ordered by the 
amount of times that a Cart has been played which effectively allows you to 
display the results as a chart!

If you want to view the Play Log Report ordered by number of times a Cart is 
played, tick the ‘Collate And Order Results By Number Of Plays’ option.
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Remember that you can combine this option with other Play Log options to 
get the Play Log Report you want. Take a look at the settings below.
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Now if we assume that we are using ON-Air Control to set the workstation that 
is ‘broadcasting’ and that our music is stored between Cart 3000 and Cart 
5000 on our Audio Wall then the Play Log Report that these settings would 
display would be a ‘chart’ of all the music played ‘on-air’ in the past week, 
which is nice!

To run the Play Log Report and view the results, click on the OK button.
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Please note that if this option is not ticked then if a Cart is played three times 
in specific period then it will be listed three different times in the Play Log 
Report. If this option is ticked then it will appear only once but it will be 
recorded as having been played three times.

Play Log Reports

The Play Log Reports window displays the Carts played that match the 
criteria set in the Play Log Options window.
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The screen shot above shows a typical Play Log Report. In this case it is only 
showing Carts played on a specific day but that will depend entirely on the 
options set on the Log Options window.

Play Log Report General Screen Layout

The Play Log Report window is divided in to the Play Log Report Results and 
the Play Log Report Tool Bar sections. The Tool Bar section provides a range 
of tools and options for working with Play Log Report whilst the Play Log 
Report Results section is used to list the Carts that match the Play Log 
Options you set.
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The Play Log Report Tool Bar

The Tool Bar on the Play Log Reports window offers a range of tools and 
facilities for working with the Play Log Report results.

The diagram below shows the options available on the Play Log Report Tool 
Bar.

Save Report Settings
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The Save Report Settings option allows you to save the criteria used to 
generate the Play Log Report you are working with so that you can run the 
report again at a later date.

If you click on this option, you will then be asked to provide a name for your 
saved Play Log Report.

Type in a name that best describes the report and then click on the OK 
button.

The Play Log Report will be listed under the general Audio Play Log Reports 
section on the left hand side of Myriad Manager and can be run again at any 
time by either double clicking on it or highlighting it and clicking on the Open 
button on the tab strip.
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Refresh Results

The Refresh Results button will force Myriad Manager to repeat the Play Log 
Report search and list the new results. This is useful if other Myriad users 
have been playing Carts whilst you have been working with the Play Log 
Report window.

Stop Refresh

The Stop Refresh button is only enabled whilst Myriad Manager is performing 
a refresh operation (see above > Refresh Results) but as this usually only 
takes a fraction of a second. You should not have much need for this option.

Play Log Options

The Play Log Options button allows you to open the Play Log Options window 
to review or adjust the criteria used to generate the Play Log Report you are 
working on.

The Play Log Options Window will show the criteria your used to generate the 
Play Log Report and if you change any of the criteria and then click on the OK 
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button then Myriad Manager will generate a new Play Log Report based on 
your new criteria.

For full details on the options available on the Play Log Options window, 
please refer to the Play Log Options Window section covered earlier in this 
Chapter.

Print Highlighted Results

The Print Highlighted Results button is used to print a list of the selected Carts 
using your computers default printer.

If only have one item highlighted in the Play Log Report then Myriad Manager 
will print all of the Carts listed in the Play Log Report.

If you have more than one Cart selected (by holding down Ctrl and clicking on 
several items – see Selecting Multiple Carts Using The Audio Report Results 
in the last section for more details on how to do this) then only the highlighted 
Carts will be sent to your default printer.
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Export As CSV File

The Export As CSV File option is used to export the selected list of Carts as a 
single text file with the information for each Cart separated by the use of 
commas. This type of file can be imported by most third party data 
manipulation applications such as Microsoft Excel and Access.

When you click on this option, you will be asked to set the file name and 
location of the CSV file that Myriad Manager will generate.
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Once saved, you can open the CSV file in a range of applications.

Please note that unlike the Print option outlined above, the Export To CSV file 
will always include all of the Carts listed in the Play Log Report in the exported 
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CSV file regardless of which Carts are highlighted when you click on the 
Export To CSV button.

Play Options

The Play Options is a multifunction button. If you click on the main section of 
the button then Myriad Manager will load the last highlighted Cart in to a free 
Cart Player for you to listen to. 

But if you click on the drop down arrow to the right of the button you access 
the Play Options menu.
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This allows you to add the selected Carts to a Myriad Pad Run which allow 
you to then listen to the Carts in order or even save the Pad Run load it up 
again later in Myriad.

One useful application for this is to generate a chart that you can then use in 
Myriad for playout. 

Remember that in the example above, we searched for all the Carts played 
from the songs range on the Audio Wall for a particular day and that we ticked 
the ‘Collate As Chart’ option when setting up the Play Log Options.

This effectively gave a list of all the songs played on the specific day and they 
are arranged that the most played is at the top and the least played is at the 
bottom (like a chart).

Well if we then selected all the Carts in the Play Log Report (<Ctrl> + <A> will 
do this) and then used the Play Options drop down list to select the ‘Add 
Selected Carts To A Pad Run’ option.
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We would first be asked whether we wanted to arrange them as a count down 
(i.e. least played song is played first in Pad and most played song plays last in 
pad). For this example we will assume we are after a count down so we say 
‘Yes’ at this stage.

Myriad Manager will then fill the Pad (from Myriad) with the Carts in ascending 
order. You could then either play the Pad Run in Myriad Manager or you can 
also save the Pad Run and load it up in Myriad later on.

Edit Last Selected

The Edit Last Selected option allows you to open the Myriad SmoothEdit 
Screen for the Cart last selected from the Play Log Report.
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If you select this option then the SmoothEdit Screen from Myriad will open in 
Myriad Manager and will display the audio and data information for the last 
Cart to be highlighted in the Play Log Report. You can edit both the data and 
the audio from this screen and changes you make and save here will be 
updated in ‘real time’ on your Myriad workstations.

Play Log Results

The Play Log Results section lists all of the Carts that Myriad Manager finds 
that matches the criteria you have set in the Play Log Options screen.
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As you will see, the Play Log Results shows all the Carts played within the 
selected time frame and takes in to account all of the other criteria such as the 
Computers that played the Carts etc.

By default, the Cart in the Play Log Report will be listed by date (unless you 
ticked the Collate as a chart option) but you can sort the results by any of the 
columns by clicking on the column header (just like a spread sheet or 
windows explorer).

If you double click on a Cart in the Play Log Results then the SmoothEdit 
Screen for that Cart will automatically open which allows you to edit the 
details and audio for that Cart.

A number of the tools and facilities offered by this window are based on 
selecting one or more Carts.
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In the example above, several Carts have been selected and these are 
indicated by the blue highlight bar.

There are a number of ways that multiple Carts can be selected in this 
window.

 <Shift> + <Cursor Keys> - You can hold down the <Shift> key on your 
keyboard and then use the <Up> and <Down> buttons or the <Page 
Up> / <Page Down> button to select multiple Carts. You can also hold 
down <Shift> and then click on a Cart using the left mouse button and 
this would select all of the Carts between the currently highlighted Cart 
and the one you clicked on. This method is fine but it does not allow 
you to select Carts in more than one block so you can not select all the 
Carts between 1 and 20 excluding Cart 15.

 <Ctrl> + Left Mouse Click – If you hold down the <Ctrl> key on your 
keyboard and click on Carts in the Audio Report Results window using 
the left mouse button then the Cart you click on will toggle between 
being selected and de-selected. The advantage of this method is that 
you could use the <Shift> + <Down> method to select Carts 1 to 20 
and then hold down <Ctrl> and click on Cart 15 to de-select it. This 
would be how you could select all the Carts between 1 and 20 
excluding Cart 15.

 <Ctrl> + <A> - This will select all of the Carts in the Audio Report 
Results window, even the ones that are off the bottom of the visible 
range.
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Please note that all of these methods are common to most Windows 
applications so you will probably be familiar with them all.

Play Log Results Column Headers

The Play Log results are displayed in a grid formation with each column listing 
a particular type of data for the Carts. 

You can sort the order in which the Carts in the Play Log Report are displayed 
by any of the columns by clicking on the Column Headers. Let’s say for 
example that you wanted to view the Carts by Cart Number then all you would 
need to do is click on the ‘Carts’ column header and the Carts would be 
displayed by Cart Number in ascending order.

There are a number of different Column Headers in the Play Log Report, the 
table below briefly explains what they are.

Column Header Description
Date The date the Cart was played
Time The time Cart was played
Duration The overall length of the Cart (to extro)
Played The amount of the Cart that Myriad actually played
Cart The Cart Slot Number on the Audio Wall
Description The Cart Description lines (title, artist and description)
Location The Computer that played the Cart
Login The User logged in when the Cart was played
Reference Special reference code (usually adverts only)
Player The Cart Player used to play the Cart
Hardware Active Any Hardware lines that were active when the Cart was 

played

Please note that you can change the width the columns in the Play Log 
Report by left clicking on the line between each Column Header and dragging 
left or right.
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This can be useful if you are not able to see all of the information in a 
particular column.

Save Results As A Reconciliation File

The Save Results As A Reconciliation File button is normally only used when 
you are using a third party advert scheduling system. Clicking on this button 
will save a special ‘reconciliation’ file in to a pre-defined location that includes 
the details for when Carts were played by Myriad. This play information is 
then reconciled with the scheduled time for play in the advert scheduling 
system and then used to provide billing and impact information to the 
advertising customer.

Although Myriad supports the generation of reconciliation files, it does not 
support the process any further. Also, reconciliation files are not used by the 
Advanced Advert Manager (by P Squared) as it is able to read the Myriad play 
logs directly.

To use this facility, ensure the Carts you want to included in the Play Log 
Results and then click on the button.

The location that Myriad Manager will use to save the reconciliation file is 
determined by the Station Database (see Settings Menu > Station Database 
Settings > Log Import tab in the Myriad User Guide for more details) so if you 
have not configured Myriad to automatically use a Station Database then you 
will first be asked which Station Database you wish to use.

Highlight the Station Database you want then click on OK.
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Myriad Manager will then generate the reconciliation file in the folder location 
set in the Station Database and let you know when it has finished.

Run A Previously Saved Play Log Report

As with the Cart Reports covered in the previous section, Myriad Manager 
allows you to add a number for saved Play Log Reports to allow you to quickly 
perform tasks that you may do regularly.

Play Log Reports that have been saved in the past are displayed directly 
underneath the Run A Custom Play Log Report option on the Audio Tab Strip.

You can have a large number or previously saved Play Log Reports if you 
wish although you may find a few will cover all of your needs.

In order to run a previously saved Play Log Report, either double click on it or 
highlight the option and the click on the Open button on the tab strip.
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In this example, let’s say we wanted to run the ‘Show Carts Played In The 
Last 7 Days’ Play Log Report. Highlight the report and then click on the Open 
button.

The Play Log Report will then be displayed in the main Myriad Manager work 
area.

You can also Rename or Delete a previously saved Play Log Report by right 
clicking on it and then selecting the action you want from the right click menu.
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If you select Rename then you are asked what name you would like to use.

If you select the Delete option, then you are first asked to confirm that you 
want to delete the Play Log Report.

If you click on ‘Yes’ then the previously saved Play Log Report will be 
removed from the system.

Add A New Play Log Report 
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In the last section we looked at how to run a Play Log Report that had been 
saved previously so obviously, we need to be able to save the Play Log 
Report criteria in the first place.

To add a new Play Log Report, either double click on the Add New Play Log 
Reports option or highlight the option and then click on the Open button.

Next, use the Play Log Options window to set the criteria that you wish to use 
as the basis for your saved Play Log Report.
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The options on this window are covered in detail in the Run Custom Play Log 
Report section of the documentation. When you are happy with your settings, 
click on the OK button.

Type in the name that you wish to use for your new Play Log Report and then 
click on the OK button.

Your new Play Log Report will be added to the list of available Play Log 
Report, to run the report, double click on it or highlight it and then click on the 
Open button.

Copyright Reports

In addition to the Play Log Reports outlined in the previous section, Myriad 
Manager also has the ability to generate Copyright Reports which are similar 
in that they are based on what Myriad has played but the information supplied 
in the report has been extended to include the additional copyright information 
most copyright bodies require you to provide.

Please note that in all cases, the copyright reports only report the information 
stored in Carts on the Audio Wall so if the information is not available on the 
Cart, it will also not be available on the report.
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As with the previous sections, the Copyright Report section of the main tab 
allows you to select a number of options. These may change depending what 
country you are in (as they are based on copyright report profiles) but in the 
UK, the defaults are.

 General Copyright Report – Includes all available copyright 
information in the report.

 UK PRS Commercial Return – Limits the displayed information to that 
needed by UK PRS for a commercial return.

 UK PRS Music Return – Limits the displayed information to that 
needed by UK PRS for a music return.

Whilst these appear as different options, they all run the same report, but in 
the PRS reports, certain fields are minimised to hide the information that PRS 
does not require.

To access the Copyright Report tool, double click on one of the Copyright 
Report options or highlight it and click on the Open button.

General Copyright Report

The General Copyright Report allows you to specify a start and end date / 
time, the location that Carts were played and restrict the Cart Range to be 
examined, the system will then take these criteria and generate a report 
based on the Myriad Play Logs. This report will contain all of the additional 
Copyright information that you have added to Carts and should be ready to 
print and send to the relevant copyright body.
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Copyright Report General Layout

The Copyright Report general layout is outlined below.

The Tool Bar

The Tool Bar on the Copyright report screen offers a range of options.
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Search

The Search button is used to begin the generation of the Copyright Report.

Stop Search

The Stop Search button is only enabled when Myriad Manager is generating a 
Copyright Report and is used to stop the generation process.

Print

Use this button to print the contents of the Copyright Report to your default 
printer.

Export To CVS File

This option is used to save the contents of the Copyright Report as a special 
text file where all the data is separated by commas. This type of file can be 
imported by most third party data applications such as Access and Excel.

Edit Details

This option is not enabled on the Copyright Report screen.

Delete From Report
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Use this option to remove one or more highlighted Carts from the Copyright 
Report.

Play Cart

If you click on this button, Myriad Manager will load the last selected Cart in 
the Copyright Report in to a free Cart Player to allow you to review the Cart.

Edit Cart

This button will open the SmoothEdit Screen for the last selected Cart in the 
Copyright Report to allow you to edit the Carts audio or data information.

Time Date Range

The Time / Date Range section allows you to set the first and last time / date 
that you want to include in your Copyright Report.

You can either type in the time and date (most formats will be recognised) or 
you can click on the ‘From’ or ‘To’ buttons to select a date using the calendar.

Computer Location

The Computer Location section allows you to limit the Copyright Report to 
only displaying Carts played on a specific workstation or to only include 
workstations that were ‘On Air’.

To select the Computer Location you want to base the report on, use the drop 
down list.
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If you select the <Any Location> option then all Carts will be included 
regardless of which Myriad workstation played them.

N.B. The <On-Air Computer> is a special case option that forces Myriad 
Manager to include Carts played on the ‘On-Air’ machine in the Copyright 
Report.

This is all linked to the ‘On-Air’ / ‘Off-Air’ status in Myriad (using either simple 
or advanced ON-Air Control) so if your studio 1 PC was ‘on-air’ all morning 
but you switched On-Air  Control to studio 2 in the afternoon, the Copyright 
report would automatically track that change in control and include Carts 
played in studio 1 in the morning and Carts played in studio 2 in the afternoon 
(but not vice versa).

Cart Range

The Cart Range option allows you to set the range of Carts to be included in 
the Copyright Report. If for example, you were doing a music return then you 
would want to limit the range of Carts included in the Copyright Report to only 
include your music (say from Cart 3000 to 6000 for example).

To use this feature, just type the Cart Slot Number you want to use in the 
provided fields.

Column Headers

The Column Headers are used to show what each column of data in the 
Copyright Report represents. 

Cart Number

The Cart Number on the Audio Wall.
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Air Date

The date that the Cart was played.

Air Time

Time that the Cart was played.

Air Location

The Computer Location where the Cart was played.

Product Title

The product title for the audio you are working with. This could be an album 
title for example.

Play Count

This column shows the amount of times the Cart was played. It is not usually 
applicable in Copyright Reports.

Music Title 

The title of the music you are working with. Click on the Copy button to copy 
the Title from the General tab.

Copyright Code

This allows you to assign a code to identify the use for the audio. The options 
are:

 Not Specified
 C – Commercial
 D – Disc
 L – Live / Local
 P – Promo
 S – Station Ident

Composer / Arranger

The name or names of the composer / arranger.
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Performer

This is the name of the artist who performed the song. This can be copied 
from the Artist field on the General tab using the Copy button.

Publisher

This is the name of the company that published the recording.

Record Label

This is for the name of the record company that owns the recording.

Recording Number

This is normally the unique recording number found on the spine of the CD.

Music Duration

This allows you to specify a separate music duration. This may be useful if 
you are working with a promo that is 30 seconds long but only contains 10 
seconds of music. You would set Total Duration to 30 seconds and Music 
Duration to 10seconds. That way, if your music copyright body charges per 
second played, you will not have to pay for time you did not use.

These definitions are intended as guides only please consult with the 
appropriate copyright organisations that you report to for more details about 
the information you need to be adding to these fields.

Duration

The is the total duration of the audio recording. You can click on the Copy 
button to copy the overall Cart Length from the General tab.

Report Results

The Report Results section shows the details for the Carts that match the 
report criteria you have set.
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You may notice that some of the information listed is in italics, this is to 
indicate that the Cart does not actually have that information set but Myriad 
Manager has extrapolated it from the information it does have.

Take a look at Cart 3009 in the example above. Myriad knows that the Music 
Title is ‘Why Does My Heart’ because we told it so but we look at the 
SmoothEdit Screen for that Cart (which you can do by double clicking on it) 
then we will see that the Product Title field on the Copyright tab is blank.

Rather than leave the field blank in the Copyright Report, Myriad Manager has 
guessed that the Product Title will be the same as the Music Title and filled it 
in on the report accordingly, but it has filled it in using italics to warn you that 
an assumption has been made.

This allows you to review the Copyright Report, checking to see where Myriad 
Manager has made substitutions and correcting them if necessary.

N.B. The italic entries only appear on screen, when you print the report, none 
of the text will be in italics.
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UK PRS Commercial / Music Return

The UK PRS Commercial Return and UK PRS Music Return options are 
included by default with UK installation but may be replaced with other options 
at installations outside of the UK.

Basically, if you double click on either of the UK PRS options, it will open the 
same basic Copyright Report window as detailed above but only the fields the 
UK PRS are interested in will be visible.

The allows you to generate a report for PRS that only contains the information 
they need and it will print in the format they recommend.
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As you can see from the screen shots above, the layout and of the report itself 
is the only difference between the two.

Chapter 3 – The Contacts / Users Tab

The Contact / Users tabs is used in Myriad Manager to review and manage 
two important things.

 General Station Wide Contacts – The P Squared Director provides a 
unified, station wide contact database for store contact details for 
everyone your station need to be able to contact. Whether it is 
technical support, local police or the pizza guy, by add the contacts to 
the P Squared Directory, the details can be accessed by Myriad 
Manager, Scoop and the stand alone P Squared Directory Manager 
from anywhere in your station.

 Users Of P Squared Products – The Users section of the Contacts / 
Users tab refers to managing the list of User who have access to 
Myriad, Scoop, PowerLog and other current generation P Squared 
products. You can add and review Users as well as set the level of 
access they have to the various P Squared software systems you are 
running at the station. You can even track a Users actions to check out 
what they have been doing with your system.

Essentially, Contacts and Users are the same thing but Contacts do not have 
access to Myriad, Scoop or other P Squared products where as Users do.
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Please note that access to the functions in this section of Myriad Manager are 
heavily dependent on the User who is logged in having the appropriate level 
of access rights to view and edit Users on the system. It is likely that the 
average User will not be able to access the majority of the tools and functions 
outlined below unless you have specifically allowed them to. 

For the purposes of documentation, it is assumed that the User logged in to 
Myriad Manager has full access rights to all areas of the system.

Contacts / Users General Screen Layout

The Contact / Users tab is laid out in a similar way to the Audio tab in that the 
left hand section is used to navigate the Contacts / Users in your system and 
access the details for a specific Contact or User. The Main Work Area is used 
to display the details for Contacts / Users and edit their details and settings.
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Find Contact

The Find Contact option at the top of the Contact / Users tab allows you to 
search the P Squared Directory for a Contact name.

To use this facility, type in the name of the Contact you wish to locate and 
then click on the Find button.
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Any Contacts that match the search criteria will be displayed in the main 
Contact List (as shown in the screen shot above).

You can also use the drop down list to view and select Search Criteria you 
have recently used. To re-use the search criteria, just highlight it and then 
click on the Find button.

N.B. To list all Contacts in the P Squared Directory, select the <All Contacts> 
option.
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Contact Category List

The Contact Category List provides a method for organising your Contacts in 
to specific Categories to make browsing contacts easy and faster.

The Contact Category List is arranged in to Contact Folder with the ability to 
add sub folders to further categorise your Contacts should you wish.

In the example above, a News Contact Category has been created and by 
expanding the News Contact Folder, we can see that there has also been two 
sub-categories created (Local News and Local Sport).

When you highlight the News Contacts Category folder, the Contact List 
shows all of the Contacts in the News Contacts folder as well as all of the 
Contacts in the sub folders (Local News and Local Sport).



193

By highlighting an alternative folder, you can narrow down the list of Contacts 
in the Contact List further.
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To list all of the Contacts on the system, you would need to highlight the All 
Categories option at the top of the ‘tree’.

Adding New Categories

You can add a new Category to any part of the Category List by right clicking 
on the ‘parent’ Category and using the New > New Category option.
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In the example above, we first right clicked on the News Contact category and 
then selected the New > New Category option.

This would then create a new sub-category for the News Contacts Category. 
You can also name the sub Category as you see fit.
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Renaming An Existing Contact Category

You can also rename an existing Contact Category by right clicking on the 
Category folder and selecting the Rename option.

You can then type in the new Category Name on the folder itself.
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Type in the name you wish to use and then hit <Enter> (or click away from the 
Contact Category list).

Moving Contacts Between Categories

You can move Contacts between different Categories in two different ways.

1. Drag and drop – You can drag a contact from the Contact List up to a 
specific Contact Category and the Contact will be moved in to the 
Contact Category folder you have selected.

In the example above, by dragging the ‘Todd Stone’ Contact in to the 
Local Council Contact Category Folder, ‘Todd’s’ Contact will be moved 
in to the Local Council Category.
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2. Using The Category Drop Down On The Contact Details – You can 
also change the Category a Contact is in using the Category drop 
down list on General tab.

To open a Contact’s details, double click on the Contacts name in the 
Contact List. You can then alter any of the Contact Details including the 
Category that it is in.

Deleting Contact Categories

You can only delete a Contact Category if there are no Contacts listed within 
the Category (including in sub folders). If you attempt to delete a Contact 
Category that still contains contacts, Myriad Manager will warn you.

If a Category does not contain any Contacts then you are free to delete the 
Category using the right click menu.
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To do this, right click on the Contact Category that you wish to delete and 
select the Delete Category option. N.B. You will only be able to do this is the 
Category does not contain any Contacts as in the example above.

You will then be asked to confirm that you wish to delete the Category.
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Myriad Manager will then remove the Category from the Category List.

The Contact List

The Contact List section displays a list of all the Contacts that either exist 
within the selected Category (and sub Categories) on the Category List meet 
the Find Contact criteria (or both).
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The Contact List itself is divided in to two tabs, the Shared tab shows all 
Contacts in the database that are in the selected Category and are not 
marked as ‘Personal’ in the Contact Details.
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If a Contact has the Personal option ticked then it will only be viewable on the 
Personal tab by the User who added the Contact to the system.
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This allows Users to create their own Contacts database that is not visible to 
other Users in the system. 

Please note that you Contacts that have access to Myriad or any other P 
Squared product can not be added as Personal Contacts. You also need to 
have access rights yourself to be able to add Personal Contacts to the 
system. This allows you to control who will have use of this feature.

Opening A Contact’s Details

You can open the Details for a Contact by doing one of the following two
options.
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1. Double click on the Contact in the Contact List.
2. Right click on the Contact in the Contact List and selecting the Open 

Contact option.

Adding A New Contact

You can add a new Contact to the system in one of three ways.

1. Click on the New Contact button at the bottom of the Contact List.
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2. Right Click anywhere in the Contact List and select New Contact from 
the right click menu.
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3. Open an existing Contact’s details (by double clicking on it) and then 
click on the New Contact button on the Tool Bar.

In all cases, Myriad Manager will open a blank Contact window to allow you to 
add in the Contact details and User information (if needed). 
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But Contact Details will be covered in more detail in a short while (See 
Contact Details for more information).

Deleting Contact

To delete a Contact, right click on the Contact you wish to delete and select 
the Delete Contact option.
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You will then be asked to confirm that you wish to delete the Contact.

If you say yes then the Contact will be deleted from the P Squared Directory 
Database.

The Contact List Right Click Menu

The Contact List includes a fairly comprehensive right click menu with a range 
of options.

The options on the right click menu are outlined below.

Open Contact
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The Open Contact option is used to open the Contact Details for the Contact 
you right clicked on. You can the view the Contact Details and make any 
changes that wish to.

The Contact Details window is covered in more detail later in this Chapter.

Copy

The Copy option on the right click menu is used to open a duplicate copy of 
the Contact that you then work with.
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Print Contact

The Print Contact option will print the highlighted Contact Details using your 
computers default printer.

Please note that this feature is not implemented on some versions on Myriad 
v3.

E-Mail Contact

This allows you to e-mail the contact details to an email address.

Please note that this feature is not implemented on some versions on Myriad 
v3.



211

Export As vCard

This option allows you to export the highlighted Contacts details as a vCard 
that can then be imported in to range of third party applications such as 
Microsoft Outlook and Outlook Express.

Create Removable ‘Security Key’

Now this is an interesting option!

The idea is that you can transfer a Contacts details to a removable USB hard 
drive (some time called a USB key or USB pen drive). The data is encrypted 
on to the drive in such as way that when the drive is plugged in to a PC 
running Myriad, Myriad will attempt to use the information on the Security Key 
to log the User in to the system.

Using this method, you can issue each User on your system with a low cost 
hardware USB Security Key that they simply plug in to the PC at the 
beginning of their show to login and unplug at the end of their show to log out 
again.

That way, Users do not have to remember username or passwords in order to 
gain access to the system.

To use this feature, follow the steps below:

1. First, plug a suitable removable USB drive in to a free USB port on 
your computer or a USB hub connected to your computer.

2. Right click on the Contact name that you wish to transfer to the USB 
Security Key and select the Create Security Key option.
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Please note that the Create Removable Security Key is only enabled 
when you click on a Contact that is allowed to log in to one or more P 
Squared product.

If you attempt to create a Security Key without plugging in a suitable 
device, Myriad Manager will let you know.

3. Select the Removable Drive that you wish to use from the drop down 
list (in case you have more than one plugged in).

4. In Myriad Manager detects Contact details on the Security Key already, 
it will ask you whether you wish to replace the details. If the Security 
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Key does not already contain Contact details then it will automatically 
move on to the next step.

5. Myriad Manager will next ask you whether you wish to store the 
password along side the other details on the Security Key. If you select 
Yes then the User will be automatically logged in when the Security 
Key is inserted. If you select No then the User will be prompted to 
provide the password each time.

6. Myriad Manager will then create the Security Key information on the 
USB drive.

Your Security Key has not been created.

TIP: For a really cool installation, why not issue all of your Users with Security 
keys and then mount a USB hub up near the mixing desk. That way 
presenters can log in and out of Myriad using their Security Keys without 
crawling round on the floor looking for the USB hole!

New Contact

The New Contact option on the right click menu is used to add a new Contact 
to the system in the highlighted Contact Category folder.

If you select this option, Myriad Manager will open a blank Contact Details 
screen to allow you to edit the new Contact’s information and set their access 
to the system (if any).

Delete Contact

The Delete Contact option is used to Delete a Contact from the system.
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To delete a Contact, right click on the Contact you wish to delete and select 
the Delete Contact option.

You will then be asked to confirm that you wish to delete the Contact.

If you say yes then the Contact will be deleted from the P Squared Directory 
Database.

The Contact Details Window

The Contact Details window is used to view and edit both the contact details 
for the Contact and the Login and User access they have to Myriad.

The Contact Details window is divided in to four tabs to allow easy navigation 
of the information stored for the Contact.
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Contact Details Window General Layout

The general layout of the Contact Details window is outlined below.
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In general, each section is outlined below:

 Tool Bar – Offers a range of tool options.
 General Tab – View and edit the contact details for the Contact you 

are working on.
 Login Tab – This tab is used to set whether a Contact has the ability to 

login to Myriad and what there Username and Password should be.
 Settings Tab – This tab is only used if the Contact has the ability to 

login to Myriad and it is used to set the level of access that the user 
has to the system.

 Notes – Allows you to add additional text notes for the Contact.

All of these options are investigated in more detail below.

The Contact Details Tool Bar

The options on the Tool Bar our outlined below.
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New Contact

The New Contact button will open a new, blank Contact to allow you to add a 
new Contact to the system.

Save Contact

This option is only enabled if you have added or edited something to the 
Contact Details window.

If you attempt to close the Contact Details window without saving, you will 
asked by Myriad Manager whether you wish to save the details or discard the 
changes.

Cut (also <Ctrl>+<X>)

This button will perform a standard windows ‘cut’ on whatever is highlighted 
on the Contact Details screen. When you cut text, the text is copied to the 
‘clipboard’ and then deleted from the original location.

Copy (also <Ctrl>+<C>)

Similar to Cut but the highlighted text is copied to the ‘clip board’ but the 
original text remains in place.
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Paste (also <Ctrl>+<V>)

The Paste button will ‘paste’ whatever is in the windows ‘clipboard’ in to the 
selected field on the Contact Details page.

Contact History

The Contact History button on the Tool Bar allows you to access the Contact 
History window.

As part of the inbuilt security in Myriad, the system keeps track of a number of 
operations that users perform and compiles a log of their actions. This log of 
actions is displayed in the Contact History window and it allows you to view 
what such things as when a User deletes a Cart, when they change Active 
Playout Mode or change Station Database.

By using the options on the Contact History window you can see what 
happened on a certain day, who was logged in when a Cart was deleted or 
edited or even what Myriad workstation was used to perform a task.

For more details on Contact History, please refer to the Contract History 
window section of the documentation.
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The General Tab

The General tab is used to add in all of the generic contact information for the 
Contact you are adding to the system.

Most of the information fields on the General Tab are self explanatory but we 
will briefly run through them below.

Please note that you do not have to fill in all of these fields unless you wish to.

Contact Name

The full name of the Contact you are adding to the system.

Please note that you can add more than one Contact with the same Contact 
Name if you wish.

Company

The name of the Company that Contact works for.

Job title

The Contacts job title (if applicable).
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Phone Numbers

Myriad Manager allows you to add two standard phone numbers per Contact.

Mobile Number

Allows you to type in the Contacts mobile phone number or ‘cell’ number of 
you are American!

Fax

The Contacts fax number.

Email

This allows you to type in the Contacts email address.

You can actually add up to three email addresses per Contact. If you wish to 
add or view any of the three email addresses (as opposed to just email 
address 1) then use the drop down button to the right of the Email caption to 
select the email address you wish to work with.

You can also start an email to a Contact by clicking on the Email button to the 
right of the Email field.
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If you click on the Email button then Myriad Manager will open up a blank 
email to the Contact using your computers default email package (such as 
Outlook or Outlook Express). You can then use this to email the Contact.

Web Site

The Web Site field allows you to add an appropriate web site to the Contact 
Details. This may be the company web site or a personal web site.

You can add up to two web sites per Contact and you switch between Web 
Site 1 & 2 using the drop down button to the side of the Web Site caption.



222

You can also browse the web site by clicking on the Web Site button to the 
right of the web site field.

If you do this then the web site will be displayed directly within Myriad 
Manager.

Address

Set the Contact’s mail address in this field.

Category

This field show the Contact Category that the contact is currently in.
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As we have already seen in the Contact Category List section, you can 
change the Contact Category that a Contact is in by dragging the contact 
between the Contact Category folders, but you can also change the Contact 
Category that the Contact is in using this drop down menu option.

In the example above, if we selected the ‘News Contact’ Category then the 
Contact would be moved from the ‘General Contacts’ Category in to the 
‘News Contacts’ Category.
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Personal

The Personal tick option sets whether the Contact you are working on is 
stored in the Shared list of Contacts (can be viewed by all Users with access 
rights) or in your personal Contacts in which case you will be the only person 
who could view the details.

If you ticked the Personal option then the Contact would be listed on the 
Personal tab in the Contact List Area whenever you are logged in.

The Login Tab

The Login Tab is used to set whether the Contact you are working with is able 
to login to Myriad and also what Login Name and Password the Contact 
should use. 

A Contact that can log in to Myriad is usually referred to as a User.

Allow The Contact To Login To The Directory As A User
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This option allows you to set whether the Contact is able to login to Myriad 
and any other P Squared products that use the P Squared Directory to 
manage security (such as Scoop).

By default, this option will not be ticks to Contacts you add to the system will 
not automatically have access to Myriad.

By ticking this option, the additional login options will be enabled.
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Login Name

This is the name that the user will use to login to Myriad (and other directory 
enabled products such as Scoop).

The Login Name should be something memorable that the user will be able to 
easily recall (like there name?).

Password

The Password field allows you to set a password for the Contact you are 
working on. 

In order to ensure security, you can not see any Contacts password, but you 
can alter it should you have the access rights.

Confirm

The Confirm field allows you to confirm the password whenever you alter it.

To alter the password for a Contact, type in the new password in to the 
Password field and then re-type the password in to the Confirm field. Then 
click on the Save button to save the changes.
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Options: Account Is Disabled And Contact Cannot Log In

If you tick this option then the Contacts access to Myriad will be disabled and 
they will not be able to log in to Myriad.

Options: Allow The Contact To Change Their Own Password

Tick this option if you wish the Contact to be able to set and alter their own 
password using the Change Password option on the Tools menu in Myriad.

If this option is not ticked then the Contact will not have the option to change 
their own password and they will have to use the password you set for them.

Option: This Contact Must Change Their Password Next time They Log 
In
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If you tick this option, the next time the Contact logs in to Myriad, they will be 
prompted to change their password before they can proceed in to Myriad. 
They will not be allowed to login to Myriad until the password has been 
changed. Once the password has been changed then this option flag will be 
cleared.

Option: Automatically Log This Contact In If Already Logged In To 
Windows™

This is a fairly interesting option. Basically, if this option is ticked and the 
same Login Name has been used to login to Windows then Myriad will 
automatically start up with the Contact logged in.

Confused?

In the example above, the Contact Login Name is ‘liamb’, now, let’s say my 
login name for Windows was also ‘liamb’, When Myriad starts up, it asks the 
Windows operating system who is logged in at the moment, Windows would
say that the current user is ‘liamb’ and Myriad would realise that it has a 
‘liamb’ in it’s Directory and would automatically login using the ‘liamb’ details.

This is especially in the situation where you do not have individual Contacts 
logging in and out of Myriad but rather just have a ‘studio 1’ login etc. In this 
case, you could set up Windows to automatically login as ‘studio 1’ and 
Myriad would also automatic login use the ‘studio 1’ account details.
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Options: This Is A ‘Software Account’ Used By Some Special Directory 
Applications

Some specific P Squared software applications (such as Scoop Capture and 
Powerlog Capture) actually login to the P Squared Directory using special 
‘software accounts’ which are a lot like normal user accounts but only the 
specific software applications can use them.

The image above shows the Login details for a Contact account for a Scoop 
Capture PC.

Note how the ‘This Is A Software Account’ option is ticked in this case.

If you tried to login to Myriad using this Contact Login details, you would not 
be able to.

Under normal circumstances, there is never any need to tick this option. 
Software Accounts are generated automatically by the application when it first 
starts.

Account Information: This Account Will Expire On XXXX

This option allows you to set an automatic expiry date after which the Contact 
will no longer be able to log in to Myriad.
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To use this option, click on the calendar control, and select the date you wish 
the Contact account to expire.

Account Information: This Contact Last Logged In 

This shows the date that the Contact you are working with last logged in to 
Myriad.

The Settings Tab

The options on the Settings tab are primarily concerned with the level of 
access the Contact has to your Myriad system. Using the options on the 
Settings tab you can set dictate what functions in Myriad the Contact can 
access and even what Carts on the Audio Wall they can record, edit or delete.
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There are two different ways in which the level of access the Contact has to 
the system can be set.

The first is to use Security Groups. 

Security Groups are predefined sets of Permissions and when a Contact is in 
a Security Group, they automatically inherit the Permissions from the Security 
Group. This allows you to set up a range of different Security Groups and then 
just assign each Contact you add to the system to the appropriate group (i.e. 
have a ‘management’ Security Group and a ‘general users’ Security Group 
and assign Contacts to one or the other group accordingly).

The other option is to set the Permissions specifically for the Contact you are 
working on.

In practice, you can combine both methods to good effect by using Security 
Groups to set the base level Permissions and then customising the 
Permissions on certain Contacts if you need to.

Security Groups

The Security Groups drop down option allows you to assign a Security Group 
for the Contact to belong to.
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When you select a Security Group from this list, the Contact is added to the 
Security Group and the Permissions from the Security Group are copied to 
the Contact BUT the Contact will only use the Permission from the Security 
Group if the ‘Use The Security Permissions For This Security Group’ option is 
set.

Otherwise, the Contact will use the Security Permissions outlined in the 
customised Permissions section.

Please note that Security Groups are set using the P Squared Directory 
Settings option on the Settings menu.
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Then switch to the Security Groups tab to add or edit a Security Group.

For more details on how to do this, check out the Settings Menu section of the 
documentation.

Use The Security Permissions Set For This Security Group

As outlined above, this option set the Contact to use the default Permissions 
for the Security Group that it belongs to. If this option is not set the Contact 
will use the Customised Permissions set in the window below.
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Use The Following Security Permissions Instead (Customised 
Permissions)

If you tick this option then the Customise Permissions section of the window 
becomes enabled and the Contact will use the Permissions set in the 
Customise Permissions window.

To customise the Security Permissions for the Contact you are working on, 
click on the ‘Configure’ button, this will open the Contact’s Permissions 
window.

The Security Permissions window is used to set Security Permissions for 
Myriad but it is also used for setting permissions for other Directory enabled P 
Squared products such as Scoop and Powerlog. If you have other P Squared 
products installed on your PC then you may well have more than just Myriad 
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related options in this window but as we are mainly concerned with Myriad 
right now, we will stick with the Myriad based options.

The left hand side of the window shows a list of the P Squared products that 
are available to be configured. You will notice that as well as Myriad, the 
Audio Wall and Directory are listed separately. This is because both the Audio 
Wall and the P Squared Directory are shared by several P Squared products 
and so the settings need to be configured separately from Myriad. To select 
the application (or element) you want to configure permissions for, simple 
click on if on the left hand list. The Security Permissions options are displayed 
on the right hand side of the window.

Audio Wall > Read Cart Ranges

To view this option, make sure that the Audio Wall is selected in the left hand 
list.
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This section allows you to add one or more ranges of Cart Slot Numbers that 
the User or members of a User Group is allowed to view and play on the 
Audio Wall. 

To add in a new range, click on the ‘+’ button and then add the start and end 
Carts for the range you wish to add.

You can edit the details of a Cart Range previously added by highlighting it 

and then clicking on the Edit Range button .

To remove a Cart Range, highlight the Cart Range and click on the ‘X’ button.

Caution: You will not be asked to confirm so be careful!

N.B. This feature is only implemented in Myriad v3.1 or higher.

Audio Wall > Write Cart Ranges

This section allows you to add one or more ranges of Cart Slot Numbers that 
the User or members of a User Group is allowed to record in to, edit or delete.
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To add in a new range, click on the ‘+’ button and then add the start and end 
Carts for the range you wish to add.

You can edit the details of a Cart Range previously added by highlighting it 

and then clicking on the Edit Range button .

To remove a Cart Range, highlight the Cart Range and click on the ‘X’ button.

Caution: You will not be asked to confirm so be careful!

Audio Wall > Can Add / Edit / Delete Shared Instant Cart Sets

If this option is ticked, the User or members of a User Group are allowed to 
add, edit or delete shared Instant Cart Sets from the Instant Carts Screen.

Directory > Can Have Personal Contacts

The User or members of a User Group are allowed to have personal Instant 
Carts on the Instant Carts Screen in Myriad.
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Directory > Can Add / Edit / Delete Contacts

The User or members of a User Group are allowed to add, edit or delete 
contacts in the P Squared Directory.

Directory > Can Add / Edit / Delete Users

The User or members of a User Group are allowed to add, edit or delete 
Users in the P Squared Directory.

Directory > Can Add / Edit / Delete Contact Categories

The User or members of a User Group are allowed to add, edit or delete 
Contact Categories in the P Squared Directory.

Directory > Can Have Personal Websites

The User or members of a User Group are allowed to add personal websites 
to the website lists in Myriad Manager.

Directory > Can Add / Delete Websites

The User or members of a User Group are allowed to add or delete websites 
from the shared websites section of Myriad Manager.

Directory > Can Add / Edit / Delete Websites

The User or members of a User Group are allowed to add, edit or delete 
websites categories from the shared websites section of Myriad Manager.

Directory > Can Edit P Squared Directory Settings

The User or members of a User Group are allowed to edit settings in the 
Directory Settings window.

Directory > Can View P Squared Directory History

The User or members of a User Group are allowed to view P Squared 
Directory History which is a history of Users movements and actions in 
Myriad.
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Myriad v3 > Can Edit The Main Myriad Settings

This option allows a User or member of the User Security Group to access the 
Myriad Settings option on the Settings menu.

Myriad v3 > Can Edit The Information Views

This option allows a User or member of the User Security Group to edit the 
options that appear in the View Menu. These are edited using the View Menu 
tab on the Myriad Settings window.

Myriad v3 > Can Edit The Station Database Settings

This option allows a User or member of the User Security Group to access the 
Station Database Settings option on the Settings menu.

Myriad v3 > Can Choose Between Different Station Databases

This option allows a User or member of the User Security Group to switch 
between Station Databases using the options on the File menu in Myriad.

Myriad v3 > Can Edit The Schedule Log

This option allows a User or member of the User Security Group to edit the 
Schedule Log on the Log Screen in Myriad. If this option is not ticked then the 
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User can not add or remove Log Items or move Log Items around within the 
Schedule Log.

Myriad v3 > Can Remotely Edit The Schedule Log

This option allows a User or member of the User Security Group to remotely 
edit the Schedule Log and record Remote Voice Tracks using the P Squared 
Remote Voice Tracking system.

Please note that not all Myriad systems include the capabilities for this option.

Myriad v3 > Can Import / Export Sections Of The Schedule Log

This option allows a User or member of the User Security Group to import or 
export sections from the Schedule Log on the Log Screen in Myriad.

Please note that not all Myriad systems include the capabilities for this option. 
The Schedule Log Import / Export utility is part of the Advanced Tools Pack.

Myriad v3 > Can Edit The ‘On-Air’ Hour From A Different Database

This option allows a User or member of the User Security Group to override 
the Myriad Setting that prevents a non ‘on-air’ workstation from editing the 
currently playing hour in the Schedule Log. It is recommended that this option 
is used for Programme Controllers that want to retain the ability to edit the ‘on-
air’ Schedule Log from any Myriad workstation.

Reset All Of This Contacts Preferences To The Default

Clicking this button will reset the Customised Permission back to the default 
Permissions for the Security Group that the Contact belongs to.

The Notes Tab

The Notes tab allows you to add any additional text notes to the Contact’s 
details.
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You can use the Notes tab for anything that you wish.

You may also notice that at the bottom of the Notes tab is the date that the 
Contact was added to the system.

Directory / Contact History Window

The Directory or Contact History window was mentioned earlier when we 
were looking at the Tool Bar on the Contact Details page but we will now look 
at this in a little more detail.
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Essentially, Myriad v3 keeps track of what Contacts are doing with your 
system, where they are doing it and where they were successful in their 
operation. This ‘log’ of activity is maintained by the system to allow you to look 
back and see what people have been doing. This is really useful if you want to 
see who deleted a Cart or to check out what your ‘late night jock’ has been up 
to.

The Directory History window is split in to two regions.

The upper section allows you to search the Directory History using a number 
of criteria. In general, the options in the upper section allow you to restrict the 
detail listed in the lower section.
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The lower section shows a list of logged activity that matches the criteria set 
in the upper section.

The results are arranged in to a grid with the columns representing each of 
the information types that Myriad is logging.

You can also use the Print and Save buttons to either print the Directory 
History or save it as a ‘CSV’ file to be imported in to a third party application 
such as Microsoft Excel.

We will now look at the options on the Directory History window in a little more 
detail.

Application

As stated previously, the P Squared Directory covers a much wider spectrum 
of P Squared products than just Myriad so if your station is also using Scoop 
v3, Powerlog v4 or other ‘directory enabled’ applications then actions 
performed in these applications will also appear on the Directory History. 
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The Application drop down list allows you to select whether you wish to 
include Directory History for ‘All Applications’ or just for a specific application. 

Please note that Myriad v3 and Audio Wall are listed separately as the Audio 
Wall is used by more applications than just Myriad.

From

You can restrict the Directory History displayed to just show activity between 
certain dates.

The ‘From’ field allows you to set the start date that you wish to use. To set 
the From date, click on the drop down calendar to select the date.

To

You can also use the ‘To’ option to select end date that you wish to use.
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Event 

The Event drop down list allows you to select the type of Event to include in 
the Directory History.

The options are:

 All Events – List all Events regardless of whether they are initiated by 
a Contact or by the system.

 Normal Events – These are everyday ‘normal’ Events that are initiated 
by a Contact and include almost everything that a User can do to the 
system.

 System Events – These are special Events that are not performed by 
a Contact but rather initiated by Myriad (or other applications) itself. 
These may include things like automatic database compacting and 
backing up.

Action
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The Action drop down option is only enabled when you have selected a 
specific Application using the Application drop down list. This is because each 
separate Application has it’s own specific Actions list.

In the example above, Myriad v3 has been selected from the Application list 
and the Action list has been populated with the Myriad related actions.

Let’s say for example that you wish to see all the Carts that have been 
Deleted from the Audio Wall. We would need to select the Audio Wall from the 
Applications list and the select Delete Audio from the Actions list and click on 
Search to list all the Carts deleted between the selected dates.

The list of Actions available for each Application is extensive and changes 
regularly as we add more Directory Logging to our applications so we will not 
go through the list of available options, but they should be fairly self 
explanatory.

Login

The Login drop down list allows you to switch between ‘All Login Names’ and 
just the Directory History for a specific Contact.
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Let’s say you wanted to see what ‘Luke Skywalker’ had been doing with the 
system then you could select his Login Name from the drop down list.

You can of course combine this with the other criteria we have already looked 
at so be combining this with the example above (in the Action section), it 
would be simple to see what Carts ‘Luke Skywalker’ had deleted from the 
system in the past X days!

Computer 

The Computer field allows you to type in the Computer Network Name for the 
Computer you are interested in viewing the Directory History for. Just type in 
the network name of the computer you are interested in (like studio1) and 
then hit Search.

The Search Button

The Search button is used to initiate or refresh the results listed in the 
Directory History window.

Directory History Results

The Directory History Results section shows a list of all the entries in the 
Directory History that match the criteria you have set.
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Print

The Print button will print the Directory History list using your computers 
default printer.

Save

The Save button will export the Directory History as a special text file called a 
CSV file where all the information is separated by commas. This type of file 
allows you to import the data in to a range of 3rd party application such as MS 
Excel.
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When you select this option, you will be asked to select the location that you 
wish to save the CSV file to. Type in the name, select the location and it Save.

Chapter 4 – The Web Tab

The Web tab allows you to build a list of your favourite web sites that can then 
be accessed and viewed using Myriad Manager. This list of web sites is 
shared between other Directory Enabled P Squared products so will also be 
available in Scoop v3, Nexus and other products in the future.

The Web Tab General Layout
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These features are explained in more detail below.

Find Criteria

As with all the other tabs we have looked at, you can search the list of web 
sites on the Web tab for a web site that has a word or phrase in the title or 
address.

To use this facility, type in the word or phrase that you are looking for in the
Find field and click on the Start Search button or press the <Enter> key.

You can use the drop down list to view and select Find Criteria you have used 
recently.

Once the search is completed, the results are displayed in the Web Site 
Details section of the tab.

Start Search

Used in conjunction with the Find Criteria, the Start Search button initiates the 
search of the listed web sites looking for one or more that match the criteria.

Web Site Categories

Just as with the Contacts we looked at earlier, Myriad Manager allows you to 
organise the web sites that you have listed in to categories to make viewing 
and managing them simpler.

The Categories are organised in to a ‘tree’ structure, with navigation working 
by way of clicking on folders to expand the list of web sites in that Category.

You can drag Web sites from the Web Site Details (lower) section in to the 
Category Folders to move Web sites from one Category to another. 

You can add and manage Web Site Categories using the right click menu.
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The right click options are:

 Open Category – Opens the selected Category.
 New – Allows you to add a new Contact or a new Category.
 Delete Category – Deletes the highlighted Category.
 Rename – Renames the highlighted Category.

Web Site Details

This section lists all of the Web Sites that are in the selected Category or 
meet the Find Criteria (or both). You can open a Web Site by double clicking 
on it. You can also move a Web Site in to a different Category by dragging it 
from the Details section in to the desired Web Category Folder in the upper 
‘tree view’ section.

There is also a right click menu in the Web Site Details section to allow you to 
add, edit and manage your Web Sites.
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When you add a new Web Site to the system, you are asked for some simple 
information about the site. Fill in this information and the site will be added.

Shared / Personal Web Sites

When you add a new Web Site to the system, you set whether or not the Web 
Site is to be added as a Personal Web Site. If you add a Site as a Personal 
site, it will only be available to you. Other Users will not be able to see it listed. 
If not then the Web Site will be visible to all Users on all workstations.
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You can use the Personal / Shared tab to switch between viewing the Shared 
Web Sites and your Personal Web Sites.

New Browser

Clicking the New Browser button will open the Scoop Web Browser which will 
allow you to ‘surf’ the web.

The Web Browser

The Web Browser in Myriad Manager is designed to display simple web sites 
and to allow you to ‘surf the web’ from within the application.

The Web Browser consists of a tool bar at the top of the screen and the main 
section of the window which displays the content of the web page you are 
looking at.
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The Web Browser Tool Bar

The Tool Bar options are outlined below.

Save Site

The Save Site button is used to add the web page you are viewing to the Web 
Site list in Myriad Manager.
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When you click on this button, the New Website window opens with the 
address and title of the page you are viewing already populated. All you have 
to do is select Web Category you want it in and click on Ok.

Print

Prints the currently viewed web page using your default printer.

Forward / Back

Allows you to move forward and backward between web pages you have 
viewed in this session.

Web Address

Type in the web address (or URL) for the web page you wish to view.

History

The History drop down option shows a list of web pages visited recently.
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To re-visit a site, select it from the list and then click on the Go button.

Go

The Go button is used to go to the address that you have typed in to the 
Address field.

Stop

The Stop button is only enabled whilst Myriad Manager is downloading a web 
page. It is used to stop downloading the current web page.

Chapter 5 – The Menu System

In this Chapter we will look at the Menu system in Myriad Manager and how it 
is used to configure and customise Myriad and Myriad Manager as well as the 
tools that it offers in every day use. 

When we talk of the menu system we mean the series of menus and sub-
menus that is accessible from the top left of the left hand screen in Myriad 
Manager.

The menu system offers a range of diverse options ranging from providing 
access to information to totally re-configuring Myriad. Because of this, this 
Chapter will be fairly eclectic in content. Not all options covered in this section 
will be applicable to all station or user so just take from this Chapter, what 
ever you need.

Please notes that many of the file options are also only available if the logged 
in User has enough access rights within the P Squared Directory. For the 
purposes of this documentation, it is assumed that the User has full access 
rights to all sections of the menu system but general Users may well find that 
some of the options are not available to them.

The File Menu
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The File menu can be see in extended form below.

Logged In As XXXX

The Logged In As XXXX section of the File menu is really more for 
information purposes as the option can not be selected. As you can see from 
the screen shot above, the Logged In As section of the menu shows the Login 
Name of the User currently logged in to Myriad. In the example above, the 
User logged in is called ‘PSQUARED’.

Logout

The Logout option is used to log the current User out of the system. When 
you select this option, you are immediately logged out of Myriad Manager and 
the new User Login box is put on screen to allow the next User to log in. 

To log in to Myriad Manager type in a valid Login Name and password and 
then click on Ok. The Login Name and Password will be checked against the 
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P Squared Directory and assuming the Login Name and Password match, the 
new User will be logged in to Myriad Manager.

You can opt to change your password directly after logging in by ticking the 
‘After Login, I Want To Change My Password’ option.

But don’t worry if you forget, you can also change you password using the 
Change Password option on the Tools menu.

If you accidentally click on the Cancel button, it may get a little worried for a 
second.
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What you will see in this case is a blank blue screen with the Cart Players 
along the bottom of the screen and nothing else. Don’t panic, click on the File 
menu and select the Login option to re-open the Login box.

Printer Setup

The Print Setup option allows you to configure the printer that Myriad 
Manager will use to print reports etc.



261

When you select this option, you will see the standard Windows Print Setup 
screen that allows you to set the printer to use and to change the options for 
the selected printer.

Exit

The Exit option is used to close Myriad Manager altogether and return to the 
Windows Desktop.

When you select the Exit option, you get a window that allows you to confirm 
that you wanted to exit from Myriad Manager and not just log out.

If you wanted to exit from Myriad Manager , click on the ‘Quit From Myriad’ 
option and then click on Ok.

If Myriad detects that it is still playing a Cart, it will offer an additional warning 
to let you know that quitting now will also end playback of the Cart.
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Click on Yes to quit anyway or click on No to return to Myriad Manager.

The Log Menu

The Log Menu in Myriad Manager currently only has one option which allows 
you to remove all entries from a selected Station Database.

Remove All The Items From The Schedule Log

If you select this option, you will then be asked to select the Station Database 
that you want to remove all entries from.

If you have configured Myriad to automatically use a particular Station 
Database or you only have one Station Database then this selection stage will 
be skipped.
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Next you will be asked to confirm that you wish to remove all Log Entries from 
the Station Database. Remember that this will include all adverts and Voice 
Tracks you may have added to the Schedule Log.

If you wish to proceed, click on the Yes button.

You will be asked to confirm again. If you select Yes then Myriad Manager will 
remove all of the Log Entries from the selected Station Database.

The View Menu

The View menu is fairly unique in Myriad Manager in that it is the only menu 
that can be customised to your stations needs. In general, the View menu is 
used to access additional text information and also to access the Pad in 
Myriad Manager.

The interesting thing about the View menu is that you can add a number of 
local and web based HTML pages to the menu along with a bunch of HTML 
scripts. This allows you to customise the View menu to offer Users access to 
key information pages and web sites. In the screen shot below, the 
customised elements are indicated with the red boxes.
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The View menu in Myriad Manager is shared with the View menu in Myriad so 
the options will be exactly the same. The following section is taken from the 
Myriad User Guide but if you have already read the View Menu section in the 
main manual then you can probably skip on to the next section.

Audio Browser

The Audio Browser option on the View menu opens a ‘floating’ Audio Browser 
which allows you to browse the Audio Wall. The Audio Browser is used 
extensively throughout Myriad and other Audio Wall compatible P Squared 
applications and is covered in detail in Chapter 7 of the main Myriad User 
Guide.
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Customisable Information Menu Options (Contact Details, Station Info 
etc)

In the example above, you will see a range of information base menu options 
including Contact Details, Station Information, What’s On Guide and P 
Squared Web Site. Clicking on these options will open a special web page 
viewing and allow you to view the content of the pages the menu options are 
linked to.
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Nothing too unusual here except for these menu options are not ‘hard coded’ 
in to Myriad but rather can be configured to be different on each Myriad 
workstation at your station. 

Let’s take a look at the Settings menu > Myriad Settings > View Menu tab for 
the workstation we are working on.
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Here we can see that the options on the View menu have actually been 
configured in this window. Each option on the View menu corresponds to an 
entry in this table with the Name column being used for the Name on the view 
menu and the Location column being used for the location of a local or web 
based HTML page that the View menu option will open when selected. You 
may also note that the Separator Line entry between the ’What’s On Guide’ 
and the ‘P Squared Website’ causes the line between the options on the View 
menu.

Let’s say for example that we want to add another option on the View menu 
that links to a ‘weather’ HTML page stored on the local computer and we also 
want to add a separator line between the P Squared Web Site option and the 
new Weather option.

First click on the Add Option button and tick the Separator Line option to add 
the separator line to the list.
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Next click on the Add Option button again and this time type in the Name and 
Location of the Weather option we wish to add.

Note that is the HTML file you are linking to is a local or network file then you 
can click on the Select button to browse your local drives and network 
connections. Click on OK once you are done.

Our View Menu settings window now looks like this with the new Weather 
option added to the bottom of the list.
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Click on OK to save the changes. We can now see the end results on the 
View menu.
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And if we click on the Local Weather menu option, voila!

You can actually edit text in the file from this window by clicking on the Edit 
button.

You can then type and edit the text in the main window, when you are done, 
click on the Save button to save you changes.
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Fore more details on the View Menu tab on the Settings > Myriad Settings 
window, please refer to the Settings Menu section of the documentation.

Live Read Scripts

The Live Read Scripts option on the View Menu is another part of the menu 
that can be changed to suit your stations needs. The difference is that unlike 
the previous section where we looked at adding more options to the View 
menu, the Live Read Scripts section of the menu is a lot more dynamic in that 
it basically offers access to all of the HTML files in the special Scripts folder 
within your main Myriad System folder. 
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In the example above, the Live Read Scripts menu contains two options, 
Cinema Listings and Todays Weather. Now if we look at the main Myriad 
System file location (the folder location where Myriad stores all the Myriad 
files and databases) and the Scripts sub folder.
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Any HTML pages copied in to this folder will automatically be added to the 
Live Read Scripts section of the View menu with the filename being the option 
name on the menu.

This means that support staff at a station can write HTML scripts in any word 
processor, copy them to this folder and they will instantly be available to the 
presenter in the studio (and all other workstations). 

If you click on a Live Read Script option, the script is loaded in to the special 
script viewer window.

As with the Customisable View Options, you can edit the text in the script by 
clicking on the Edit button and save your changes by clicking on the Save 
button.

Display Pad 

The Display Pad option on the View menu is used to open a floating Pad that 
can be used in the same way that the main Pad in Myriad is used.
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You can combine this with the Audio Browser option on the View menu to 
allow you to drag Carts from the Audio Wall in to the Pad in Myriad Manager.

You can use the Pad to play back a list of Carts in Myriad Manager, to export 
all of the Carts to a single Cart on the Audio Wall or to save a list a Carts that 
can be loaded in to the Pad in Myriad.

For more details on the Pad, please refer to Chapter 2 in the Myriad User 
Guide.

The Tools Menu

The Tools menu is offers a range of tools that are oriented around the User 
logged in to Myriad Manager at the time. The principle option on the Tools 
menu is the Customise option which allows users to customise certain 
aspects of the Myriad experience to their personal preferences.
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It is important to make the distinction between Customising Myriad and Myriad 
Settings. Customisation options are only applicable to the User logged in at 
the time. When they log out, the Customise settings will be saved and 
automatically reloaded the next time they log in.

As with the View and Settings menus, the Tools menu in Myriad Manager is 
shared with the Tools menu in Myriad and the options set in here will apply to 
Myriad. Although we are accessing the menu option from Myriad Manager, 
many of the settings refer specifically to customising the Myriad interface and 
preferences.

As before, the section below is taken from the main Myriad documentation so 
if you have already read the main Myriad User Guide or are familiar with the 
Tools Menu option then you can probably skip this section.

Customise Myriad

The Customise Myriad window is split in to two main tabs (vertically along the 
right hand side). The Myriad tab is used to display Myriad Interface 
Customisation options that refer to the way Myriad looks. The Audio tab refers 
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to a range of options that refer to the way Myriad deals with Audio and Carts 
on the Audio Wall. Each of these major tabs are then divided in to sub tabs 
within the main section of the window.

The Reset All button is used to reset all Customisation options back to the 
default settings. The Ok button is used to save the changes and close the 
window and the Cancel button is used to close the window without saving the 
changes.

Myriad Tab > General Tab

This tab allows you to customise General Myriad interface options.

Display Todays Date On The Clock Strip

You can use this customisation option to toggle whether the date is displayed 
below the time on the general Myriad interface.

Myriad Tab > Log Display Tab

This tab allows you to customise the Log Screen interface options.
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Switch Back To Following The Log XX Seconds Of Inactivity

When you are working with the Schedule Log on the Log Screen, the Log 
Screen display will normally automatically update to follow the currently 
playing Log Item as each item in the Log is played. This means that when it is 
in an Active Playout mode, Myriad makes sure that the currently playing Log 
Item is always visible.

Now if you move to a different part of the Log to review the Schedule Log for 
later in the day or to edit tomorrows show, the last thing you want Myriad to do 
is keep jumping back to the currently playing Log Item each time it performs a 
segue. This option allows you to set a time (in second) after which, if you have 
not moved around in the Schedule Log or edited it in any way, it will jump 
back to display the currently playing Log Item.

Let’s say for example that you are presenting a show and you want to look at 
tomorrows Schedule to make some changes and record some Voice Track. 
You use the Goto button to jump to tomorrow in the Schedule Log and start 
editing the Schedule Log. While you are working with the Log, Myriad is 
happy to leave the display showing tomorrows schedule but once you have 
finished, if you go off to make a cup of tea, Myriad will automatically jump 
back to the Currently Playing Log Item (just like pressing the Home button) 
after XX seconds of inactivity.



279

The default for this setting is 60 seconds but you can customise it to your 
individual needs.

Display The Information Panel

This customisation option allows you to decide whether you wish the Notes / 
Information panel to be displayed on the Log Screen.

When this option is un-ticked, the Notes / Information Panel is hidden on the 
Log Screen and the Mini Mode Segue Editor stretches to fill the entire screen.

Audio Tab > Navigation Tab

The Navigation tab allows you to customise elements of Myriad that refer 
moving round and searching the Audio Wall.
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Initially Display The Last Viewed Cart

If you tick this option, each time you log in to Myriad, the Audio Wall will 
automatically jump to the last Cart on the Audio Wall that you had highlighted.

Initially Display A Specific Cart

This customisation option allows you to specify a particular Cart to be 
highlighted each time you log in to Myriad regardless of the last Cart you were 
looking at.

To use this option, tick the box and then type in the Cart Slot Number that you 
wish to use each time you Login to Myriad.

When Searching Carts Search The Notes / Copyright Details
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This customisation option allows you to customise the Find Cart default 
options that will be ticked each time you open the Find Cart window on the 
Audio Wall.

If you tick the Search The Notes option then when you open the Find Cart 
window for the first time in a single Login session, the Search Notes option on 
the Find Cart window will be ticked. The Same goes for the Search Copyright 
Details option.

Please note that just because you set them here, you can still turn them on 
and off as you need to in Myriad, this just sets the initial state when you first 
log in to the system.

Cart Range Display: Personal Range

The Personal Range allows you to set a range of Carts to be your own 
personal area. This range is used for two very important uses. Firstly, when 
you click on the Home button on the Audio Wall Main Tab Strip, Myriad will 
jump to the first Cart in your Personal Range.
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The second and more important use for this Personal Range is that when you 
click on the Quick Record button on the Record Cart Player, Myriad will 
automatically assign the next free Cart in your Personal Range to be recorded 
in to.
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If there are no free Carts in your Personal Range then Myriad will let you 
know.

Please note even if your Personal Range is set to be a specific range of 
Carts, you still need to have Edit Cart Rights for that range in order to allow 
you to record or edit the Carts. This is set in the User Security Settings 
section of the Contact / Directory in Myriad Manager.

Allow Carts To Be Moved By Drag ‘n’ Drop

This option can be ticked to allow you to use ‘drag n drop’ on the Audio Wall 
to move Carts from one Cart Slot to another.

Please note that this option is useful if you are doing a lot of moving around 
on the Audio Wall but is not recommended for general day to day use as it 
makes it very easy to move a Cart by mistake.

Audio Tab > Cart Display

The Cart Display tab allows you to customise the size of the Carts on the 
Audio Wall and the size of the fonts used on the Carts. This is a very useful 
option as it allows users who have trouble reading the Audio Wall screen to 
make everything bigger. And as this is a customise option, the changes made 
will only apply to the User currently logged in.
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Minimum Width / Height In Pixels

In this section you can set the minimum Cart size for the Audio Wall. This is 
the smallest that the Carts will appear on screen but they may well appear 
bigger as Myriad will fit the maximum amount on screen that it can (allowing 
for your minimum size) and any space left over will be shared between the 
visible Carts

To alter the minimum width and height, type in the size in pixels, in the Width 
and Height.
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Unfortunately, the only way to test you new size is to click on the OK button 
and see how the Audio Wall looks!

Font For The Audio Wall

This customise option allows you to set the font and font size for eh 
description lines displayed on the Carts on the Audio Wall. To alter the font or 
font size, click on the Font button and select the font and font size you wish to 
use.



286

Once you are happy with the new font, click on the OK button. A preview of 
the font and font size is displayed on the sample Cart in the centre of the 
window.

Font For The Others

This setting is used to set the font and font size used for Carts in the Audio 
Browser when it is in single line Cart Display mode. 
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To alter the font or font size, click on the Font button and select the font from 
the font selection window.
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Audio Tab > Playback / Recording Tab

The Playback / Recording tab is used to customise the way that Myriad deals 
with certain aspects of playback and recording. You can customise the way 
Myriad acts when Carts are ejected from Cart Players, the level at which 
Myriad will ‘trigger’ recording when using the Record Cart Player and also 
whether Myriad will automatically display the wave form when viewing the 
SmoothEdit Screen.

When Ejecting A Cart

This section of the Playback / Recording tab allows you to customise the way 
that Myriad acts when you either click on the Eject button on a Cart Player or 
use the keyboard shortcut key for ejecting a Cart on a Cart Player. Basically 
there are two possible scenarios.

 The Cart Is Faded – When the Eject button is clicked on or the Eject 
key is pressed, Myriad will slowly fade the Cart out over X seconds.

 The Cart Is Immediately Ejected – The Cart is immediately ended 
and ejected from the Cart Player.
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The When Ejecting customise options allow you to set Myriad to Fade Carts 
when either the mouse is used, or the keyboard is used (or both) and to also 
customise the duration over which Myriad performs the fade.

In the above example, the ‘Fade the cart when using the mouse’ option is 
ticked and it is set to take 2 seconds to fade out. The ‘Fade the Cart when 
using the keyboard’ option is not ticked so when you press the Eject button on 
the keyboard, the Cart will stop and be ejected immediately.

So if you ticked both options the Myriad would fade out the Cart regardless of 
whether you use the keyboard or mouse to eject the Cart and by adjusting the 
‘Take X sec to fade out’ option you can adjust the duration taken to fade out 
the Cart.

If none of the options are ticked then Myriad will immediately stop and eject 
the Cart regardless of whether the mouse or keyboard is used.

The ‘Only allow Carts to be Ejected from the players when paused or cued’ 
customise option allows you to set Myriad to only allow you to Eject a Cart 
from a Cart Player when the Cart Player is either cued ready to play or 
paused, i.e. do not let a Cart be Ejected whilst it is playing. This option allows 
you to customise Myriad to act like many pro CD players.

If this option is not ticked then Myriad will allow Carts to be Ejected at any 
time.

When Recording New Audio

This set of customise options allows you to alter the way in which Myriad acts 
when you are using the Record Cart Player to record audio in to a Cart Slot.
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Using the drop down option, you can select whether Myriad should use 
‘trigger level’ recording (only start recording when the incoming audio volume 
exceeds the Trigger Threshold) to start recording in to the Cart.

The options on the drop down list are:

 Never Use – If this option is selected, Myriad will never use ‘trigger 
level’ recording and start recording as soon as you click on the record 
button on the Record Cart Player.

 Ask First – The Ask First option will offer the user the opportunity to 
decide whether to use trigger recording or not.

This is done via the dialogue box. Click Yes to use trigger level 
recording, click No to not use trigger recording (start recording
immediately) or Cancel to abandon recording.

 Always Use – If this option is selected then Myriad will always use 
trigger level recording.

The ‘Trigger Threshold’ setting allows you to customise the incoming audio 
level at which Myriad will start recording when using trigger levels. The 
Trigger Threshold is set as a percentage with 0% being silence and 100% 
being the maximum input level of the sound card being used. The higher the 
trigger threshold, the more likely that Myriad will ‘clip’ the beginning of your 
recording. Ideally, you need to set the level to be above any background noise 
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but as low as possible. Unfortunately, the trigger threshold will need to be set 
individually depending on your sound card and external audio equipment. The 
default setting is 10%.

SmoothEdit Options

The SmoothEdit section of the Audio Tab allows you to customise the way 
Myriad will display wave forms on the SmoothEdit Screen and indeed whether 
the wave form should be displayed automatically when you switch to Edit 
Cart.

The ‘Open the audio file for editing immediately’ customise option is used to 
set whether Myriad will automatically open and display the wave form for a 
Cart when you click on the Edit button on the Main Tab Strip.

If you un-tick this option then when you click on the Edit button, the 
SmoothEdit Screen will display the Cart details but will not show the actual 
wave form. This is useful if you need to alter the title or timing info but do not 
need to alter the actual audio. In this mode, you can still load the wave form 
by clicking on the ‘open the file for audio editing’ option on the SmoothEdit 
Screen.
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Regardless of how this customise option is set, you can access the 
SmoothEdit Screen inn both modes using the right click menu on the Audio 
Wall.
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You can also use the ‘Use improved display scales’ option to customise the 
way in which the SmoothEdit Screen displays the wave form in respect to the 
scale used down the right hand side of the Wave Form Edit area to show the 
relative size of the wave form. There are basically two ways Myriad will 
display this information.

 Display Scale In Samples – This shows the value of each ‘peak’ in 
the wave form in terms of the actual data per sample. This is 
technically accurate but has very little ‘real world’ value. 

If the ‘Use improved display scale’ option is not ticked then the 
SmoothEdit Screen will display the scale in this way.

N.B. The time scale along the bottom is also displayed in samples in 
this mode.

 Display Scale In Percentage – The scale on the right hand side of the 
Waver Form Edit Area is displayed as a percentage ranging from 0% 
(silence) to 100% (full range).
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When the ‘Use improved display scale’ option is ticked, the vertical 
scale is displayed as a percentage and the horizontal scale is 
displayed in seconds.

This option is usually preferable as it is far more understandable in ‘real 
world’ terms.

Change Password

The Change Password option on the Tools menu allows you to change the 
password for the User / Contact currently logged in to Myriad and Myriad 
Manager.
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To change the password, you will first need to type in your current password 
and then the new password that you wish to change to. Next confirm the new 
password by re-typing it and then click on the Ok button to complete the 
change.

Quick Record In To The First Available ‘Personal’ Cart

The Quick Record option on the Tools menu provides a fast way of starting to 
record in to the first free Cart in your personal range (see Audio Tab > 
Navigation Tab > Cart Range Display). When you select this option, Myriad 
Manager will automatically find the first empty Cart in the ‘personal’ Cart 
Range you have set and start recording in to that Cart using the Record Cart 
Player.

If you have customised Myriad to use ‘trigger level’ recording (see Audio Tab 
> Playback / Record > When Recording New Audio) then Myriad will assign 
the Cart in the Record Cart Player and will then wait for the incoming audio 
level to raise above the ‘trigger threshold’ before starting to record.
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If you have customised Myriad to ask you each time, you will be asked 
whether you wish to use ‘trigger level’ before proceeding.

If you have customised Myriad to never use ‘trigger level’ then when you 
select the ‘Quick Record’ option on the Tools menu, Myriad will automatically 
start recording in to the next empty Cart in your ‘personal’ range.

Stop Recording

The Stop Recording option on the Tools menu is only enabled when the 
Record Cart Player is recording in Myriad. You can use this option to stop 
recording and select whether to save the recorded Cart or to discard the 
recording and start again.
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N.B. This option can be used whenever the Record Cart Player is active, 
regardless of how you initiated the recording.

Directory History Log

The Directory History Log option on the Tools menu is used to access the 
Directory History window.

The Directory History window displays a special ‘log’ of events and actions 
that Contacts have performed on your Myriad system.
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Basically, Myriad keeps track of a large number of events and keeps of log of 
when they happened, where they happened and who was logged in at the 
time. The Directory History window gives you access to this information and 
allows you to perform searches by a range of criteria.

For details on how to use the Directory History window, please refer to the 
Directory History Window section in Chapter 3.

The Settings Menu

The Settings Menu offers access to all of the various configuration options 
and settings available in Myriad and is the principle method for viewing and 
altering the way Myriad works.

The Settings menu offers an extensive range of configuration options and 
settings so to help you navigate around them and find the options you are 
after, the settings are divided in to several different menu options each 
covering a different aspect of Myriad.
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As with the View and Tools menu, the Settings menu is shared with Myriad 
and although you are accessing them through Myriad Manager, most of the 
settings refer to and affect the main Myriad system. That said, not all of the 
options available on the Settings menu in Myriad are available in Myriad 
Manager.

As before, the following section is taken from the main Myriad User Guide so 
if you have already read the Settings menu section or are familiar with the 
Settings in Myriad then you can probably skip over the next section.

The Settings Menu Overview

Broadly speaking, the menu options offer access to the following settings in 
Myriad.

 Audio Settings – The Audio Settings opens the Audio Settings 
window which allows you to configure Cart Player assignments, play 
back and sweeping options, recording and editing settings as well as a 
range of additional advanced audio related options. The Audio Settings 
window is divided in to four tabs:

o Cart Players – The Cart Players tab allows you to configure 
how many Cart Players are visible in Myriad and which 
soundcard outputs to use for each Cart Player. You can also 
use this tab to tell Myriad which Cart Players to use for special 
items such as Instant Carts and AutoHooks etc.

o Playback Settings – The Playback Settings tab allows you to 
alter the way in which Myriad deals with sweepers and Voice 
Tracks as well as the order in which the Cart Players are used. 
You can also set whether to allow Users to customise the way in 
which Myriad ejects Carts or whether to use a global method.

o Record / Edit Settings – This tab allows you to set the audio 
quality and format that Myriad will use when record, ripping or 
importing audio in to the system. You can also optionally give 
the User the ability to alter this on a ‘per recording’ basis. You 
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can also configure an external audio editor (such as Adobe 
Audition™) for Myriad to use.

o Advanced  - The Advanced tab provides some miscellaneous 
advanced audio related options that should only really be altered 
at the direction of a P Squared engineer. This tab also allows 
you to switch Myriad to ‘debug’ mode where the system writes a 
varying degrees of information to a text file while it is running. 
This can be useful for P Squared engineers tracing a fault. 
Debug mode should be left ‘off’ by default as it slows Myriad 
down and creates a large amount of unnecessary data when the 
system is operating normally.

All of the settings on the Audio Settings window are ‘local box’ settings 
which only affect the local Myriad workstation that you are working on. 

 Audio Wall File Locations – The Audio Wall File Locations menu 
option allows access to the Audio Wall File Locations window which 
allows you to browse and select the data location for the audio and 
data files that comprise your Myriad Audio Wall. These are usually all 
stored in a single location but Myriad can be configured to store each 
‘chuck’ of a thousand Carts in a different location (up to 9999 beyond 
which they are all stored in a single folder). The Audio Wall File 
Locations are ‘local box’ settings and only apply to the Myriad 
workstation you are working on.

The Audio Wall File Location option also offers access to the Global 
Audio Wall Settings window which allows you to alter a range of ‘global’ 
(affects all Myriad workstations on your network Audio Wall related 
settings. The Global Audio Wall Settings window is divided in to three 
tabs:

o General – This tab allows you to set the number of Cart on your 
Audio Wall (up to 99,999) and the picture format that Myriad will 
use for pictures associated with Carts.

o Import Audio – This tab allows you to set up Myriad to acquire 
Title and Artist information from an ‘online’ database such as 
FreeDB when ripping in audio from CDs. It also allows you to set 
the default Normalise level for all audio imported in to Myriad.

o Advanced – The Advanced tab offers some advanced Global 
Audio Wall settings that should not normally be altered unless 
directed to by a P Squared support engineer.

The Audio Wall File Locations are a ‘local box’ setting so they only 
apply to the workstation you are working on. The Global Audio Wall 
Settings are ‘global’ and apply to all Myriad workstations within your 
system.

 P Squared Directory Settings – The Directory Settings menu option 
offers access to the P Squared Directory Settings window which is 
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used to set the location of the P Squared Directory that Myriad will use 
and also to alter some of the settings within that directory. The fact that 
the same window is used to set the location of the P Squared Directory 
as well as settings within the Directory means that there is a mixture of 
‘local box’ and ‘global’ settings on this window. The location (path) of 
the Directory and the Automatically Create User options are local but 
all other settings are global.

The P Squared Directory Settings window is divided in to three tabs:

o General – The General tab allows you to set the location of the 
P Squared Directory using the Path setting. You can also set 
whether Myriad should automatically create a P Squared 
Directory User based on the Windows Login name. The final 
section on this tab allows you to add additional ‘stand alone’ 
Directory Manager licenses to your system to give access to the 
P Squared Directory on PC’s that do not have Myriad installed. 
These stand alone licenses are available for a small cost directly 
from P Squared Ltd (email sales@psquared.net for more 
information).

o Security Groups – The Security Groups tab allows you to add, 
view and manage security groups within the P Squared 
Directory. Security Groups provide a quick and simple way of 
specifying access rights for multiple Users on the system.

o Backup – The Backup tab allows you to setup and manage the 
automatic backup of the P Squared Directory.

 Myriad Settings – Another very important section of the Settings 
menu, the Myriad Setting option is used to access the Myriad Settings 
window which hosts a vast array of settings and configuration options 
relating to the general behaviour and operation of Myriad. The majority 
of the settings on the Myriad Settings window are ‘local box’ settings 
with the exception of some of the options on the View Menu, Advanced 
and Other Settings tabs.

The Myriad Settings window is divided up in to eight tabs each of which 
refer to a different area in Myriad. The tabs are:

o Data Location – The Data Location tab allows you to browse 
and select the base level file location for the data files and 
databases that Myriad uses to store its data. All Myriad 
workstations should be ‘pointed’ at the same Data Location 
which would normally be located on a server or a RAID disk 
array on one of the local boxes.

o General Options – The General Options tab contains a number 
of miscellaneous setting and options pertaining to a wide variety 
of areas in Myriad. 

o Audio Wall – The Audio Wall tab allows you to set Audio Wall 
related options in Myriad (not covered in the Audio Wall Global 

mailto:sales@psquared.net
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Options). Of particular interest is the ‘Recent Play’ settings 
which can be set up to make Myriad mark Carts played in the 
last X hours as having been played recently on the Audio Wall. 
These Carts have a special ‘Recently Played’ icon on them.

o Station Database – The Station Database allows you to set 
whether Myriad will automatically open a specific Station 
Database when it starts up, ask the User to select a database or 
not open a Station Database at all. You can also set whether 
you want Users to be able to edit the ‘currently on air hour’ on 
workstations other than the one that is ‘on air’ using an option on 
this tab.

o View Menu Tab – The View Menu tab allows you to customise 
the options on the main View Menu (as seen earlier in this 
Chapter). Basically, you can use this tab to add new local or 
web based links to the View Menu and also to decide whether 
the list should apply just to the workstation you are working on 
or to all Myriad workstations on your system.

o On Air Control – The On Air Control tab allows you to select 
the On Air control method that you wish to use (simple or 
advanced) and also to set up the way the on air control will 
work.

o Other Settings – The Other Settings tab covers two main 
areas. Firstly it allows you to maintain a global list of all the 
Myriad workstations on your network and to assign a Computer 
Name to the workstation you are working on. The second area 
covered on this tab is the Command interface which allows you 
to add and manage the Commands that you want to be 
available to users via the Log Screen.

o Advanced – The Advanced tab offers some more advanced 
configuration options that would not be altered by Users in 
normal operations. These include managing Configuration 
Profiles (for multi-configuration setups), altering system priority 
for Myriad, setting debug information. You can also configure 
Myriad to automatically log in to Windows when the PC starts up 
and get time sync information from a PC time source.

 License Details – The License Details option on the Settings menu 
offers access to the License wizard which is used to review and 
renew the License Code for the Myriad workstation you are working 
on.

As you can see, there is a lot to cover in this section of the documentation so 
we best get started!

Audio Settings
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Please note that the following settings affect both Myriad and Myriad 
Manager.

The Audio Setting option on the Settings menu provides access to the Audio 
Settings window which in turn allows you review and edit a range of Myriad 
settings all of which relate to audio playback, audio recording or the Cart 
Players in Myriad.

The Audio Settings window is divided in to four tabs which are:

 Cart Players – For editing the amount of Cart Players Myriad 
shows and which sound card outputs Myriad should use for each 
Cart Player.

 Playback Settings – For adjusting the way Myriad deals with 
‘sweepers’ and Voice Tracks and well as what order Myriad should 
use Cart Players in and whether to allow Users to customise the 
way Cart Players eject Carts.

 Record / Edit Settings – For setting the audio quality and format 
that Myriad uses when it records, rips or imports audio in to the 
Audio Wall. Also allows you to configure an external audio editor 
(such as Adobe Audition™) to use in addition to the SmoothEdit 
Screen.

 Advanced – For a range of more technical and advanced audio 
related settings that should normally only be adjusted at the advice 
of P Squared.

We will not look at the options on each of these tabs in more details.
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The Cart Players Tab

The primary role of the Cart Players tab is to allow you to set how many Cart 
Players will be used on the Myriad workstation you are working on, which 
sound card outputs each Cart Player should use and also what Cart Plays 
Myriad should use for certain special events such as Editing Carts, playing 
Hooks etc.

You can also configure Myriad to display the Cart Players along the top of the 
screen if you wish.
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Number Of Cart Players To Use

The ‘Number Of Cart’ Players option allows you to set the number of Cart 
Players that will appear on screen and therefore the amount of Cart Players 
that are available in Myriad.

When run Myriad for the first time, Myriad will automatically scan you PC for 
soundcards and set the amount of Cart Players based on the amount of audio 
playback channels it finds. If you PC is fitted with one of the standard 
soundcards that P Squared use (Midiman Delta 10/10 or Echo Layla 3g) then
Myriad will automatically pick the correct amount of Cart Players and assign 
the Cart Players to the correct audio channels (in theory – but it can be 
confused by other audio devices such as fax / modems or Bluetooth 
adaptors).

To alter the amount of Cart Players Myriad will use, click on the Change 
button.
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You can the type in the number of Cart Players you wish to use.

You can enter a number between 1 and 12 but keep in mind that you should 
have an individual soundcard playback channel available for each Cart Player 
you enable and also that Myriad will need to fit them all on screen. If you 
select more Cart Players than can be fitted on screen, Myriad will do it’s best 
to cram them in but you may find that they are not practically useful.

Once you have typed in the appropriate number of Cart Players to use, click 
on the Set button.

Please note changing the amount of Cart Players on a ‘on air’ PC is not 
recommended and the changes will not come in to effect until you next restart 
Myriad.

Manual / Automatic Allocation Of Sound Devices To Players

The ‘’Allocation Of Sound Devices To Players’ drop down list allows you to 
switch between Myriad automatically assigning a soundcard output to each 
Cart Player and you manually assigning a sound device to each Cart Player.

To set this option, use the drop down list to select Manual or Automatic 
assignment.
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When the setting is set to Automatic, the Cart Players are automatically 
assigned to sound card outputs and the sound card assignment section is 
’greyed’ which prevents you from altering the settings.

Once you switch to Manual, the Player Soundcard Assignments section 
becomes white and you can edit the sound card assignments for each Cart 
Player using the drop down lists (see next section).
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Allocating Sound Devices To Cart Players

When Myriad is running on a workstation that is intended to use ‘on air’ then 
each Cart Player must be assigned to a separate sound device playback 
channel to allow Myriad to individually fade and control each Cart Player and 
to allow you to physically wire each Cart Player to a separate channel on your 
mixing desk. The screen shot below shows a typical setup using a multi-
channel sound card (in this case an Echo Layla 3G).



309

Note that each of the ‘Player’ rows is assigned to a different output on the 
multi channel sound card.

To alter the sound device that a Cart Player uses, click on the sound device 
column and select the sound device you want to assign to the Play row you 
are working on.
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In the example above, we are changing the sound device assigned to Cart 
Player 1.

Please note that the Cart Players, the Edit Soundcard and the Record 
Soundcard can be assigned to sound devices where as the Hook Player, 
Instant Cart Player and Preview Player can only be assigned to Cart Players 
(which of course are assigned to sound devices). The list below should help 
identify what each option is for.

 Player 1 – X – Each ‘Player’ row represents a Cart Player so if you 
have Myriad configured to use six Cart Players, you will see ‘Players 1 
to 6’ in the list.

 Edit Sound Card – The sound device playback channel used by the 
SmoothEdit Screen when editing the audio. This is often set to the 
same channel as Cart Player 4 but if you have a sound device free 
then having an ‘edit’ fader on your desk may be useful.

 Record Soundcard – This is the audio input channel that Myriad will 
use for recording audio in Myriad. This is used by both the Record Cart 
Player and the SmoothEdit Screen. Many multi-channel soundcards 
actually have multiple inputs as well as outputs but Myriad will only use 
one audio input.

 Hook Player – Use this option to select the Cart Player that Myriad will 
use when you manually load the Hook Player or a AutoHook Log Item 
is encountered in the Schedule Log. It is a good idea to either set this 
to ‘Any Player’ or if you always want to use a specific Cart Player, 
select a high number Cart Player as if you set this to a specific Cart 
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Player and that Cart Player is not available when Myriad comes to use 
the Hook Player then Myriad will not be able to play the hooks.

 Instant Cart Player - This allows you to set default Cart Player that will 
be used in preference whenever an Instant Cart is triggered in Myriad. 
Unlike Hooks however, Instant Carts will play through other Cart 
Players if the default Instant Cart, Cart Player is not available.

 Preview Player – The Preview Player option is used to select the Cart 
Player that is used when you preview a Log Item on the Log Screen. 
As with the Hook Player, it is a good idea to leave it set to Any Player 
or a higher number Cart Player as Myriad if you specify a Cart Player 
and the Cart Player is in use, Myriad will not be able to Preview items 
from the Log.

Please note that sound devise assignment changes and changes to the 
amount of Cart Players on screen do not take effect until you have restarted 
Myriad.

Player Display Alignment

The Player Display Alignment option is used to set whether the Cart Players 
in Myriad are displayed along the bottom of the screen (default) or along the 
top of the screen.
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Playback Settings Tab

The Playback Settings tab is used to review and alter a range of playback 
related settings in Myriad. 

The tab is divided in to three general areas:
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 Playback Volume – Allows you to alter the way in which deals with 
special event Carts such as ‘sweepers’ and Voice Tracks. Also allows 
you to alter the segue (cross fade) point which has a direct effect on 
how ‘tight’ Myriad will sound in automated segues.

 Cart Player Usage Order – By default, when Myriad needs to use a 
Cart Player for automated playback (on either the Log Screen or the 
Pad), it will try to find the lowest Cart Player Number available. This 
means that the first Cart would be played in Cart Player 1 and then the 
next Cart would be played in Cart Player 2. By the time this Cart has 
finished, Cart Player 1 should be empty again so Myriad will use that 
next. The system will only use the higher numbered Cart Players if the 
lower number Cart Players are in use. The Cart Player Usage section 
allows you to set Myriad to do this in reverse order (start with the 
highest number Cart Player and work backwards) and also to restrict 
the system so it does not use all of the available Cart Players.

 Option Options – The Other Options section allows you to configure 
Myriad to use or over rule Cart ejection Customise options.

We will now look at the options on the Playback Settings tab in more detail.

Play Normal Carts At XX% Of Maximum Volume

This setting allows you to set the audio playback volume for normal Carts 
played by Myriad as a percentage of the maximum volume of the sound card.

Why?

The first thing we should do is define ‘normal Carts’. In this instance we many 
any Cart played by Myriad that is not to be played as a ‘sweeper’ or a Voice 
Track and also Adverts in some configurations.

The reason for the distinction is that sweepers and Voice Tracks are intended 
to be played ‘over the top’ of other Carts and so ideally should be louder than 
the Carts they are playing with. Myriad Can be configured to do this is two 
different ways.

1. All normal Carts are played out at a standard volume (say 100% for 
example) and then ever a sweeper of Voice Track is played, the 
sweeper of Voice Track plays at the standard volume but all other 
Carts are faded down to a lower audio volume to allow the sweeper or 
Voice Track to be heard.

2. All normal Carts are played at a lower audio volume and Myriad plays 
sweepers and Voice Tracks at a higher audio volume. Usually this 
would have to be combined with an external audio processor in order 
to sound any good.
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Of the two methods, the first is the most desirable as it does not rely on 
external equipment and is also much closer to the way a presenter may work 
in a live show. The second method may be better suited to some stations 
application.

Obviously, which ever method you wish to use, the Play Normal Carts At XX% 
Of Maximum option is important as it allows you to set the base level audio 
volume for playing normal Carts in Myriad.

In the next section we will set how we want Myriad to deal with sweepers and 
Voice Tracks.

When Playing A Sweeper Duck To XX% / Play At XX% - working on

In the last section (Play Normal Carts At XX %) we looked at the two different 
ways that Myriad can be set to play sweepers and Voice Tracks. We also set 
the playback volume for ‘normal’ Carts.

The When Playing A Sweeper option allows you to select the method that you 
want Myriad to use as well as set the audio volume percentage for each 
method. The options are:

 Duck The Other Cart To XX% Of Maximum Volume – If you select 
this option then Myriad will fade or ‘duck’ all other Carts to the 
prescribed audio volume percentage whenever a sweeper or Voice 
Track is playing. The sweeper or Voice Track will be played out at the 
‘normal’ Cart volume.

 Play Sweeper At XX% Maximum Volume – If you select this option 
then sweepers and Voice Tracks will be played at this audio volume 
and all other Carts will be played at the ‘normal Cart’ volume with no 
ducking or volume changes of any kind. This method should usually be 
combined with external audio processing in order to ‘lift’ the audio 
volume of ‘normal’ Carts to an acceptable level. The screen shot below 
shows a typical setup for using Myriad in this way.
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So with these settings, all ‘normal’ Cart in Myriad will play out at 80% of 
full volume on the sound card but sweeper and Voice Tracks (and 
optionally adverts) will play out at 100% volume on the sound card.

When Segueing Carts, Fire The Next When The Current Has Faded To 
XX%

This innocent looking setting actually affects the entire way that Myriad will 
sound in manually triggered segues in any of the Active Playout Modes as 
well as when you ‘soft’ Eject a Cart that is part of an active Pad run. When 
you trigger a Go event in an Active (or soft Eject a Cart in a Pad run), Myriad 
will start to fade down the currently playing Cart but will not start the new Cart 
straight away, this intended to give a smooth sounding transition between the 
two Carts.
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The diagram below should help to illustrate the way that Myriad works.

In this example, when the Go button is pressed in Live Playout Mode, Myriad 
will start to fade out the Cart that is currently playing. When the volume of the 
Cart being faded drops to 65%, the next Cart is automatically started.
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This means that by setting this value higher, the transition between the two 
Carts will be faster with the next Cart cutting in while the current Cart is still 
playing at a high volume, this may be more suitable for ‘hot’ sounding station. 
Set this setting lower and the transition will be slowing giving a more relaxed 
transition more suited to a ‘gold’ style station.

Please note that Myriad can be configured in such a way that when you 
trigger a Go event, the next Cart starts straight away and the current Cart is 
not faded at all. If you configure Myriad in this way then the ‘When Segueing 
Carts’ setting will not be used.

Play Carts Starting With Cart Player X

The Cart Player Usage section of the Playback Settings tab allows you to 
configure the default way in which Myriad will load Carts in to the Cart Players 
when in Actively Playout Mode or when you cue a Cart without specifying 
which Cart Player to use.

The default setup is for Myriad to always start with Cart Player 1 and work it’s 
way up to the ‘Last Cart Player’. In practice, this means that if you have 
configured Myriad to have four Cart Players, the first Cart would be played 
using Cart Player 1, the next Cart would have to be cued in Cart Player 2 prior 
to starting (as Cart Player 1 is still in use playing the first Cart). Once the 
second Cart Player is playing, Cart Player 1 would finish what it is doing and 
become empty again. At this point, Myriad would be free to cue the next Cart 
back in Cart Player 1. Myriad will continue in this way ‘flip flopping’ between 
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Cart Players 1 & 2. If at any point, Myriad needed to cue a Cart and both Cart 
Players 1 and 2 were in use then it would cue the next Cart in to Cart Player 
3. In extreme conditions, if Myriad was using three Cart Players and needed 
to cue another Cart, it would make use of Cart Player 4 and so on and so 
forth. 

So basically, Myriad will always try to use the lowest number available Cart 
Player and the higher number Cart Players will only be needed under heavy 
load conditions, leaving them free for you to use manually.

The Cart Player Usage settings allows you to change this default behaviour to 
restrict the Cart Players that Myriad can use or alter the order in which it uses 
the Cart Players.

The ‘Play Carts Starting With’ drop down list allows you to select the Cart that 
Myriad will attempt to use first when cueing audio. If you set this to Cart 
Player 2 then Myriad would always start from Cart Player 2 and work it’s way 
up leaving Cart Player 1 free at all times. If you selected ‘the last Cart Player’ 
option then Myriad will start with the highest number Cart Player first.

And Finish With Cart Player X

You can use the ‘and finish with Cart Player X’ drop down list allows you to 
select the last Cart Player that Myriad will use for automatically cueing Carts.
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In the above configuration, Myriad will first try to cue Carts in the highest 
number Cart Player (Cart Player 4 for example), then the next highest  and so 
on until it has to use Cart Player 1. With this configuration, under normal 
circumstances, Myriad would alternate between Cart Players 4 and 3 
(assuming Cart Player 4 is highest) and only use the lower number Cart 
Players when Cart Players 4 and 3 are already in use.

You can also use this option to restrict the Cart Players that Myriad will use to 
automatically cue Cart up in.

In the configuration below, Myriad will automatically cue Carts in Cart Players 
1 to 3 but will not automatically cue Carts in Cart Player 4 leaving it free for 
manual use.
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Please note that changes made to the Cart Player Usage section will only 
take effect the next time that you restart Myriad.

When Should Carts Be Allowed To Be Ejected

This option allows you to set the conditions under which a User can Eject a 
Cart from a Cart Player.

To set this option, use the drop down list to select the option that you wish to 
use.
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The options are:

 Allow Cart To Be Ejected At Any Time – When this option is set, the 
User can Eject the Cart at any time, even when it is playing.

 Only Allow When Paused Or Cued – When this option is set, the 
User can only Eject the Cart while the Cart Player is in cue or pause 
mode. This means that you can not Eject a Cart that is playing without 
stopping it first.

 Use The Users Directory Preferences – If this option is selected then 
Myriad will use the individual Users preference for Ejecting which is set 
on a per User basis using the Customise options on the Tools menu 
(see Tools Menu > Customise > Audio Tab  > Playback & Recording).

Changes to this setting will only take effected once you have restarted Myriad.

The Record / Edit Settings Tab

The Record / Edit Settings tab allows you to set a range of options that refer 
to the method and format that Myriad uses when recording or importing audio 
in to the system. It also allows you to configure an external audio editing 
software program to use for more advanced audio editing techniques that may 
not be available in the SmoothEdit Screen.
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Record Audio Settings > New Audio Will Be Recording Using The Audio 
Format

This setting allows you to select the audio quality level and compression 
format for all audio recorded, ripped or imported in to Myriad. This setting is 
very important as it is used to set the quality and format for several areas in 
Myriad. These include:

 Recording audio via the Record Cart Player.
 Ripping CD tracks using the Import Audio wizard.
 Importing audio files using the Import Audio wizard.
 Recording audio using the SmoothEdit Screen.

But it does not set the quality the Voice Tracks will be recorded in at when 
using the Segue Editor (in Full Segue Editor mode). This is set as part of the 
Station Database settings (see Settings Menu > Station Database Settings > 
General tab).
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To select the audio quality and format to use, click on the Choose button to 
open the Choose Audio Format window.

You can use this window to set the audio format, quality and other associated 
audio quality settings.

 Audio Format – This allows you to set the basic audio format type that 
you wish to use. In Myriad v3.0.x, the only option on this drop down list 
is Windows Wave (WAV) format as that is the only format that Myriad 
supports. Myriad v3.1 or higher supports other audio formats including 
MP2, MP3, WMA, Ogg Vorbis, AAC and AC3 (see future versions 
below).

 Format – When working with WAV format options, the Format drop 
down list is used to select whether you wish to use PCM (linear / non 
compressed) format or IMA ADPCM (4:1 compressed) format.
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The advantage of PCM is that it offers the highest quality audio but 
also takes the most hard disk space per minute recorded on to the 
system. IMA ADPCM offers 4:1 compression which means that four 
times as much data can be stored in the same space as PCM. The 
down side is that compressed audio is not as high a quality as linear 
audio (although IMA ADPCM is a very light compression scheme).

 Sample Rate – The Sample Rate drop down list allows you to select 
the sample rate that you wish to use for recording / importing audio in 
to Myriad.

The drop down list shows all of the Sample Rates that Myriad supports 
but it is highly recommended that you stick with 44,100Hz as this will 
offer the best audio quality.
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N.B. 48,000Hz and 96,000Hz may not function on all configurations.

 Stereo / Mono – This allows you to select whether Myriad should 
record audio in stereo or mono.

Future Releases: Myriad v3.0.X only supports WAV format audio files but 
future releases will support a range of other compression formats including 
MP2, MP3, WMA and Ogg as well as PCM Wav and ADPCM Wav formats. 
Once these additional formats are supported, the settings on the Choose 
Audio Format window will change to accommodate the options for the 
selected format. The screen shots below show the configuration options for 
MP3 and Windows Media formats. Remember, these options are not available 
in versions earlier than Myriad v3.1 which is due for release in late summer in 
2006.

Also Allow Users To Choose A Different Format To Record Audio With

This tick box option enabled a new option on the Audio Wall right click menu 

With this option ticked, the right click menu on the Audio Wall changes to give 
users the option to either record using the default audio format or to select an 
alternative audio format for the recording.
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If a User opts to use a different format, the Choose Audio Format window 
appears prior to Myriad starting recording.
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Record Files To The Local Disk Then Transfer Them To The Network

By default, when Myriad records audio on to the Audio Wall, the audio is 
written directly to the folder that the Audio Wall files are stored in regardless of 
whether it is a local disk drive or a network drive. This has the advantage that 
once you have finished recording, there is virtually no ‘save time’ as the audio 
is saved to the disk (as it is saved in real time) and the audio is available to all 
Myriad workstations almost immediately.

The only time that this configuration can be problematic is if you are saving to 
a network location and you have a very slow network or your network is very 
busy. Under these circumstances, you may find that the recordings are 
contain small gaps or jumps which is when Myriad was not able to write to the 
network location because the network was busy or too slow to keep up with 
the data being written. 

In order to avoid this situation, you can use the ‘Record Files To The Local 
Disk’ option to configure Myriad to record audio to a temporary file on the local 
hard disk drive and then transfer the file to the network location once the 
recording is complete. This has the advantage that a busy or slow network will 
not cause problems when recording but there will be an increased ‘save time’ 
as the file is transferred to the network after recording has finished. On longer 
files, this may also have a negative effect on playback in Myriad so it is 
recommended not to use this option unless you have to.

As Well As SmoothEdit™, Also Allow An External Audio Editor To Be 
Used

Myriad v3 introduces the SmoothEdit Screen for editing Cart details and also 
performing simple audio editing functions using the Wave Form Edit Area. 
The audio editing functions in SmoothEdit are designed cover a range of 
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common tasks used in everyday studios but if you want to do production work 
then you may find the audio editing capabilities in SmoothEdit to be a little 
limiting. IN this situation, you can configure Myriad to offer access to an 
external audio editor such as Adobe Audio Audition™. 

If you configure Myriad in this way then the SmoothEdit Screen acquires an 
External Editor button on the main Edit Cart Tool Bar.

When you click on this button, Myriad automatically starts your selected audio 
editor program, loading the audio file you are working on. Myriad then 
minimises until you have finished working on the audio, saved the file and 
exited the external audio editor.

To set up this option, tick the ‘As Well As SmoothEdit™, Also Allow An 
External Audio Editor To Be Used’ option and then type in the location of the 
program (exe) file for the audio editor that you wish to use.

You can also use the Choose button to browse your computer for the audio 
editor program that you wish to use.
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TIP: Whilst programs can be installed anywhere, the most common location 
for applications to install is the c:\Program Files\[Application Name] folder. 
You can see this in the example above where we have configured Myriad to 
use Cool Edit 2000 which is located in the c:\Program Files\Cool200 folder 
and the actual program is called Cool2000.exe. If you are unsure as to the 
location of your external audio editor or the name of the application program, 
please refer to the audio editor documentation for further details.

Priority: P Squared Product / Editor Runs Faster

The Priority setting is used to prioritise computer processing power for either 
running Myriad or for running the external audio editor (see above). The 
reason for doing this is that editing audio can be a fairly intensive process and 
if you are working on a Myriad workstation that is also playing out at the same 
time, intense audio editing could effect playback in Myriad. 

The Priority setting allows you to divert computer power more towards Myriad 
or your external audio editor which should allow you to balance between the 
two applications to allow Myriad to playout reliably even when editing

The default for this setting is for the audio editor to run as fast a possible with 
Myriad running at a lower priority in the back ground. For the vast majority of 
workstation configurations, this setting will work just fine but if your are having 
problems then move slider more towards the Myriad side to alter the priority 
between the two applications.
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The Advanced Tab

The Advanced tab offers access to some of the more advanced configuration 
options in Myriad, relating to audio, audio playback and editing. In general, 
there is no need to alter any of these settings unless you are trying to fix a 
particular problem or you are advised to do so be a member of the P Squared 
technical support team.

This tab also offers access to the Advanced SmoothStream settings which 
allows you to alter the settings for Myriads’ proprietary audio engine 
SmoothStream.

The SmoothStream settings are for advanced users only and you should not 
‘tinker’ with them unless advised to do so by a member of the P Squared 
technical support team.

The final option on the Advanced tab is the Debugging Mode options which 
allows you to set Myriad to generate various levels of debugging log files to 
help track down problems in the audio engine or with playback in Myriad. 
When in debug mode, Myriad generates large quantities of data as special 
files that can be sent to P Squared to help solve problems. Generating these 
files will cause Myriad to run more slowly than usual and also fill up the local 
hard drive so it is not a good idea to run in debug mode for long and you 
should only ever do so at the request of a P Squared technical support 
engineer.

The options in on the Advanced Tab are outlined below.
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Audio Files > Use ‘Legacy’ Mode To Copy / Move Carts 

If this option is ticked, Myriad will use a older, slower method for moving and 
copying Carts on the Audio Wall. The reason for this option is that over time, 
the Myriad move / copy functions have been optimised to take advantage of 
modern hardware and operating systems (OS). Unfortunately, that means that 
some hardware configurations may exhibit problems when moving and 
copying Carts on the Audio Wall. If you are experiencing problems when 
moving or copying Carts, select this option and see whether matters improve.

When this option is ticked, Myriad will use a more generic method for moving 
and copying Carts which will be more reliable on older configurations but will 
also be a bit slower.

SmoothStream > Increase The Size Of The Buffers That SmoothStream 
Uses

SmoothStream is the audio engine that Myriad uses for all audio playback and 
recording. Developed exclusively by P Squared, SmoothStream sits at the 
heart of all P Squared products delivering fast, reliable playback and 
recording that allows Myriad to interact and control directly with your PC’s 
sound cards.

Some configurations of hardware (particularly Windows 2000 installs) can 
have problems with playback when there is a lot of graphical manipulation 
happening on screen. This most commonly occurs when you minimise or 
maximise a window and the audio stops for a fraction of a second.

In order to over come this, you can tick the ‘Increase The Size Of Buffers’ 
setting to set Myriad to use slightly large audio buffers for playback which 
allow the computer to be ‘busy’ doing other things for slightly longer before 
playback is affected.

The only down side to this is that you may find that cueing Carts takes 
fractionally longer (and we mean a very small fraction of a second) and also 
that the ‘VU’ bars on the Cart Players are a little less accurate.

If you experience ‘choppy’ playback in general, it is worth switching this option 
on to determine whether it is a resource issue or if the problem originates 
elsewhere.

External Editor > Run The External Editor Process At Idle Priority

This option is very similar to the Priority option we looked at on the Record / 
Edit Settings tab a little while ago. Ticking this option will cause the external 
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audio editor that you have configured Myriad to use to be launched at a very 
low priority which will mean that it will run slower leaving more computer 
processing power for Myriad.

Advanced SmoothStream Settings

Clicking on the Advanced SmoothStream Settings button give you access to 
the Advanced SmoothStream settings window which contains a number of 
advanced settings regarding the SmoothStream audio engine.

The options on this window are covered in the Advanced SmoothStream 
Settings section of the documentation below.

Audio Debugging Mode

The Audio Debugging Mode option on the Advanced tab allows you to switch 
Myriad between several different debugging modes to help P Squared 
technical support engineers to track down problems you may be having with 
playback and recording on the system.

When in debug mode, Myriad automatically generates a text based file for 
each Cart Player which is stored in the root of your workstation C drive. These 
files are called:

C:\Smplyer1.dbg – Debug file for Cart Player 1
C:\Smplyer2.dbg – Debug file for Cart Player 2
C:\Smplyer3.dbg – Debug file for Cart Player 3
C:\Smplyer4.dbg – Debug file for Cart Player 4
…etc

The type and amount of data written to these log files depends on the level of 
debugging that you select from the drop down list.
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The options are:

 Play Normally – The default mode for Myriad with no debug files being 
created.

 Use Basic Debugging – The recommended level of debugging for 
tracking down occasional problems as only top level functions are 
added to the debug log files.

 Use Medium Debugging – More intensive than basic, medium 
debugging provide more details in the debug files but can slow the 
workstation down and fill up your hard drive.

 Use Full Debugging – When using this option, Myriad will write a 
great deal of detail to the debug log file and is likely to run very slowly 
and fill up your hard drive very quickly. As an example, in full debug 
mode, simply cueing and playing around 30 seconds of a Cart will 
generate more than 7000 lines of debug code!

It is recommended that you only use debug modes when requested to by a P 
Squared technical support engineer and they will advise you as to the level of 
debugging you should use.

Due to the nature of the debug file, left unchecked they could get very large 
very quickly so Myriad includes an inbuilt management system that monitors 
them and if they get too big, deletes them and starts again. Myriad also 
deletes them and starts again each time you re-start the system so if you are 
running debug mode to track down a particular problem, it is recommended 
that as soon as the problem occurs, stop Myriad and copy the appropriate 
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debug file to a save location prior to re-starting Myriad. That way you can go 
back to using Myriad and send the debug file to P Squared technical support 
at your leisure.

SmoothStream Advanced Settings Window

The SmoothStream Advanced Settings window is accessed via the Advanced 
SmoothStream Settings button on the Advanced tab of the Audio Settings 
window.

When you click on this button, it first warns you that you are about to access 
the Advanced SmoothStream settings window and that you should only do so 
if you have been advised to by a P Squared support engineer.
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It also advises that you should make a backup of your system before altering 
these settings. This is done but copying the System folder in your Myriad Data 
Locations (see Myriad Settings > Data Location tab).

If you wish to proceed, click on the Ok button.

SmoothStream Information

The top section of the window shows you some technical details about the 
SmoothStream system running as part of your Myriad installation. The 
SmoothStream version and Smoothey version numbers will be particularly 
important to P Squared technical support engineers when diagnosing 
potential faults with the SmoothStream audio engine.

Fade Mode

The Fade Mode option on the SmoothStream Settings window allows you to 
alter the way in which the audio engine performs audio fades by changing the 
way the fade information is passed to the sound card that is being used to 
play the audio.
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Under normal conditions Myriad fades Carts out in a linear fashion so that it 
starts at 100% of full volume, then fades it down steadily to 0% volume. This 
assumes that the sound card performs in the same way but some sound 
cards do what is called logarithmic fading which is where the rate at which the 
audio fades out is not constant across the entire duration of the fade. If this is 
the case then Myriad tells the card to fade to 90% of volume but because the 
drop in volume between 100% an 90% is much greater then the drop in 
volume from 90% to 80% the overall affect is that you get a very fast and 
rough sounding fade out. This is not good for automation because it relies on 
smooth fading to sound ‘live’.

To help to combat this, SmoothStream can be tweaked so that is actually 
uses a logarithmic method of fading so that the actual drop on volume over 
the first 10 % (100% - 90%) is the smallest drop of all with the drop steadily 
increasing over the duration of the fade out or vice versa. 

The graph above shows a rough approximation of what happens when the 
‘Start fading quickly and then slow down’ option for Fade Mode option is 
switched on. The sound card fades out the volume slowly at first then more 
quickly as time goes by. Conversely, SmoothStream fades out rapidly at first 
and decreases the rate of fading as time goes by. The net result is a basically 
linear fade which is what we wanted in the first place.

The opposite happens if you select ‘Start fading slowly and then speed up’ for 
use with soundcards that use logarithmic fading in the opposite way.

Use the drop down list to select the option and test it before putting it ‘on air’ 
as it is essentially a work around for a short coming of some sound card 
drivers and assumes that the sound cards are doing a perfect logarithmic fade 
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which may not be the case. Many people have found that this tweak does get 
around ‘dodgy’ sounding fades on their system.

Of course, if your sound card works the way it is supposed to then it will have 
a linear fade and when Myriad says fade to 50%, it will reduce the audio 
volume to 50% of maximum volume in which case ‘Normal fading’ should be 
selected from the drop down list.

Flush The Audio Engine With Silence Prior To Each Cue

This option has been added to specifically cure a bug in the actual multi-
media sub system of Windows 2000™ when a soundcard is using WDM 
(Windows Drive Model) drivers. The WDM initiative is supposed to allow 
manufacturers to make a single driver for a device that works across all the 
different operating systems. Our internal testing has highlighted a few of 
problems common to all WDM drivers which would suggest the problem lies in 
the WDM system itself. 

One of the most common problems occurs under Windows 2000 using WDM 
drivers. If you recue a Cart when it is halfway through playing and the press 
Play again, a fraction of a second of the middle of the song plays before the 
start of the song. This is very annoying in a broadcast environment so we set 
about working around the problem. The solution is to flush the buffers in the 
Audio Engine each time an item is re-cued. This has practically no effect on 
Myriad but does appear to fix the problem in all the cases that we have tested. 

The problem does not exist on most Windows XP (SP2) installations but if you 
experience problems similar to those described above then try setting this 
option.

If you tick this option, you can also set the size of the audio used to flush the 
Audio Engine. It is highly recommended that you leave this setting at 1 
millisecond unless advised otherwise by a P Squared engineer.

If you make any changes to the Advanced SmoothStream Settings window, 
click on the Save Settings button to save the changes you have made. You 
may have to restart Myriad in order for the changes to take effect.

Audio File Locations

The Audio File Locations option on the Settings menu offers access to the 
Audio File Locations window which is used to set the folder locations of the 
audio and data files that are used to make up the Myriad Audio Wall. 

The Audio File Location can be set for all Carts on the Audio Wall or 
individually per ‘chuck’ of a thousand Carts on the Audio Wall (up to 10,000).
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The Audio Wall Locations window also offers access to the Global Audio Wall 
Settings window which (as the name suggests) allows you to set a number of 
global Audio Wall related options that affect your entire system.

The Audio Wall Locations are set on a ‘per box’ basis so if you want all of the 
Myriad workstations in your station to use the same Audio Wall, set the file 
locations to be the same on each box. The Audio Wall File Locations would 
normally be set to either a shared drive on a server or a local hard disk. 
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It is highly recommended that you store your audio files on a hard disk 
array that is protected by either hardware mirror or RAID 5. You should 
also make sure you implement a regular backup routine to ensure 
against valuable data loss.

Carts 1 to 1000

The Carts 1 to 1000 section allows you to type in the location of the folder 
where you want to store Carts 1 to 1000 from your Audio Wall. This location 
could be a local hard disk and folder or a network path or UNC.

You can also use the browse button to open the folder browser window to 
allow you to select the folder that you wish to use.

This will open a standard Windows file browser window which allows you to 
view and navigate the local and network file locations available to your 
system.
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Select the folder that you want to use and click on the Ok button.

TIP: You can use the right click menu on this window to copy, rename, delete 
or create a folder.

Carts 1001 to 10000+

You can also set alternative folder locations for each ‘chuck’ of 1000 Carts on 
the Audio Wall up to Cart 10000 after which only a single file locations can be 
set. To enable this option, un-tick the ‘Store All Carts In The Same Location’ 
option and then you can set a different folder location for each ‘chunk’ of the 
Audio Wall.
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If you have configured Myriad to have more than 10000 Carts then the ‘Carts 
10001 to’ option becomes enabled which allows you to set the location for all 
Carts over 10000. As before, you can use the browse buttons to access the 
Browse Folder window to select the location that you wish to use.

Global Audio Wall Settings

The Global Audio Wall Settings button opens the Global Audio Wall Settings 
window which is used to set a number of Audio Wall related options that are 
used by all Myriad workstations configured to use the same Audio Wall 
locations for Carts 1 to 1000.
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The Global Audio Wall Settings window is divided in to three main tabs that 
explained in more detail below.

General Tab > Audio Wall Size

This option allows you to set the number of Cart Slots that will be available on 
your Myriad Audio Wall. This can be set to any number from 1 to 99999 but 
the default value is 9999 which effectively gives you 10000 Carts.
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To change the number of Cart Slots on your Audio Wall, click on the Change 
button and type in the new number of Cart Slots that you want to use.

Once you are happy with the number, click on the Set button to save the 
changes.

Once you have finished in the Global Audio Wall Settings window, click on the 
Ok button and Myriad will warn you that the changes you have made will 
effect all users.

Click on Yes if you wish to continue.

N.B. Whilst Myriad restricts you to 99,999 Carts, practical restrictions such as 
hard disk space and the time taken to find Carts on the Audio Wall mean that 
is Is usually better to set this number only as high as you think you need it to 
be. You can always expand the Audio Wall in the future if you need to.

General Tab > Audio Wall Picture Filename Extensions
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The Audio Wall Picture Filename Extensions option allows you to set the 
picture file format that Myriad will use for importing and storing pictures 
associated with Carts on the Audio Wall. 

To select the format that you wish to use, click on the drop down list highlight 
your preferred format.

The options are: 

 JPG – Jpeg compressed picture files. This is the most common format 
on the Internet and is the default format for Myriad.

 GIF – Compressed pictures that allow transparent backgrounds but are 
not as common on the Internet now.

 BMP – Bitmap is the default Windows picture format but is essentially 
uncompressed so BMP pictures will be much larger than JPG or GIF in 
terms of the space used on your hard disk per picture.

Myriad is only able to use one picture file format so it is best to pick the format 
you think will be the most use and stick with it.

And as we are dealing with pictures, he is a special treat just for reading such 
an obscure part of the Myriad manual. Britney and Atomic Kitten
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And so no one feels left out, A1 and Roger Sanchez.

Now back to business!

Importing Audio Tab > CD Ripping > Allow The Internet To Be Queried 
For CD Title (CDDB Details)

This section of the Importing Audio tab allows you to set whether Myriad can 
‘look up’ information such as Title and Artists from special audio CD 
databases on the Internet, when ripping audio in to the system from CD.

Basically, CDDB is a generic term for a CD Database which is a database of 
commercially available CD’s along with the track information contained on the 
CD. Each commercially produced CD is given a unique reference number and 
Myriad can read this number as part of the CD ripping process and 
automatically download Artist and Title information from your selected 
database site.

This will only work with commercially produced as a CD burnt at home does 
not have a unique ID and the details of the tracks it contains are not publicly 
known. Some more obscure CD’s may also not be listed in the online 
databases.

To enable Myriad to use this facility, tick the ‘Allow The Internet To Be 
Queried For CD Title’ option and select the CDDB that you wish to query 
using the drop down list.
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All of the options in this list operate a free service that is updated by users of 
the service so whilst it is free to use, there is no guarantee of the quality or 
accuracy of the information downloaded to Myriad. 

The default database is ‘feedb.freedb.og’ as Myriad users have indicated that 
it offers the most accuracy.

All of the CDDB services available for use in Myriad require users to submit a 
valid and working email address as part of the enquiry. This database is not 
used for any marketing services (that we are aware of) but if you require more 
information, you should contact the CDDB services directly. To set the email 
address for Myriad to submit with enquires, type in the address in to the Email 
field.
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Import Audio Tab > CD Ripping > Automatically Trim Silence At The 
Start (Top) Of Audio

This setting is used to determine whether Myriad should automatically remove 
any silence from the beginning of audio ripped from CD and also when Myriad 
imports audio data files.

If you un-tick this setting, a CD track that includes 3 seconds of silence at the 
beginning will also have 3 seconds of silence at the beginning as a Cart on 
the Audio Wall meaning you may have to manually edit it. Turn this setting on 
and the 3 seconds would be automatically removed as part of the ripping 
process.

Import Audio Tab > Other Options > Normalise The Imported Audio To 
XX Percent

This section allows you to configure Myriad to automatically normalise audio 
that is imported in from data files or ripped from audio CD’s.
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To configure Myriad to normalise imported / ripped audio, tick the Normalise 
option to enable the setting and type in the percentage of maximum audio 
volume that you wish Myriad to normalise to.

The default in Myriad is 63% which tests indicate is around digital zero or -
14dB analogue but this will vary with your equipment. The level is not as 
important as the fact that all of your audio is normalised to the same level.

For details on what normalising is and how it affects audio, please refer to 
Chapter 6 – Normalise. 

Advanced Tab > Allow Users To Link To Other Files Not Stored In The 
Audio Wall 

This option is used to enable linking to files in Myriad. Under normal 
circumstances, of the Carts that appear on the Audio Wall have a 
corresponding audio file stored in the appropriate Audio Wall File Location. 
But Myriad can also be configured so that Carts on the Audio Wall ‘link’ to an 
external audio file that is not located in the main Audio Wall File Locations. 
This means that the file is not copied in to the Audio Wall File Location and 
Myriad instead uses the original file wherever that may be stored.

The disadvantage is that you can end up with a very complicated system 
which will run fractionally slower than the standard setup.

To allow Users to Link to audio files, tick this option.

Advanced Tab > Store A Copy Of Each Carts Information In An 
Individual File

This is a legacy setting that should not be switched on in modern versions of 
Myriad unless directed to by a P Squared Technical Support engineer.

Basically, the Title, Artist and timing information for a Cart in Myriad is stored 
in two separate places. Firstly, the information for each Cart is stored in to a 
special data file called a Cart List (carts1.lst etc) file that is located in the 
Audio Wall File Locations folder. This file contains all of the vital information 
about the Carts and is used by Myriad when browsing or searching the Audio 
Wall. In addition, key Cart information (such as Title, Artists and Timing) are 
also embedded in to the actual audio files themselves and Myriad can use this 
information to re-build the Audio Wall should the need arise.

The ‘Store A Copy’ setting is used to activate a third option for storing the 
information with an individual Cart List file being generated for each individual 
Cart on the Audio Wall.
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This method will slow Myriad considerably in day to day use and is no longer 
necessary as the information is embedded in to the audio files themselves.

CAUTION: Do not use this option unless instructed to by a P Squared 
engineer.

Advanced Tab > Use / Store Copyright Details In ‘Cart Chunk’

As mentioned above, Myriad automatically embeds key Cart information in to 
the actual audio files to allow it to recover the information if need be or to 
allow another Myriad system to import the audio and Cart information at the 
same time. This is done using an international standard called Cart Chuck 
which defines where the Cart information should be stored within the audio 
file. In theory, this means that you could export a Cart from Myriad and then 
import it in to another 3rd party playout system that is Cart Chuck compatible 
and all the title and timing information would be imported as well.

The problem is that there are not enough fields in the Cart Chuck specification 
to cover all of the information that Myriad allows you to add to the Cart. The 
main problem is that Cart Chunk does not differentiate between the Cart Title 
& Artists fields and the Copyright Title and Artists fields. In practice, these are 
normally the same so it makes little difference but there may be 
circumstances when it is important.

When this option is switched off, Myriad will use the Title and Artists 
information from the General tab on the SmoothEdit Screen for embedding in 
to the audio file. If you switch the option on, Myriad will use the Title and Artist 
information from the Copyright tab on the SmoothEdit Screen for embedding 
in to the audio file.

If you are most likely to transfer audio between Myriad systems then you 
should leave this option off. If you think you will need to transfer audio 
between Myriad and other third party systems then turn this option on as 
strictly speaking, Myriad is not fully Cart Chunk compliant with it off (but only 
on a technicality so don’t worry).

P Squared Directory Settings

The Directory Settings option on the Settings menu offers access to the 
Directory Settings window which is instruct Myriad as to which P Squared 
Directory it should be using to configure the use of the Directory itself.
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But what is The P Squared Directory?

The P Squared Directory is essential a contacts database that is used to keep 
contact details and access rights for all the Users of your Myriad system as 
well as Users for other P Squared products and general contacts that you 
may wish to add to the database.

For Users familiar with previous versions on Myriad, the P Squared Directory 
replaces the old Users Database from Myriad v2.6.

The main advantage to the P Squared Database structure over the older 
Users Database system is that the P Squared Directory is common across all 
Directory activated P Squared products (which includes, Scoop, Myriad and 
Powerlog) so you can have a single database for Users for all the P Squared 
Products at your station. The other advantage is that P Squared offer a stand 
alone Database Manager application that can be purchased for installation on 
other (non Myriad) PC’s at your station providing you with a low cost central 
contacts database that can be accessed by any enabled PC.

The P Squared Directory is used more heavily in information focused products 
such as Scoop. In Myriad it’s primary role is to allow you to add Users to your 
system and administer the access rights that they have.

The Directory Settings window is split in to three tabs which are examined in 
more detail below.
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The General Tab

The General tab is used to set the location of the P Squared Directory 
database file that you wish Myriad to use as well as what Myriad should do 
when you first set up your Directory.

You can also administer any stand alone P Squared Directory Manager 
software licenses that you may have purchased in addition to Myriad.

Directory Database Path

This Path setting is used to set the location of the P Squared Directory 
Database that Myriad will use to access the Database.

To alter this setting, click on the Change button and then use the Browse For 
Folder window to select the folder that your Directory Database is located in 
or the folder that you wish to create it in if you are working on a new database.

Once you are happy with the location, click on the Ok button.
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Please note that if you select a Directory Database Path in here that does not 
contain a valid P Squared Database File, Myriad will ask you whether it 
should create a Directory in the folder then next time it restarts.

Click on the Yes button to create a P Squared Directory in the selected folder.

Automatically Create Users When They First Use Directory Enabled 
Software

This setting is only used if you have configured Myriad to automatically 
attempt to login to Myriad when it starts, using the Windows Login name that 
is currently logged in to Windows (see Settings Menu > Myriad Settings > 
General Options tab).
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In this condition, Myriad will attempt to login using the Username and 
Password from the Windows Login but will fail if the Login name is not also in 
the P Squared Directory.
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If you tick the ‘Automatically Create Users’ option on the General tab of 
Directory Settings then Myriad will also create a User contact for the Windows 
login name and password.

Other Licensed Computers > Number Of Computers Allowed

This is a very strange setting to find in Myriad as it does not relate directly to 
Myriad in the slightest but rather to the stand alone P Squared Directory 
Manager application which enabled standard PC’s to access the P Squared 
Directory without any other P Squared products being installed.

The stand alone Directory Manager licenses can be purchased for a low cost 
from sales@psquared.net. Each PC that has the Directory Manager installed 
needs a separate license but the licensing model used for the Directory 
Manager is much simpler than the model used for Myriad. This means that if 
you purchased 10 Directory Manager licenses (they are £30 each at time of 
writing) then you would have a single license code that actually allowed up to 
10 PC’s on your network to ‘hold’ a Directory Manager license at any one 
time. 

The license code issued by P Squared can be entered in this section, you can 
also assign one of the licenses to the PC you are working on (but you would 
not need to as the Myriad Manager offers the same functionality and you  
already have that licensed!).

The Other Licensed Computers panel shows a summary of the amount of 
stand alone Directory Manager licenses you have and how many have been 
assigned. You can enter, or update your Directory Manager license code by 
clicking on the Change button.

mailto:sales@psquared.net
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This opens the Computer Licenses window. To alter the License Name or 
License Code, click on the Change button and type in the relevant details.

Once you are happy, click on the Set button.

The Lower section of the window shows a list of PC’s that the Directory 
Manager licenses are currently allocated to.
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The buttons to the right of this list allow you to manage your license 
allocations.

 Edit PC Name Details – Allows you to alter the PC name that the 
license is allocated to. Make sure you type in a valid PC network name.

 Remove License Allocation – This removes the highlighted allocation 
freeing the license to be used by another computer.

 Update List – This option updates the list based on the latest network 
information.

When you are happy, click on the Ok button to save the changes and close 
the window.

The Security Tab

The Security tab shows a list of all the available Security User Groups with the 
currently selected P Squared Directory and allows you to add new Security 
User Groups, edit the existing groups and delete groups entirely.
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The buttons down the right hand side of the window allow you to add, edit and 
remove Security User Groups. These options are examined in more detail 
below.

Adding A New Security User Group

To add a new Security User Group, click on the Add Group button.

Myriad will then add a Security User Group to the list with a default title, type 
in your preferred User Group title and press the <Enter> key on your 
keyboard.
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Your new Security User Group is added to the system.

Important Note: Please note that the top User Security Group in this list is 
the default User Security Group for all new Users added to the system so this 
Security Group should only include the minimum security permissions that 
you want Users to have. That way, if you create a new User but forget to 
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assign a Security User Group, they will only have minimal access rights on 
your system.

Renaming A Security User Group

To rename an existing Security User Group, highlight the group that you want 
to rename and then click on the Rename Group button.

You can then type in a new title for your Security Group.

When you are happy, press the <Enter> key on your keyboard.

Edit Security User Group Settings
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Clicking on this button will open the Security User Group Permission window 
which is used to assign security permissions for individual Users or Security 
User Groups.

This important window is covered in detail in the Security Permission Settings 
section of this Chapter.

Delete Security User Group

This option is used to delete the highlighted Security User Group from the 
system. When you click on this option, you will be asked to confirm that really 
do want to delete the User Group.

If you click on Yes then the Security User Group will be deleted but this can 
only happen if there are no Users within the Security Group. If there are one 
or more Users still within the Security User Group the Myriad will not allow the 
Group to be deleted.
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Use Myriad Manager to move all Users from the User Group that you wish to 
delete and then try again.

The Backup Tab

The Backup tab allows you to configure the regularity with which Myriad takes 
backup copies of the P Squared Directory database in case of emergency or 
accidental deletion.

To enable Myriad’s automatic backup of Directory databases, tick the 
‘Automatically backup the Directory database periodically option at the top of 
the tab.

Caution: Think carefully before disabling this option. Myriad will automatically 
create backup files and automatically delete older backup files to the whole 
process is maintenance free so there is little point disabling this useful feature!
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How Often Should These Backups Be Created

This section of the window allows you to set the regularity with which Myriad 
backs up your Directory database. The options are:

 Backups Should Be Created Once A Hour – Myriad will take a copy 
each hour of the day. This is the safest options but generates a lot of 
backup files. You probably do not need to use this option unless you 
add and remove a lot of Users each day.

 Backups Should Be Created Once A Day (Recommended) – Myriad 
will take a backup copy once a day. This is the recommended option as 
it keeps your database safe but does not generate too many backup 
files.

Delete Backups After X Days

This section allows you to set the amount of days after which Myriad will 
automatically delete older backup files. This means that if you set this to 7 
days (for example), Myriad would keep a rolling 7 days of backup files.

You can set this to 0 (zero) then Myriad will not automatically delete any 
backups that it creates.

Security Permissions Settings (User or User Group)

The Security Permissions Settings window is used to set specific Myriad 
related security permissions for an individual User or members of a User 
Security Group.

To change the Security Permissions for an individual User, you will need to 
access this window through the Contacts section of Myriad Manager but if you 
wish to edit the Security Permissions for a Security Group then you can to that 
via the Edit Group button on the Security tab of Directory Settings.
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The Security Permissions window is used to set Security Permissions for 
Myriad but it is also used for setting permissions for other Directory enabled P 
Squared products such as Scoop and Powerlog. If you have other P Squared 
products installed on your PC then you may well have more than just Myriad 
related options in this window but as we are mainly concerned with Myriad 
right now, we will stick with the Myriad based options.

The left hand side of the window shows a list of the P Squared products that 
are available to be configured. You will notice that as well as Myriad, the 
Audio Wall and Directory are listed separately. This is because both the Audio 
Wall and the P Squared Directory are shared by several P Squared products 
and so the settings need to be configured separately from Myriad. To select 
the application (or element) you want to configure permissions for, simple 
click on if on the left hand list. The Security Permissions options are displayed 
on the right hand side of the window.
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Audio Wall > Read Cart Ranges

To view this option, make sure that the Audio Wall is selected in the left hand 
list.

This section allows you to add one or more ranges of Cart Slot Numbers that 
the User or members of a User Group is allowed to view and play on the 
Audio Wall. 

To add in a new range, click on the ‘+’ button and then add the start and end 
Carts for the range you wish to add.

You can edit the details of a Cart Range previously added by highlighting it 

and then clicking on the Edit Range button .

To remove a Cart Range, highlight the Cart Range and click on the ‘X’ button.

Caution: You will not be asked to confirm so be careful!
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Audio Wall > Write Cart Ranges

This section allows you to add one or more ranges of Cart Slot Numbers that 
the User or members of a User Group is allowed to record in to or edit.

To add in a new range, click on the ‘+’ button and then add the start and end 
Carts for the range you wish to add.

You can edit the details of a Cart Range previously added by highlighting it 

and then clicking on the Edit Range button .

To remove a Cart Range, highlight the Cart Range and click on the ‘X’ button.

Caution: You will not be asked to confirm so be careful!

Audio Wall > Can Add / Edit / Delete Shared Instant Cart Sets

If this option is ticked, the User or members of a User Group are allowed to 
add, edit or delete shared Instant Cart Sets from the Instant Carts Screen.

Directory > Can Have Personal Contacts
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The User or members of a User Group are allowed to have personal Instant 
Carts on the Instant Carts Screen in Myriad.

Directory > Can Add / Edit / Delete Contacts

The User or members of a User Group are allowed to add, edit or delete 
contacts in the P Squared Directory.

Directory > Can Add / Edit / Delete Users

The User or members of a User Group are allowed to add, edit or delete 
Users in the P Squared Directory.

Directory > Can Add / Edit / Delete Contact Categories

The User or members of a User Group are allowed to add, edit or delete 
Contact Categories in the P Squared Directory.

Directory > Can Have Personal Websites

The User or members of a User Group are allowed to add personal websites 
to the website lists in Myriad Manager.

Directory > Can Add / Delete Websites

The User or members of a User Group are allowed to add or delete websites 
from the shared websites section of Myriad Manager.
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Directory > Can Add / Edit / Delete Websites

The User or members of a User Group are allowed to add, edit or delete 
websites categories from the shared websites section of Myriad Manager.

Directory > Can Edit P Squared Directory Settings

The User or members of a User Group are allowed to edit settings in the 
Directory Settings window.

Directory > Can View P Squared Directory History

The User or members of a User Group are allowed to view P Squared 
Directory History which is a history of Users movements and actions in 
Myriad.

Myriad v3 > Can Edit The Main Myriad Settings

This option allows a User or member of the User Security Group to access the 
Myriad Settings option on the Settings menu.

Myriad v3 > Can Edit The Information Views
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This option allows a User or member of the User Security Group to edit the 
options that appear in the View Menu. These are edited using the View Menu 
tab on the Myriad Settings window.

Myriad v3 > Can Edit The Station Database Settings

This option allows a User or member of the User Security Group to access the 
Station Database Settings option on the Settings menu.

Myriad v3 > Can Choose Between Different Station Databases

This option allows a User or member of the User Security Group to switch 
between Station Databases using the options on the File menu in Myriad.

Myriad v3 > Can Edit The Schedule Log

This option allows a User or member of the User Security Group to edit the 
Schedule Log on the Log Screen in Myriad. If this option is not ticked then the 
User can not add or remove Log Items or move Log Items around within the 
Schedule Log.

Myriad v3 > Can Remotely Edit The Schedule Log

This option allows a User or member of the User Security Group to remotely 
edit the Schedule Log and record Remote Voice Tracks using the P Squared 
Remote Voice Tracking system.

Please note that not all Myriad systems include the capabilities for this option.

Myriad v3 > Can Import / Export Sections Of The Schedule Log

This option allows a User or member of the User Security Group to import or 
export sections from the Schedule Log on the Log Screen in Myriad.

Please note that not all Myriad systems include the capabilities for this option. 
The Schedule Log Import / Export utility is part of the Advanced Tools Pack.

Myriad v3 > Can Edit The ‘On-Air’ Hour From A Different Database

This option allows a User or member of the User Security Group to override 
the Myriad Setting that prevents a non ‘on-air’ workstation from editing the 
currently playing hour in the Schedule Log. It is recommended that this option 
is used for Programme Controllers that want to retain the ability to edit the ‘on-
air’ Schedule Log from any Myriad workstation.
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Myriad Settings

The Myriad Settings option on the Setting Menu offers access to the Myriad 
Setting window which offers a range of general options related to all aspects 
of configuring and using Myriad.

The Myriad Settings window is arranged in a number of tabs each of which 
contains settings that relate to a specific area of Myriad. In brief, the tabs 
options are: 

 Data Locations – Allows you to set the key base location for data 
stored by Myriad.

 General Options – Includes a diverse mix of Myriad settings that 
covers a wide range of aspects.

 Audio Wall – Includes general Audio Wall related settings.
 Station Database Settings – Allows you to configure how Myriad 

selected the Station Database that should be used as well as option 
Station Database related options.

 View Menu- Allows you to configure the options on the View Menu.
 On Air Control – Allows you to select the type of on-air control that 

you wish Myriad to use.
 Other Settings – Includes options for workstation network ID’s and 

also the configuration and management of Commands Log Items 
available on the Log Screen in Myriad.
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 Advanced – Covers a number of more advanced Myriad related 
options that should not be altered under general conditions.

We will now look at the options on these tabs in a bit more detail.

The Data Locations Tab

The Data Locations tab performs one role and one role only, but it a very 
important role hence it having it’s own tab.

The only option on the Data Locations tab is the Path option which is used to 
set the base data location for all of the data files and databases that Myriad 
uses in general operation.

To set the Path for the Myriad Data Location, either type in the path in to the 
provided field or click on the Change button to browse for the location of your 
new Data Location folder.
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If you click on the Change button, you will first be warned that changes made 
will not take effect until you restart Myriad.

You can then use the Browse For Folder window to select the ;folder you wish 
to use.

Please note that the Data Locations tab also displays the sub folders used to 
store various database or information types in Myriad.
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This is for information only, you can not alter anything but the base Data 
Location, Myriad will automatically create all of the sub folders that it needs.

The General Options Tab

The General Options tab is used to set a range of general options for Myriad 
that do not necessarily refer to specific areas of Myriad.
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To set an option in the General Options tab, click on it to ‘tick’ the box.

Myriad Startup Options > Attempt To Login In To The Directory With The 
Windows Login Name

If this option is ticked, each time Myriad is loaded, it will attempt to 
automatically login to Myriad using Windows™ Login Username and 
Password. If the Windows Login details match that of a User in the P Squared 
Directory Database then they will automatically be logged in to Myriad.

This setting is very closely related to the Automatically Create Users When 
They First Use Directory Enabled Software option on the General Tab of 
Directory Settings which will automatically create a User in the Directory if the 
Windows Login Username is not found.

Login / User Options > If The Log Is Running, Only Allow Myriad To Be 
Closed If A User Is Logged In

The caption for this setting says it all really. Basically, if Myriad is in any of the 
Active Playout modes and this option is set then Myriad can only be shut 
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down when a User is logged in to the system. This prevents the system being 
shut down ‘accidentally’ without realising that it is in Active Playout Mode.

Login / User Options > Let Users Customise Myriad For Their Login 
Name

When this option is ticked, the Customise Myriad option becomes available for 
all Users. This allows them to customise certain aspects of Myriad such as the 
size of Carts on the Audio Wall and the way in which Myriad fades Carts when
ejecting.

If this option is turned off, Users will not have access to the Customise Myriad 
options. 

This option is set by default.

Login / User Options > Allows Users To Login Using Physical Security 
Keys

When this option is set, Myriad will allow Users to log in and out of Myriad by 
inserting or removing a specially set up USB Security Key. 

A Security Key is just a standard USB hard disk (sometimes called a pen or 
key-ring drive) that has special encrypted security information on it that allows 
it to be used to log in to Myriad. These Security Keys are created using the 
Contacts / Users tab in Myriad Manager (see Myriad Manager documentation 
for more details).

Once this option is enabled, a User can log in to Myriad by plugging in a 
Security Key in to the PC’s USB connector. They can also log out by 
unplugging the Security Key.

This option is not set by default.

Audio Wall Options > Start Carts Playing With Only A Single Left Mouse 
Click (i.e. a touch screen)

When this option is ticked, Carts on the Audio Wall will automatically played 
with a single click from the left mouse button.

The primary use for this feature is when you are running Myriad on a touch 
screen enabled system. Typically, a touch screen emulates a mouse  so 
simply tapping a Cart on the Audio Wall would automatically start playback of 
that Cart with this option set.

You can use this option with a mouse if you prefer.
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This option is not set by default.

Display Options > Display In Dual Screen Mode Even When Only On A 
Single Screen

This option is designed for use with high resolution monitors (1280x1024 for 
example) or wide screen monitors (1280x800 or higher) and is used to make 
Myriad display both the Audio Wall (or Database / Instant Carts) and the Log 
Screen at the same time, just like in a dual screen configuration, but on a 
single screen.

The screen shot above shows Myriad running in this mode on a wide screen 
monitor.

This option is ideal for a show preparation workstation where dragging Carts 
from the Audio Wall in to the Schedule Log is desirable but a dual screen 
system may be impractical.

Segue Editor Options > In Mini Mode, Warn The User Before Playing 
Carts

When this option is set, If a User clicks on the Play button on the Mini Segue 
Editor to review a segue, Myriad will reserve the Cart Players that it intends to 
use and then warn the User that it is about to start playback by way of a 
message box.
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In this situation, clicking on Ok will start playback in the reserved Cart Players. 
Clicking Cancel will abandon the review process.

This option should always be set on any ‘on-air’ workstations to prevent 
accidental playback in a ‘live’ situation.

Other Options > Enable Limited Myriad v2 Keyboard Shortcuts

Due to the many improvements and new features added to Myriad v3, some 
of the keyboard shortcuts used in Myriad v2 had to be changed in order 
accommodate the new options. This unfortunately means that any station that 
upgrades from Myriad v2 to Myriad v3 and has a special Myriad Keyboard 
(K500, K1000 or K2000) will also have to re-program the keyboard to use the 
new Myriad v3 keyboard shortcuts (see Myriad Keyboard Shortcuts section).

The alternative is to enable this option which configures Myriad to use as 
many as possible of the old Myriad v2 shortcuts. Unfortunately, support is 
limited as not all options can be accommodated. 

It is recommended that this option is only used as a short term solution and 
that Myriad v2 keyboards are re-programmed as soon as possible. The 
software needed to re-program the keyboards should have been included with 
your keyboard originally. If not then P Squared should be able to provide you 
with a copy of the software. P Squared can also provide the necessary 
configuration information to allow you to re-program the keyboard. If you do 
not fancy messing around with your keyboard, for a small charge, P Squared 
can re-program your keyboard for you.

The Audio Wall Tab

The Audio Wall tab contains general Audio Wall related options. These 
include the settings that allow you to configure Myriad to visually mark Carts 
that have been played ‘recently’ and also how often Myriad should check for 
changes made to the Audio Wall by other workstations on your system.
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Display An Icon On Carts That Have Been Played Recently

This is an extremely useful option, particularly for stations that use the Audio 
Wall to present ‘live’ shows because if the Schedule Log is not used then a 
presenter would not know what the previous presenter had played.

This option gets around the problem by automatically marking Carts that have 
been played ‘recently’ with a special icon on the Audio Wall.

To enable this feature, tick the ‘Display An Icon On Carts’ option with enables 
the settings section to allow you to configure the amount of time that the 
Recently Played Icon appears on the Carts.



378

You have two options when determining how long a Cart on the Audio Wall 
should be marked as being Recently Played.

 For XX:XX:XX (hh:mm:ss) – If this option is selected, you simply set 
the duration in hours, minutes and seconds that you want the Carts to 
be marked for. This duration will then apply to all Carts on the Audio 
Wall.

 Until It Could Have Been Played All The Way Through XX Times –
This option allows you to set the ‘recently played’ duration in terms of a 
multiple of the overall length of the Cart. This is useful because it 
means the time that Carts are marked as recently played will be longer 
on Carts with a longer overall length. Why? Well let’s say that you set 
this to be 30 then a 10 second Cart (like a jingle) would be marked as 
recently played for 5 minutes (10 seconds x 30) where as a 3 minutes 
Cart (like a song) would be marked for 90 minutes.

You can select the method that will suit your station the best. If you are not 
interested in knowing when Carts have been played in the past then this 
option can be disabled altogether by un-ticking the overall option.

Other Settings > Refresh The Audio Wall Every XX Seconds

This settings allows you to set the frequency with which Myriad will rescan the 
Audio Wall and update with any changes or new Carts added by other 
workstations on the network.

The default for this setting is 20 seconds. If you set this too high then Myriad 
will spend all its time checking for changes to the Audio Wall. Set it too low
and you may have to wait for changes made on other workstations to take 
effect.
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Please note that this setting only really applies when you are looking at one 
single ‘page’ on the Audio Wall without touching it as the act of moving around 
on the Audio Wall forces Myriad to check for changes anyway.

The Station Database Tab

This tab contains general Myriad settings that relate to the Station Database 
being used by Myriad but not specifically the settings in the Station Database 
(that is handled by the Station Database Settings menu option).

You can also set whether you want Users to be able to edit the currently 
playing hour in the Schedule Log on any workstation other than the On-Air 
workstation.

The options on the Station Database tab are examined below.

Do Not Open A Station Database When Loading

When this option is selected, Myriad will not open a Station Database when it 
first loads. Instead, the Log Screen just contains a button to allow you to 
select a Station Database to open.



380

Click on the Open Database button to access the Choose Database window.

Highlight the database that you want to open and then click on OK.

Ask For Which Database To Open When Loading Myriad

If you select this option then each time that Myriad loads, it will automatically 
display the Choose Database window to allow you to select the Station 
Database that you want to use.

Again, just highlight the Station Database you want to open and click on OK.
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Always Open This Station Database At Startup

This option allows you to set a Station Database to be loaded each time 
Myriad loads. To select the Station Database that you Myriad load, click on 
the Change button and use the Choose Database window to highlight the 
Station Database you want and then click on OK.

The Station Database that will be loaded at startup is displayed on screen.

Please note that the Choose Database window can also be used to add new 
Station Database, copy and rename existing Station Databases and also 
delete Station databases. For more details, please refer to ‘Adding, Copying & 
Deleting Station Databases Using The Choose Database Right Click Menu’ in 
the File Menu section of this Chapter.
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Log-Editing Options > Only Allow The Current Hour To Be Edited If On 
Air

This option allows you to configure Myriad to only allow the workstation that 
has On-Air (Station) control to be able to edit the ‘current’ hour in the 
Schedule Log. All other workstations would be blocked from making changes 
to the Schedule Log between the currently playing Log Item and the Hour 
Start Marker for the next full hour in the Schedule Log. 

This options can be over-ridden on a per User bases (see Settings Menu > P 
Squared Directory Settings > Security Tab Myriad v3 > Can Edit The ‘On-Air’ 
Hour From A Different Database for more details).

If this option is not set then any workstation can edit the current hour in the 
Schedule Log.

Play Logs > Create Advert Reconciliation Logs When On Air

This setting is used in conjunction with 3rd party advert scheduling systems
such as Broadnet™ and is used to set Myriad to automatically create special 
reconciliation log files whenever the workstation has On-Air (Station) control.

These log files can then be imported back in to the advert scheduling system 
to provide ‘full loop reconciliation. For more details, please consult a P 
Squared technical support engineer or email support@psquared.net.

The View Menu Tab

The View Menu tab is used to add customisable content to the View Menu on 
the main menu system (see The View Menu earlier in this Chapter).

mailto:support@psquared.net
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This basically allows you to add links to HTML pages (either local or web 
based) to the View Menu so that Users can access the information directly 
from the View Menu. 

View Menu Options > Source

This drop down allows you to select whether to use a local View Menu 
configuration or a shared View Menu configuration.

The options are:
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 Store A Local List Of Views On This Computer – The View Menu is 
configured locally and is unique to the workstation you are working on.

 Use A Shared List Of Views Stored In The Main Data Location –
Use a shared View Menu configuration which is stored in the main 
Myriad Data Location (see Data Location tab in this section).

View Menu Options > Views (Customisable View Menu Content)

The Views section allows you to add, edit or remove the customisable content 
from the View Menu as discussed in the View Menu section earlier in this 
Chapter. The diagram below shows the layout of the View Menu tab and the 
role of the buttons available on the tab.

Here we can see that some options on the View menu have already been 
configured in this window. Each option on the View menu corresponds to an 
entry in this table with the Name column being used for the Name on the view 
menu and the Location column being used for the location of a local or web 
based HTML page that the View menu option will open when selected. You 
may also note that the Separator Line entry between the ’What’s On Guide’ 
and the ‘P Squared Website’ causes the line between the options on the View 
menu.
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Let’s say for example that we want to add another option on the View menu 
that links to a ‘weather’ HTML page stored on the local computer and we also 
want to add a separator line between the P Squared Web Site option and the 
new Weather option.

First click on the Add Option button and tick the Separator Line option to add 
the separator line to the list.

Next click on the Add Option button again and this time type in the Name and 
Location of the Weather option we wish to add.
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Note that is the HTML file you are linking to is a local or network file then you 
can click on the Select button to browse your local drives and network 
connections. Click on OK once you are done.

Our View Menu settings window now looks like this with the new Weather 
option added to the bottom of the list.
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Click on OK to save the changes. We can now see the end results on the 
View menu.
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And if we click on the Local Weather menu option, voila!
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The On-Air Control Tab

There has been a lot of talk about On-Air (or Station) Control throughout this 
manual. On-Air control changes the way in which the Log Screen works and is 
used by Myriad Manager when compiling copyright reports but what do we 
mean by On-Air control and why is it needed?

What Is On-Air Control And Why Is It Needed?

In most stations, you may have several Myriad workstations but at any one 
time, only one of them can be playing out content that is actually be broadcast 
‘on-air’. Traditionally, you would designate a studio or resource as being ‘on-
air’ and the output from that studio would be what your station was 
broadcasting. Depending on the station setup, there may actually be more 
than one studio and ‘on-air’ control is switched between studios as 
circumstances dictate. 

The situation is very similar in Myriad. You may have several Myriad 
workstations but if only one is broadcasting On-Air at a time then we need a 
way of telling which one it is. The reasons that we need to know which 
workstation is On-Air are outlined below:

 Accurate Reporting – Myriad tracks all Carts that are playing 
regardless of ON-Air status but sometimes we are only interested in 
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the workstation that is On-Air. Copyright reports are a good example. 
When generating reports for the copyright agencies, you usually only 
want to include Carts that were broadcast as you usually have to pay 
for there use. By using On-Air control in Myriad, the generated reports 
can automatically include Carts that were broadcast On-Air only, even 
if you switched studios several times during the reporting period.

 Security – Myriad can be configured so that the only workstation that 
can perform certain tasks is the On-Air workstation. The most obvious 
of these is the ability to limit editing the current hour of the Schedule 
Log to only the On-Air workstation.

 Communication With External Software Applications Such As 
OCP and Myriad STS – If you are using OCP to update a web site or 
DAB broadcast with information about what is being played ‘On-Air’ 
then you need a mechanism to be able to tell OCP which workstation it 
should be ‘listening’ to. The same is true when you are using Myriad 
STS to deliver split broadcasting to different regions or transmission 
methods.

So we can see that On-Air control is important but how does it work?

There are three different levels of On-Air control available in Myriad, they are:

 Fixed On-Air Control – The Workstation is set to always have On-Air 
Control or never have On-Air control. If using this method, you should 
set only one workstation to always have On-Air control and then set all 
other workstations to never have control. If you always use the same 
workstation for broadcasting then this method is good because it 
removes the need to have On-Air control options visible on the Log 
Screen.

 Simple On-Air Control – This is the recommended method if you are 
not using OCP or STS. The simple On-Air Control method is a 
simplified model that works on the fact that only one workstation has 
On-Air Control at any one time. If one workstation has On-Air control 
then all the others are Off-Air. You can configure simple On-Air control 
to only allow another workstation to take control when it is released by 
the current On-Air PC.

 Advanced On-Air Control – This is the most advanced option and
must be used if you want Myriad to work with OCP or STS. In 
Advanced mode, Myriad workstations communicate with each other 
and other external programs (such as OCP and STS) to ‘discuss’ On-
Air control.

We will now see how the options on the On-Air Control tab are used to 
configure one of these three options.

This Computer Will Never Be On-Air

If you set this option then the workstation you are working on will be set to 
never take On-Air control. This means that the On-Air / Off-Air button will be 
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disabled on the Log Screen and the PC will be configured as if it were in Off-
Air mode.

This option should be used for Admin workstation and any other workstation 
that is not going to be needed for On-Air use.

Always Assume That This Computer Is On-Air

If you select this option then the workstation you are working on will be 
assumed to always have On-Air control. The On-Air / Off-Air button will be 
removed from the Log Screen and the system will be configured for On-Air 
mode.

Caution: You should only use this option for one PC in your Myriad network.

Use Simple On-Air Control

Ticking this option will enable Simple On Air control in Myriad which is a 
simplified On-Air control method which only allows one workstation to have 
On-Air control. The On-Air / Off-Air button will appear on all workstations that 
have this option set and this button can be used to select On-Air control for 
the workstation in question (see Chapter 5 > On-Air / Off-Air Control Button for 
more details).

Ticking this option also enables the Simple On-Air Control options which are 
outlined below:

Lock On-Air Control So That It Can Not Be Taken Without This One 
Releasing It First

If this option is set, when the workstation you are working on has On-Air 
control and another workstation requests it. It will not be transferred unless 
you manually release On-Air control (by clicking on the On-Air / Off Air 
button). If this option is not ticked then On-Air control can be transferred to 
another PC without you releasing it first.

Take Control When Starting The Schedule Log 

If this option is ticked then On-Air control will automatically be taken (or 
attempted to be taken) by the workstation whenever an Active Playout mode 
(Live, Auto or AutoFade) is activated.
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Use Advanced On-Air Control

Selecting this option will enable Advanced On-Air control which must be used 
whenever you want Myriad to communicate with external software 
applications such as OCP and Myriad STS.

Selecting this option will enable the options for Advanced On-Air which are
outlined below.

When This Computer Has Control And Another Requests Control

The ‘When This Computer Has Control And Another Request Control’ option 
is used to determine what to do in Advanced On-Air control when another 
workstation requests On-Air control. The drop down list is used to select the 
action that you want Myriad to take.
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The options are:

 Release Control Immediately – With this option selected, Myriad will 
automatically hand over On-Air control to any PC requesting it. This 
option should be used for automated ‘playout’ PC’s that may need to 
hand control to a live studio workstation.

 Never Release Control – If this option is set, Myriad will never 
automatically release On-Air control. You will have to manually release 
control (by clicking on the On-Air / Off-Air button on the Log Screen) n 
order for another workstation to take control.

When The Computer Needs Control This Computer Should

This computer allows you to configure how Myriad acts when you request On-
air control (either automatically or by clicking on the On-Air / Off Air control 
button). The options are available on the drop down list.
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The options are:

 Only Request Control When Told To By The User – With this option 
set, Myriad will only attempt to gain control when told to by the User 
(but them clicking on the On-Air / Off-Air button on the Log screen or 
using the On-Air menu option). If this option is selected, when the On-
Air / Off-Air button is clicked (on the Log Screen), Myriad will request 
On-Air control from the workstation that has it. Whether you get On-Air 
control will depend how the other workstation is configured (see above 
options).

 Constantly Request Control Silently – When this option is selected, 
the workstation will constantly request On-Air control but it will do so 
‘silently’ which means that whilst it request control every few seconds, 
the workstation that has control does not tell the User. When running in 
this mode, the workstation will take On-Air control as soon as it is 
released by the other workstations. This option is well suited to 
workstations that are used for automated playout as a ‘sustaining’ 
service. This setting is usually coupled with the Release Immediately 
option outlined above.

 Attempt To Gain Control Anyway – This option should be used with 
caution. When selected, if the User clicks on the On-Air / Off Air control 
button to take On-Air control, the Myriad workstation will take On-Air 
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control regardless of what the current On-Air workstation is set to do 
upon a request.

Take Control When Starting The Schedule Log

If this option is ticked then On-Air control will automatically be taken (or 
attempted to be taken) by the workstation whenever an Active Playout mode 
(Live, Auto or AutoFade) is activated.

The Other Settings Tab

The Other Settings tab is primarily used for two things in Myriad Settings, 
firstly it allows you to assign workstations in your Myriad network with usable 
names to make them more identifiable. The second major section of the Other 
Settings tab is concerned with Commands but we will get to them in a minute.

Computer Details
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The Computer Details section allows you to add workstation details for all of 
the PC’s on your Myriad network. You can then assign a network ID number 
to each workstation.

The reason for doing this is that when you are working with Myriad Manager 
and you wish to generate play logs or copyright reports, it is useful to be able 
to filter the results to include just the workstations that you are interested in. 
By giving each workstation a human readable name, you make this selection 
process a lot simpler.

Add Computer Name

To add a computer name to this list, click on the Add Computer button. You 
will first see a warning message warning you that the changes you have made 
will be applied to the central computer list and asking you whether you wish to 
continue. Click on Yes to continue.
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A ‘New Computer’ entry will then be added to the list of computer names.

Next we need to edit the details.

Edit Computer Name Details

You can access the Computer Name Details window by either highlighting the 
Computer Name you wish to work with, and clicking on the Edit Computer 
Name button, or you can simply double click on the Computer Name in the 
list.
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You can then add a Name for your computer along with the Network Name (if 
known). Click on Ok to save the details.

Assigning A Computer Name To The Workstation You Are Working On

This is done by placing a tick in the box to the left of the Computer Name you 
wish to assign.
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Please note that each workstation can only be assigned to one Computer 
Name.

Deleting A Computer Name

To delete a Computer Name from the list, highlight it in the list and then click 
on the Delete Computer Name button (see diagram above for button map).

You will then be warned that the action you are taking will effect the central 
computer list, and asked if you wish to continue.

If you wish to delete the Computer Name, click on Yes and it will be removed 
from the list.

Command Information

The Command Information section of the Other Settings tab is used to view 
and manage the Commands that are available within Myriad. Commands are 
a special type of Log Item that can perform range of tasks. This section allows 
you to add and delete Commands from Myriad as well as edit the details on 
existing Commands.

Types Of Commands

There are four main types of Commands, which are:
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 External – Used to run an external window program or application. 
When Myriad encounters an External Command in the Schedule Log, it 
runs the external application detailed in the command then moves on 
to the next Log Item in the Schedule Log.

 Myriad Command – Allows you to add a Command Log Item that 
performs one or more tasks in Myriad. The Myriad Command section 
allows you to construct a special script that can be used to perform a 
variety of tasks (more on this in the New Command section).

 TCP/IP – This Command will send a specific message to a specified IP 
address. When Myriad encounters one of these in the Log, it will send 
the specified message to the desired TCP/IP address and then move 
on to the next Log Item.

 Serial (RS232) – This works in the same way as a TCP/IP message. 
When encountered in the Schedule Log, Myriad will send the specified 
message to the selected serial port.

Commands are designed to be general purpose, problem solving additions to 
the standard Myriad Log Items. 

Add A Command

To add a new Command to the list (and therefore make it available in Myriad), 
click on the Add Command button to open the Command Details window.

At this stage you have to select the type of Command that you wish to add to 
Myriad using the Type drop down list. The main details screen changes for 
each Type of command you can add so we will tackle each one separately.
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Adding An External Command

An External Command allows you to run an external Windows™ application 
from within the Log Screen in Myriad.

To add an External Command, follow these steps.

1. Give your Command a unique name by typing in to the Command 
Name Field.

2. Make sure that External is selected from the Type drop down list.
3. Use the Window Style drop down list to select the way in which you 

want Myriad to run the external application. The options are:

 Normal With Focus – Application opens in normal window with 
mouse focus.

 Normal Without Focus – Application opens in a normal window 
but Myriad retains mouse focus.

 Maximised With Focus – Application opens maximised (full 
screen) with mouse focus.
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 Minimised With Focus – Application opens minimised but does 
have mouse focus.

 Minimised Without Focus – Application opens minimised and 
Myriad retains mouse focus.

4. Command – Type in the location of the application program (.exe) that 
you want Myriad to run when the Command is evoked. Remember that 
you can include ‘command line switches’ in this Command field should 
you wish to.

Click on Ok to save the Command Details and add the Command to 
the Commands List.

Adding A Myriad Command

A Myriad Command is a specially scripted sequence of events that will 
happen when Myriad executes the Myriad Command. This is done by using a 
simple ‘script’ style language that gives a list of instructions for Myriad to 
complete before moving on to the next Item in the Schedule Log.



403

To add a Myriad Command, follow these steps:

1. Type in a name for your Myriad Command using the Command Name 
field.

2. Make sure that the Myriad Command option is selected using the Type 
drop down list.

3. Type in the Myriad Command sequence in to the Command box paying 
close attention to the syntax as described in the Myriad Command 
Script reference outlined below.

4. When you are happy, click on OK to save your Myriad Command and 
add it to the list.

Myriad Command Script Reference

As detailed above, the Myriad Command is a series of instructions for Myriad 
to carry out as part of the Command Log Item. When creating the Myriad 
Commands, it is important that the syntax of the script language used is exact 
as Myriad will only follow correctly formatted scripts.

The reference guide below details the script commands that are available for 
use in Myriad v3. Myriad Commands are intended to be used by advanced 
users only. Beyond this reference, the Myriad Command script language falls 
outside the scope of this documentation.

Note: Parameters shown surrounded by square brackets - [] are optional

MyriadCommand Reference:

Command | Usage
COMMAND | Run another MyriadCommand sequence

| Example: COMMAND PlayNewsCart
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CART/ | Used to Play, Pause, Cue/Recue, Close/Eject a cart or a 
player

HARDDISK/ | Commands:
HDITEM | PLAY Player[,Reference][,Sync] - Sync is used to wait 
until the cart has finished playing.

| CUE Player[,Reference]
| RECUE Player[,Reference]
| PAUSE Player
| CLOSE Player
| EJECT Player
| Example: PLAY 1,3001,1
|(This will play cart 3001 in player 1 and wait until it 

finishes

INSTANTCART | Used to Play or Cue a specified Instant Cart
| Commands:

            | PLAY Reference[,Sync]
| CUE Reference

            | Example:INSTANTCART PLAY 2,1
| (This will play Instant Cart 2 and wait until it 

finishes

DEBUG/ | Used to change the debugging mode used when diagnosing 
problems.

DEBUGMODE/ | Commands:
  OFF/NONE/0 Turn off debugging
  MEDIUM/5 Medium debugging
  ON/HIGH/MAX/10 Full debugging

HARDWARE | Used to Set/Clear/Flash/Pulse a hardware line 
| Example: HARDWARE Pulse 12
| (This will cause line 12 to pulse)

LOG | Used to change the Log mode or move around in the log
QNXT | Commands:

  GO Move on to the next item in the Log
  PRECUE Precues the next log item ready to play
  TOGGLEENDING  Changes the ending of the currently 

playing item

  ITEM Changes to the currently highlighted Item
  PREVIEW Previews the highlighted item 
  TOGGLEDELETE Deletes/Restores the highlighted item
  TOGGLEENDING Toggles the ending of the highlighted item

  VIEW Changes the Log View
  HOME Jump to 'now'
  NEXTHOUR Scroll up to nearest hour start
  PREVHOUR Scroll down to next hour start
  PAGEUP Scroll up one page
  PAGEDOWN Scroll down one page
  SCROLLUP Scroll up one line
  SCROLLDOWN Scroll down one line

  MODE Change QAE's running mode
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  HOURMODE Change to the original play mode for the 
current hour

AUTOFADE Change to AutoFade mode
AUTO/AUTOMATION Change to Auto Mode
LIVE/LIVEASSIST Change to LiveAssist Mode
STANDBY Stop the Log Running

TOGGLE Toggles the mode between Standby and 
the Hour's original mode

ONAIR | Used to Take/Release 'On-air Control'
| Commands:
TAKE/REQUEST Request/Take On-Air control
RELEASE Release On-Air control
MESSAGE Advanced: Sends a formatted network 

message to the On-Air device being Controlled

WAIT | Waits for a number of seconds
| Example: WAIT 5
|(this will wait for 5.5 seconds)

WEB | Opens the Quick web browser and displays a specified 
file or webpage

WEBBROWSER | Parameters: URL,Caption

WEBVIEW | Commands:
| VIEW Display the given URL
| Example: WEB VIEW http://www.psquared.net,P Squared's 

Website

If you can not really work out what this is all about, don’t worry, you will not be 
alone. If you are really stuck then why not email support@psquared.net if you 
need some additional helpful advice.

Adding A Serial Command

A Serial Command is used to send a specific sequence of numbers and 
characters to the computers serial (RS232) port in a specific format. This may 
be controlling external devices or sending commands to remote computer 
systems.

mailto:support@psquared.net
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In order to understand these settings, you will need a fairly good 
understanding of RS232 (serial) communication as the meaning of the various 
protocols used falls outside of the scope of this documentation.

To add a Serial Command, follow these steps:

1. Give your Serial Command a name using the Command Name field.
2. Make sure Serial is selected using the Type drop down.
3. Select the Serial Port that you want using the Serial Port drop down 

list.
4. Check that the Settings are correct. The format for this settings string 

is: baudrate,parity,databits,stopbit so 9600,n,8,1 means 9600 baudrate, 
no parity, 8 data bits, and 1 stop bit. All you really have to do is match 
these settings to the equipment you are sending the Serial Command 
to.

5. Use the Handshaking drop down list to select the handshaking type 
you wish to use. Again, this will depend on what you are connecting to.

6. Type in the actual message that you want to send in the Command 
section.

7. Tick the ‘Leave The Connection Open’ option if you want Myriad to 
leave the serial port open at the end of the message.

8. Tick the ‘Use Existing Connection’ option if you want Myriad to make 
use of an open Com Port if possible.

Adding A TCP/IP Command

The TCP/IP Command option is very similar to the Serial Command in that 
when Myriad encounters one in the Log, it will send the specified message to 
a specified device only instead of using RS232 (serial) it will use TCP/IP to 
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send it over the network. This feature can be used for a wide variety of 
applications such as network monitoring or triggering external events.

Again, it is assumed that an understanding of TCP/IP technology is assumed 
in this section of the documentation.

To add a TCP/IP Command, follow these steps:

1. Give your TCP/IP Command a name using the Command Name field.
2. Make sure TCP/IP is selected from the Type drop down list.
3. Type in the IP address that you want Myriad to send the message to 

using the IP Address field.
4. Type in the Port Number that you want to use via the Port Number 

field.
5. Select either TCP/IP or UDP/IP using the Protocol drop down.
6. Type in the message you want to send using the Command field.
7. Tick the ‘Leave The Connection Open’ option if you want Myriad to 

leave the IP port connection open at the end of the message.
8. Tick the ‘Use Existing Connection’ option if you want Myriad to make 

use of an open IP connection port if available.

When you are happy, click on the OK button.

Editing An Existing Command

To edit an existing Command you have two options. You can either highlight 
the Command in the list and the click on the Edit Command button.
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Or you can double click on the Command itself.

In both cases, the Command Details window opens which allows you to alter 
the details for the selected Command.

Deleting An Existing Command

To delete an existing Command, highlight the Command in the list and then 
click on the Delete Command button.

You will be asked to confirm your actions before the Command is deleted. 
Click on Yes to delete the selected Command.

The Advanced Tab

The Advanced tab is home to some of the more advanced Myriad settings 
and as such, you should not really play with the settings in here unless you 
are confident that you know what you are doing. Unlike most of the tabs in 
Myriad Settings, the options on the Advanced Tab are not related to any 
specific areas in Myriad.
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Application Process Priority

This option allows you to alter the processing priority that Windows™ gives 
Myriad in normal operation. Under normal circumstances, Myriad should be 
given Normal Priority but if you are running several other applications on the 
same PC and you want Myriad to take priority over the other applications, it 
might be worth putting Myriad’s priority up a notch.

There are four options in total but you should only alter this setting if directed 
to by a P Squared Technical Support engineer.
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Configuration Profiles > Manage

Configuration Profiles allow you to effectively save the particular setup 
information and configuration options for Myriad to be reloaded at a later date.

In practice, the most common application for this is if you are running several 
different radio stations from a single Myriad system and the different stations 
use totally different Data Locations, Audio Wall File Locations and settings 
etc. In which case you could set up two profile (one for each) and each time 
you start Myriad, you select the Configuration Profile that you want to use.

Another common use for this is to have a ‘backup’ profile that is configured to 
use audio and data locations on a backup hard drive or backup server.

Profiles are added and managed using the Profile Manager window. To 
access this window, click on the Manage button.

Configuring Myriad To Have Multiple Configuration Profiles

The Profile Manager window is accessed via the Manage button on the 
Advanced tab of Myriad Settings and is used to switch Myriad to using 
multiple Configuration Profiles and to add and remove the available 
Configuration Profiles.

To configure Myriad to use multiple Configuration Profiles, select the ‘Allow P 
Squared Applications To Use Different Configuration Sets (Profiles)’ option. 
This will also enable the main Profile Management window which list available 
profiles and allows you to add and delete Profiles.

To add a new Configuration Profile, click on the Add Profile button.
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You will then be asked to provide a name for your new Profile.

Once you have typed in the new Profile name, click on OK.

You will then be asked to confirm that you want to create the new 
Configuration Profile. Click on Yes to create the new Profile.
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Next time you quit Myriad and then restart it, you will be asked which Profile 
you wish to use.

Once you have loaded Myriad with your new Profile, any changes you make 
to the configuration will be stored in the settings for the selected Configuration 
Profile.

You can switch back to using a single Configuration Profile by selecting the 
‘Only Allow One Set Of Configuration Options’ option (at the top of the 
window). In this case, the highlighted Configuration Profile will be used.

You can edit the description for a Configuration Profile by clicking on the Edit 
Profile button.
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This will then allow you to ‘over type’ your new Profile name.

Finally, you can delete a Configuration Profile by highlighting it and then 
clicking on the Delete Profile button.
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You will then be asked to confirm that you wish to delete the selected Profile.

If you click on Yes, the Configuration Profile will be deleted immediately and 
there is no way to recover deleted Profiles.

Global Settings > Debugging Level

This is a Global Setting and it applies to all Configuration Profiles. 

This setting allows you to set an overall level of debugging mode in Myriad 
which is a special mode where lots of information is logged to a text file that P 
Squared engineers can use to track down system faults.

In general, Myriad should be run with the ‘No Debugging Information Will Be 
Generated’ option selected. In this mode, Myriad does not keep track of 
debugging information and does not generate debug files.

If you are experiencing problems, a P Squared Technical Support Engineer 
may ask you to switch to ‘Create Normal Amounts Of Debugging Information’ 
mode where Myriad keeps track of a number of key factors and generates 
modest debug files that can be sent to P Squared in the event of a problem. In 
this mode, Myriad will run fractionally slower but the difference should be 
marginal.

As a note, if you are asked to run in debug mode to track a particular problem. 
You should stop Myriad as soon as the problem occurs and then copy all of 
the debug files (found in the root of the C drive and called smplayer1.dbg to 
smplayerX.dgb) to a safe place ready to be sent to P Squared. The reason for 
this is that Myriad over-writes debug files once they reach a certain size so 
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useful information could be lost if you do not copy the files as soon as the 
problem occurs.

The ‘Create Maximum Amounts Of Debug Information’ option should only be 
used in extreme circumstances as a great deal of information will be recorded. 
Myriad is not likely to perform to a satisfactory level while in this state.

Automatic Logon Settings (for logging in to Windows™)

Myriad has the ability to configure your overall Windows™ system to 
automatically login to Windows™ using a specific Login Name and Password.

This is important because if you have a Myriad workstation running in 
automation and there is a power cut. Myriad can be configured to 
automatically detect this and restart in automation in the appropriate place in 
the Schedule Log. 

This ability is dependent on two factors however. Firstly, someone or 
something needs to log in to Windows™ in order for any applications to run 
and secondly, Myriad needs to be in the ‘start up group’ so it is automatically 
launch when Windows™ loads. The second is easily achieved by copying the 
Myriad shortcut in to the Start Up section of the Start bar. The first can be 
achieved by using this configuration option to supply Myriad with a username 
and password to automatically log in to Windows™ with.

To set the login name and password you want Myriad to log in to Windows™ 
with, click on the Change button.
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This will open the Windows Automatic Logon window which allows you to 
enter the Username, Password and Domain that you want to use. To enable 
this option you will also need to tick the Automatically Logon option.

You will see that the Advanced tab is updated to display the information that 
Myriad will use to login to Windows™.

Myriad Will Not Update The Time And Date For The Computer

If this option is set then Myriad will not attempt to update the computer time 
and date and the standard system time and date will be used for displaying 
time and AutoFade Playout Mode by Myriad.

It is recommended that you have a central time and date server (which can be 
any PC) which is either using a radio clock or is getting it’s time from a web 
time server. All of the other PC’s can the ‘sync there time from that.

An explanation on how to set up a PC as a ‘time server’ and then synchronise 
all the other PC’s from that can be found on the P Squared Forums which you 
will find at http://forum.psquared.net

Myriad Should Automatically Update The Date And Time Using

This setting should be enabled if you have a P Squared supplied Galleon 
Rugby Radio Clock attached to your system via a serial port. If you have 
purchased one of these radio controlled clocks (or sourced the same model 
from another company) then you should enable this option.

http://forum.psquared.net/


417

Once the clock is attached to a valid Com Port, ensure that Galleon PC Serial 
Time / Date is selected from the drop down list and select the correct Com 
Port using the ‘Connected To’ drop down list.

Once you are happy it is all connected and configured correctly, you can test 
that the clock is getting a strong enough signal by clicking on the Test button.

The Test Radio Clock window shows the strength of the radio signal that the 
Radio Clock is receiving. You will need to get a fairly constant 60% or greater 
for the clock to function. When you first open the window, the signal will 
appear erratic. It will take approximately 1 minute to settle down to a valid 
indication of the signal strength. If you are getting less than 60% then you 
should consider repositioning the clock to get a better signal. If the reading 
remains on 0% then check that the batteries in the clock are fitted correctly 
and that you have configured Myriad to use the correct Com Port.

When you are happy with the signal strength, click on OK.

License Details

Please note that Myriad Manager uses the Myriad license code so you do not 
have to enter a separate license code for Myriad Manager.

The License Details option on the Settings Menu offers access to the Myriad 
License Wizard which is used to enter the initial license code for Myriad as 
well as subsequent annual (or more regular) license codes which are issued 
by P Squared as an anti-piracy measure.
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Selecting this option will open the P Squared Software License Wizard which 
will walk you through the process of entering an initial license or renewing an 
existing license.

Myriad v3 uses an advanced licensing system to prevent software piracy and 
to safeguard the future of Myriad™ and other P Squared Ltd products.

The advanced licensing procedure generates a special code (called a 
PSQUISH) that is unique to your computer. The first time that you activate 
Myriad you will need to provide this code to P Squared Ltd in order to 
complete the licensing process. Subsequent codes can be obtained 
automatically (assuming you have web access) but you may have to contact 
P Squared Ltd periodically in the future. 

Manually Obtaining A License Code

The standard licensing procedure for manually obtaining a license code is:

1. Select the License Code option from the Tools menu. The License 
Wizard will run automatically the first time that you run Myriad or if you 
run Myriad once your license has expired,

2. If this is the first time that you have licensed Myriad or you have not 
ticked the option to skip the introduction screen the last time you 
entered a license code, the introduction screen will be displayed.
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3. Read the screen, the tick the “Skip this screen in the future” option 
unless you want to read this introduction each time. The click on Next.

4. You will then see a summary of the current license status of Myriad. In 
the example below, you can see that we currently have a valid license 
that is not due to expire for some months. If you are entering a license 
for the first time then this information will be blank. If you wish to 
proceed, click on the Next button.
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5. If you do not need to license Myriad, the License Wizard will warning 
you before you proceed to the next screen, if you want to proceed 
anyway then click on OK.

6. The next phase is to enter your registration details. You will only have 
to do this the first time; the information will be loaded automatically on 
subsequent license procedures

The first thing that you have to enter is your P-SQUID or P Squared 
Unique ID which is your P Squared unique customer ID and will be 
provided by P Squared. Your P-SQUID will be at the top of all quotes, 
or purchase orders that you receive from P Squared and should be 
quoted whenever you contact P Squared. To enter or alter your P-
SQUID, click on the Change button and type in the new P-SQUID

Next add in your contact details by clicking on the Change button by 
the contacts summary window.
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You are required to enter your name and a valid email address; these 
details will be used when processing requests for ‘online’ license 
renewals in the future. You may also fill in the additional information if 
you wish. Once you have finished, click on OK to return to the main 
wizard and then click on Next to move on to the next step.

7. The next step in the license wizard allows you to enter the License 
Name and Features Code for the product. Both of these will be 
provided by P Squared with the purchased product or we can give you 
the details over the phone.
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Type in the License Name exactly as it is give to you by P Squared and 
then click on the Set button. Repeat the same procedure for the 
Features Code.

N.B. It is possible to obtain a Features Code ‘online’ by clicking on the 

 button. When you select this option, the progress of the ‘online’ 
Features Code generation is shown on screen and if a code is 
successfully generated, it will be added to the Wizard window. Please 
note that this option will generally only be available to existing 
customers who have licensed Myriad previously.
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Once the License Name and Features Code have been set, you can 
alter them by clicking on the appropriate Change button. If you are 
happy, however, click on Next to proceed.

8. The next screen allows you to choose the method that you want to use 
to obtain your Myriad license code.
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Each option is explained on screen as you can see from the image 
above.

In this case, let’s assume that we want to manually enter the code and 
we intend to phone P Squared to give them details needed to activate 
the product. Select ‘Manually Enter A New License Code’ and then 
click on Next.

9. The next screen displays the P-SQUISH code which is a unique code 
that is used to generate your Myriad license. The P-SQUISH is unique 
to your contact, details, the PC you are working on and the time and 
date that you generate it.



425

The P-SQUISH is only valid for a few days so you should contact P 
Squared as soon as possible to let them have your P-SQUISH code. 
You can do this be either:

 Telephoning: +44 1482 383700
 Emailing: licenses@psquared.net
 Faxing To: +44 1482 383701

Once P Squared have a valid P-SQUISH code, they will then provide 
you with a License Code that you need to type in to the New License 
Code part of the screen before finally hitting Finish.

10.Clicking on Finish will end the licensing process. A short summary 
screen will be displayed before you can proceed on to using Myriad.

mailto:licenses@psquared.net
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Automatically Obtaining A License Code

In general, the first license code that you receive will have to be processed 
manually but once all your details are registered with P Square, subsequent 
licenses can be obtained ‘online’ without the need to contact us. This means 
that you can renew your license at your convenience providing that your PC 
has a web connection. 

To obtain a license code ‘online’, follow these steps.

1. Select the License Code option from the Tools menu.
2. The introduction screen is usually skipped when renewing a license. In 

this case, the first screen you will see is the Current License Details 
screen which shows you when the current license was entered and 
when it is going to expire.
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3. Click on Next to move on to the P-SQUID and Personal Details screen. 
You only need to alter the information on this screen if it has changed. 
If not, click on Next to move on to the next screen.

4. Next you will see the License Details screen. Again, unless you need to 
need to alter any of this information, you can click on the Next button to 
move on to the next window.
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5. The License Method window allows you to select the way in which you 
want to obtain your License Code. In this case, we want to renew the 
license online so we need to make sure ‘Obtain A License Code 
Online’ is ticked and then click on Next.

6. Finally, you will see a brief summary screen before Myriad attempts to 
obtain a license ‘online’. Click on Finish to begin the process.
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At the end of the process, you will be told whether your license code 
was successfully renewed or whether you need to contact P Squared 
to continue the licensing process.

For more information on P Squared product licensing, please refer to 
www.psquared.net/support as well as your P Squared Software 
License Agreement.

http://www.psquared.net/support
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The Help Menu

The Help Menu option in Myriad Manager offers access to information about 
the latest updates to Myriad as well as shortcuts to the P Squared web sites, 
discussion forums and online technical support resources.

In addition to this, the Help menu also offers access to the P Squared Support 
File generator which is a special tool that can be used to compile a report that 
can be automatically uploaded to P Squared. These support files contain a 
whole host of information about your system and can be used by P Squared 
engineers to help pinpoint problems with your system.

Finally, the Help Menu offers access to a specially formatted version of this 
manual that can be downloaded and added to your system to allow Users to 
browse the documentation while using Myriad.

Myriad Manager Help System

This option is only enabled if you have downloaded the specially formatted 
version of this documentation and copied it to the applicable folder in your 
Myriad Data Location.

If this option is available, click on it to load a help file version of this manual 
but keep in mind that it is a very big document so it is probably not a good 
idea to be browsing while you are broadcasting ‘live’ from the same 
workstation.

Create P Squared Support File

Clicking on the Create P Squared Support File option will open the Create P 
Squared Support File window which allows you to add in the all the 
information that you need in order to create a P Squared Support file. Some of 
this information will be supplied by the P Squared Technical Support Engineer 
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that requests the file in the first place. The details you need to enter are 
outlined below.

P Squared Support ID

This is a unique ID number that is assigned by P Squared for the support 
issue that you are currently working on. Every time you contact P Squared 
with a new technical support enquiry, the P Squared support system 
automatically assigns a unique ID number that allows us to track your support 
issue, recall the details if you contact us again and to ensure that we do not 
have issues that go unresolved. 

You will usually be generating a Support File at the request of the Technical 
Support Engineer who is dealing with your enquiry and they should provide 
you with the Support ID for issue you are working on when they request the 
Support File. You will also find the Support ID at the top of all emails you 
receive with respect to the issue you are working on. If you do not have a 
Support ID, please contact P Squared prior to generating the Support File.

Send Cart Play Log Files

If you tick this option then Cart Play Log files for the selected dates (see Start 
/ End Date) will be included in the Support File that is generated and sent to P 
Squared. You should include Play Log Files for a day either side of the dates 
that your issue occurred.
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Start / End Dates

You can use these settings to set the Start and End Dates for the Play Logs 
that you want to be included in the Support File being generated.

Use the drop down option to select the dates that you want to include.

Send Audio Wall Information

Ticking this option will include the special Cart List files that Myriad uses to 
search and display the Carts on your Audio Wall. It is worth including this 
information in all Support Files generated as they do not make a big 
difference to the size of the support file but give P Squared a great deal of 
information about your system.

Send P Squared Directory

This option will include the P Squared Directory database as part of the 
Support File being generated. Normally, this option would only need to be 
ticked if your support issue is related to Users or User History but the P 
Squared Directory does contain a great deal of information so under some 
circumstances, the Support Engineer may request that you include it even if 
the link is not apparent.

Send Station Database

This option will be used in the majority of cases as ticking it includes the 
Station Database in the Support File bring generated and as the Station 
Database includes the Schedule Log and a great deal of the settings for 
Myriad, it will normally be essential in tracking down the majority of problems 
in Myriad. 

When you tick this option, you then have to select the Station Database that 
you wish to send using the Choose button.
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Clicking on this button will open the Choose Database window.

Highlight the Station Database that you want to include in the Support File 
and then click on OK.

Send Cart

This option allows you to specify a specific Cart to be included in the Support 
file being generated. If you are having problem with a specific Cart then it is a 
good idea to include it in the Support File.

Select the option and the type in the Cart Slot Number of the Cart you wish to 
include.
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Reason For Sending Support File

This field allows you to type in a brief summary of the reason for generating 
the Support File. Normally, you would be asked to generate a Support File as 
part of an ongoing support issue and the Support ID will identify the support 
issue so P Squared will already know what the support issue is about, but it is 
a good idea to write a quick summary to avoid any confusion.

Edit Personal Details

The Support File generated contains a range of additional information on top 
of the options selected (such as registry keys etc). One of the information 
types included in the Support File are the contact details of the person 
sending the Support File. By default, Myriad will use the Contact Details 
entered when you initially licensed the product but you can alter this 
information by clicking on the Edit Personal Details button.

When you are happy with the personal details that will be sent, click on the 
OK button.

Make File

The Make File button is used to actually generate the Support File.
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While Myriad is working to generate the Support File, you will see a progress 
bar along the bottom of the screen showing how far there is to go. You can 
click on Stop to abandon the process if you wish. 

Once the process is finished, you will be asked whether you wish to 
automatically upload the Support File to P Squared.

If the workstation you are working on has a web connection then you can click 
on Yes and Myriad will automatically upload the file to the special support FTP 
site. This is then accessed directly by the P Squared internal support system 
and support engineers are alerted to its arrival.
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Depending on the size of the Support File, the Station Database and any 
Carts Included, the process can take anything from a few minutes to several 
hours. Progress is displayed along the bottom of the window and you can 
abandon the send process by clicking on Stop if you wish.

Once the Support File has been uploaded, you get a message confirming that 
it was successfully sent.

If you do not have a web connection on the PC you are working on then you 
need to select No. 
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If you select No then you can choose a file name and location for the Support 
File. You can then send it to P Squared as an email or burn nit to disk to be 
sent at your convenience.

Support Files are a vital part of the technical support offered by P Squared so 
being familiar with this section of Myriad is a good idea.

Update Information

Each time you install a new version of Myriad, there is an RTF (text) file that is 
installed at the same time that outlines all the changes, new features and bug 
fixes that the new version includes.

The Update Information option provides access to this file from within Myriad. 
Clicking on this option will open the Update Information window.
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It is a good idea to read this document each time you install a new version of 
Myriad as it will familiarise you with any new features or facilities included with 
the build and alert you to any bugs that have been fixed.

P Squared On The Web

The P Squared On The Web option expands to offer access to a range of P 
Squared related web sites. To access these sites you will need a web 
connection on the PC you are working on.

The options are:

 P Squared Forum – Access the online P Squared discussion forum 
where you will find a wealth of information about all P Squared 
products and an opportunity to share your questions / views with other 
P Squared users as well as the P Squared Support Team.
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 Online Technical Support – Direct access to the P Squared support 
site which offers product downloads, documentation and general 
support advice.

 Licensing Information – Provides information on P Squared licensing 
policies and procedures.

 P Squared Home Page – Access to the main P Squared web site 
which includes the latest news and product information, pricing and 
access to the support and forum sites.

About Myriad

The About Myriad option on the Help Menu offers access to the About Myriad 
screen which displays a range of information about the build of Myriad that 
you are running on, the PC platform that you are using and license name and 
PSQUID that the product is licensed to.

The principle reason for access this information is to check the Myriad version
number you are running.

This window also offers access to the P Squared support site and direct email 
access to P Squared Technical Support Engineers.

Click on OK to close the About Myriad window.

Common Questions & Trouble Shooting

Commonly Asked Questions

Whilst we have finished with the Settings Menu as a whole, it may be useful to 
go though a few of the most commonly requested configuration options to 
save you trawling through the menu system to find the one option you want. In 
this section we will cover some of the most common configuration questions 
step by step. It assumed that you have already reviewed the options in the 
Settings menu and are familiar with all the concepts.

The list above is by no means exhaustive but it does cover some of the more 
commonly asked questions regarding configuration of Myriad. Remember, 
you can always visit the P Squared Forum (www.forum.psquared.net) if you 

http://www.forum.psquared.net/
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have a question that you want to ask but before you do so, please take a few 
minutes to browse the existing posts as it is possible somebody has already 
asked the exact same question and the answer is already waiting for you.

How Do I Change The Cart Size And Text Size On A Per User Basis?

1. Click on the Tools Menu and select Customise Myriad.
2. Click on the Audio tab on the vertical tab strip.
3. Click on the Cart Display tab on the horizontal strip.
4. Set the new Maximum Width (in pixels) to change the horizontal width 

of the Carts on the Audio Wall.
5. Set the new Maximum Height (in pixels) to change the vertical height of 

Carts on the Audio Wall.

6. Click on the Cart Font button  to access the Font Selection 
window.

7. Pick a new Font and Font Size and click on Ok.
8. Myriad has just been customised to have different size Carts for the 

User logged in.

How Do I Add Custom Options On The View Menu?

1. Click on the Settings Menu and select the Myriad Settings option.
2. Click on the View Menu tab.

3. Click Add View Options button  to open the View Options details 
window.

4. Type in the View Item Name (what will appear on the View Menu).
5. Type in the location of the HTML page you want to be displayed when 

the View Option is selected. It can be a local or remote HTML page.
6. Click on Ok. Your option has been added to the View Menu options.

How Do I Increase / Decrease The Amount Of Carts On My Audio Wall?

1. Click on the Settings Menu and select the Audio Wall File Settings 
option.

2. Next click on the Global Audio Wall Settings button at the bottom of the 
screen. This opens the Global Audio Wall Settings.

3. Make sure you are on the General tab of Global Audio Wall Settings.
4. Click on the Change button for the ‘Number Of Carts That Can Be 

Stored On The Audio Wall’ setting and type in the maximum number of 
Carts you want to use.

5. Click on the Set button.
6. The Audio Wall has now bee expanded (or contracted) as per your 

setting.
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How Do I Change The Amount Of Cart Players On My System?

1. Click on the Settings Menu and select the Audio Settings option.
2. Make sure that the Cart Players tab is selected.
3. Locate the ‘Number Of Cart Players To Use’ option (top option) and 

click on the Change button.
4. Type in the new number of Cart Players that you want to use in the 

provided field.
5. Click on the Set button.
6. You may also wish to manually assign a sound card output channel to 

any new Cart Players, this is done by selecting Manually Assign and 
then using the drop down lists to assign sound card channels to Cart 
Players.

7. When you are done, click on OK.

How Do I Change The Audio Quality & Format For Recording?

1. Click on the Settings Menu and select the Audio Settings option.
2. Select the Recording / Editing tab.
3. Locate the ‘New Audio Will Be Recorded Using The Audio Format’ 

option (at the top of the window) and click on the Choose button to 
change the format.

4. Use the Choose Audio Format window to select the new audio format 
and quality.

5. Click on OK when you are done.

How Do I Change The Range Of Carts That Voice Tracks Are Recorded 
In To?

1. Click on the Settings Menu and select the Station Database Settings 
option.

2. Make sure that the General tab is selected.
3. Locate the Segue Editor / Voice Link Settings section (in the middle of 

the window).
4. Type in the Cart range that you want to use for Voice Tracks using the 

appropriate fields.
5. You can also alter the audio quality and format of Voice Tracks and the 

audio volume trigger level from this section should you wish to.
6. Click on OK when you have finished.

How Do I Alter The Normalisation Level For Audio Imported In To 
Myriad?

1. Click on the Settings Menu and select the Audio Wall File Locations 
option.

2. Click on the Global Audio Wall Settings button at the bottom of the 
window.
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3. Select the Importing Audio tab on the Global Audio Wall Settings 
Window.

4. Alter the ‘Normalise Imported Audio To’ setting in the Other Options 
section towards the bottom of the screen. 

5. You can also configure Myriad to get Title and Artist Information from 
the web on this tab.

6. Click on OK to save your changes.

How Do I Get Carts Played Recently To Be Marked On The Audio Wall?

1. Click on the Settings Menu and select the Myriad Settings option.
2. Switch to the Audio Wall tab.
3. Tick the option to ‘Display An Icon On Carts Played Recently’.
4. Type in the duration that you wish Carts to be marked for or 

alternatively, the amount of times that they could have been played.
5. Click on OK to save changes.

How Do I Re-License Myriad?

1. Click on the Settings Menu and select the License Details option.
2. Work through the License Wizard. If you get stuck, refer to the License 

Details section of the documentation but in most cases, reading the 
text on screen will answer your questions.

How Do I Upgrade To A Newer Build Of Myriad?

1. Make sure you are logged in as Administrator.
2. Download the latest version of Myriad.
3. Shut down Myriad on the workstation you are upgrading.
4. Click on the Start button and select Control Panel.
5. Double click on Add / Remove Programs.
6. Scroll down until you see P Squared Myriad v3 and click on the 

Remove button.
7. Don’t worry, none of your data will be lost, you will not have to re-

configure and your license code details will be retained.
8. Once Myriad has been removed, run the new Myriad installer program.
9. Follow the on screen instructions to complete the installation process.
10.That should be it.

Myriad Locks Up When Using Cart Players 2 And Above, What Am I 
Doing Wrong?

This is by far the most commonly asked question in technical support and 
sadly it is a fault with the sound card drivers that we sometimes use. If you are 
using either an Echo card (Gina, Darla, Mia or Layla 3G) then the chances are 
that there is a setting incorrectly set in your driver settings that will be causing 
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all sorts of playback issues in Myriad. Thankfully the answer is simple and is 
outlined below.

This is caused by a setting called ‘Sync Wave Devices’ being set when it 
should be switched off for Myriad use. To change the setting, load up the 
Echo Audio Console and click on the Options or Settings button (it is different 
for different driver version numbers). Look around for the ‘Sync Wave 
Devices’ option and turn it off. You should find all your problems magically 
disappear.

Trouble Shooting

In this section we will deal with a few of the more common problems people 
have encountered setting up or operating Myriad. Some of the problems 
outlined below are related to hardware issues whilst others are configuration 
options but the end result is the same. If you are having a problem with 
Myriad then maybe this section will help you to resolve the issue.

If you do not find the thing you are looking for in this section, it is also worth 
checking the How Do I section in Chapter 8 which covers a range of common 
Myriad configuration questions.

Symptom: Myriad Locks Up When Playing Carts In Cart Player 2 Or 
Above

This is actually one of the more common problems we see with Myriad 
systems that are using either Layla 3G cards (or the older Echo Audio cards 
such as Gina 24, Darla 24 or Mia sound cards) or a Delta 10 / 10 (or Delta 4/4 
or 10/10 Lite). So basically, this problem can occur if you are using any of the 
sound cards recommended by P Squared in the last five years!

The problem is caused by a miss configuration of the soundcard drivers 
involving a setting which synchronises the all of the output channels so that 
they all start at the same time. This is idea for sound recording but rubbish for 
the type of playback that Myriad uses. The result is that when Cart Player 1 is 
playing, the other Cart Players are also able to play but when you try to play a 
Cart on a higher numbered Cart Player when Cart Player 1 is not playing, the 
sound card does not respond up which in turn makes Myriad appear to ‘lock 
up’.

Whether you are using an Echo Card (Layla 3G, Layla 24, Gina 24, Darla, 24, 
Mia or Indigo I/O) or a M-Audio Delta card (Delta 10/10, Delta 10/10 Lite, 
Delta 4/4) the cure for the problem is as simple as turning off the appropriate 
option in the drivers.

In theory, Myriad can be used with any multi-channel sound card in which 
each playback channel can be accessed independently (using multi client 
audio protocols) so your Myriad system may not be using one of the sound 
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cards listed above. The ‘sync audio devices’ setting is common on all sound 
cards which have been designed with sound recording in mind so there may 
well be an equivalent setting in your sound card driver settings but you will 
need to consult the sound card manufacturers documentation to find out how 
to alter it.

We will now look at how to correct the problem for both Echo Audio and M 
Audio based systems.

Solving The Problem With Echo Audio Sound Cards (Layla 3G, Gina 24, 
Darla 24, Mia and Indigo I/O)

1. Open the Echo Audio Console by going to Start => Programs => Echo 
Digital Audio => Console => Show All Console Windows, or from the 
Windows task bar. 

2. Click on the Settings button to access the Echo Audio card settings.
3. On the Driver tab make sure that the ‘Synchronise Wave Devices’ 

setting is NOT TICKED.

4. You may also want to make sure that the ‘Sample Rate Is Unlocked’ 
option is also selected.

5. Click on OK to close the window. You can now close the Echo Audio 
Console.

6. N.B. Some earlier versions of the Echo Audio drivers had a settings 
menu as opposed to the Settings button shown in this example. Either 
way, the Synchronise Wave Devices is the setting you need to make 
sure is not selected.

And that is it. You may have to restart Myriad but you should find that the 
playback problems all magically clear up.

In the past, we have had reports of this option being re-set without the User 
manually doing so. Although we have not been able to confirm this, it is worth 
checking this option if you see the symptoms outlined above, even if you 
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know you have not manually changed the settings and it was working OK 
before.

Please note that there are a number of other settings that you should alter 
from the default Echo Audio installation setup in order to properly configure 
your Echo Audio soundcard. Please refer to the Configuring An Echo Audio 
Sound Card appendix for more details.

Solving The Problem With A M-Audio Sound Card (Delta 10/10. Delta 
10/10 Lite, Delta 4/4)

1. Open the M-Audio Console which can be done by either double 
clicking on the M-Audio Console option on your computers Control 
Panel or by double clicking on the M-Audio Console icon on the ‘sys 
tray’ which is the section of your Start Bar to the right of the screen 
beside the clock.

2. Once you have the M-Audio Console open, click on the Hardware 
Settings tab.

3. Now make sure that the Multi Track Driver Devices option is set to 
Independent.

4. You may also need to set the Input levels between +4dB and -10dB but 
that depends on the audio equipment connected to the sound card.

5. When you are done, click on the Done button to close the window.

Please note that there are a few options that need to be changed from the 
default M-Audio installation setup in order for the card to operate correctly 
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with Myriad. Please refer to the Configuring A Delta Sound Card appendix for
more detail.

Symptom: Myriad Is Showing A ‘Database Format Is Not Recognised’ 
Error On Start Up

This error is reported when one of the databases that Myriad uses has been 
damaged or corrupted and is only displayed when Myriad is not able to read 
the database.

Myriad v3 uses two key databases, the Station Database (which contains 
settings and the Schedule Log) and the P Squared Directory database (which 
contains User settings and information). In both cases, seeing this error will 
be rear as Myriad automatically compacts and validates both databases each 
time it starts up. That said, databases can from time to time become damaged 
by a PC not shutting down correctly or even a hardware error or fault.

The important thing to remember is that the damaged database is not the end 
of the world and you should be able to recover the database using the steps 
outlined below.

Repairing A Damaged Or Corrupted Database

1. TAKE A BACKUP OF YOUR DATABASE FIRST. It may seem like it 
is a little late but it is better to have a backup of a corrupted database 
that P Squared may be able to repair, than to not have a database at 
all. There are two databases in Myriad v3 that you may have to repair, 
they are the Station Database and the P Squared Directory Database. 
The default location for each database is shown below but keep in 
mind that the location of these databases is a configuration option so 
your system may be configured differently.

Database: Station Database - (previously known as Q-NXT) 
Default Folder: D:\Myriad\System\Schedule 
Default File Name: Myriad3.mdb 

Assuming your Myriad Data Location is set to D:\Myriad\System (see 
Settings Menu > Myriad Settings > Data Location

Database: P Squared Contacts and Users Directory (previously Users) 
Default Folder: D:\Directory 
Default File Name: Directory.mdb

Assuming your P Squared Directory Location is set to D:\Directory (see 
Settings Menu > P Squared Directory Settings > Path)
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To take a backup of either of these files, use My Computer to browse 
to the appropriate location and then simply copy the .MDB file to a 
backup location just in case something goes wrong.

2. Next you need to make sure that you quit from Myriad on ALL THE 
WORKSTATIONS at your station. This includes all studios, any office 
machines with Myriad installed and playout workstations. If Myriad is 
left running anywhere on your system then the repair will not be able to 
be performed and potentially you could further damage the database 
you are trying to repair. Also, if you are repairing the P Squared 
Directory you will also have to shut down any Scoop workstations 
(including Scoop Cpature) any AutoTrack or AutoTrack Pro 
workstations and any copies of Powerlog Client that you are running. In 
all cases, you just have to quit the P Squared application, shutting 
down the box will not be necessary.

3. Next, run the Myriad Emergency Recovery Utility (Start > Programs > P 
Squared Myriad v3 > Utilities > Emergency Recovery Utility.

4. You will be warned that you should only use this utility if you are unable 
to use Myriad to make changes to your setup. In this case, the 
corrupted database may well be preventing you from accessing Myriad.

Click on the Yes button to continue to the Emergency Recovery Utility.
5. Next click on the Repair Database button.
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6. Use the Browse For File window to browse to the location of the 
database that you want to repair. Once the database you want to repair 
is selected, click on the Open button.

In this example, we will be repairing the P Squared Directory database.
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7. You will be asked to confirm that you want to repair / compact the 
selected database.

Click on Yes to continue.

8. You will next get a warning that applications that use the database 
must not be running on any PC in the building. Remember that the P 
Squared Directory is also used by Scoop, AutoTrack, AutoTrack Pro 
and Powerlog Client so they will all have to be shut down also.

Click on the Yes button to proceed.

9. Myriad will then compact and repair the selected database. This can 
take anything from a couple of seconds to several minutes during 
which time the computer may appear to have stopped responding. 
Please be patient as Myriad will inform you when process has been 
completed.

Myriad will also create it’s own backup which you can delete later when 
you are happy that everything is OK but it is better to have your own 
backup anyway.

If Myriad reports a problem with this process then the best thing to do 
is contact P Squared Technical Support (support@psquared.net) as 
soon as possible.

mailto:support@psquared.net
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10.  You should now be able to close the Emergency Recovery Utility and 
go back in to Myriad (Scoop, AutoTrack etc) as normal.

Symptom: When Myriad Fades Carts Out It Does Not Sound Right (fades 
out quickly at first or slowly at first)

There are two common symptoms that people with relation to fading of Carts 
not sounding right. They are:

 When Myriad fades a Cart, nothing seems to happen for the first 
second or so, then the Cart fades out really quickly.

 When Myriad fades a Cart out, the volume drops to virtually nothing 
almost immediately but then fades out slowly for the remainder of the 
fade period.

Both of these symptoms are caused by the way the sound card drivers fade 
change the volume of audio when Myriad instructs it to lower (or raise) the 
playback volume.

Under normal conditions Myriad fades Carts out in a linear fashion so that it 
starts at 100% of full volume, then fades it down steadily to 0% volume. This 
assumes that the sound card performs in the same way but some sound 
cards do what is called logarithmic fading which is where the rate at which the 
audio fades out is not constant across the entire duration of the fade. If this is 
the case then Myriad tells the card to fade to 90% of volume but because the 
drop in volume between 100% an 90% is much greater then the drop in 
volume from 90% to 80% the overall affect is that you get a very fast and 
rough sounding fade out. This is not good for automation because it relies on 
smooth fading to sound ‘live’.
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Setting Myriad To Counteract Logarithmic Fades On Sound Cards 

Thankfully, we can alter the way in which Myriad fades out to do the opposite 
to the sound card so you effectively get a linear fade again. To do this, follow 
the steps below.

1. Click on the Settings menu in Myriad and select the Audio Settings 
option to access the Audio Settings window.

2. Click on the Advanced tab.
3. Click on the Advanced SmoothStream Settings button.
4. Click on the OK button when the SmoothStream Settings warning 

window appears. This window warns you that you should not be 
messing around with these settings unless you are sure about what 
you are doing. You are so click on OK.

5. Use the drop down Fade Mode option to select the Fade Mode that you 
want Myriad to use.

Normal Fading will make Myriad us a standard linear fade and is the 
default. The Start Fading Slowly Then Speed Up option should be 
selected if currently you system fades out Carts almost immediately. 
The Start Fading Quickly Then Slow Down option should be used if 
currently, you system appears not to fade the Carts at all until the very 
end of the fade period.

Select the setting that best suits your problem.

6. Click on the Save Settings button to return to the Audio Settings 
window and then click on OK to return to Myriad. Test out the fading 
and see whether you have set the right option, if not, go back and 
choose the other option.
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Symptom > Myriad Has Auto Configured The Cart Players I Want To Use 
Incorrectly

When run Myriad for the first time, the system attempts to auto-configure 
based on information that you give as part of the initial start up process and 
the hardware that is found in your PC.

One of the things that Myriad does do automatically is to attempt to ascertain 
the amount of Cart Players that it should set up for use based on the amount 
of valid sound card devices (or playback channels) that it can find. If you are 
using a Card that Myriad knows about (like a Delta 10/10 or a Gina / Layla) 
then Myriad should configure the correct amount of Cart Players and assign a 
playback channel to each Cart Player in turn (so Cart Player 1 uses outputs 1 
& 2 etc).

If however, you are not using one of the cards mentioned above, or you have 
several cards fitted to your PC, Myriad will attempt to configure your system 
based on ‘best guess’ but you may wish to manually alter the configuration to 
be the way you want it.

Manually Setting The Amount Of Cart Players & Which Sound Card 
Channels They Use

To manually change the amount of Cart Players that Myriad will display on 
screen, follow these steps.

1. Click on the Setting menu and select the Audio Setting option.
2. Make sure you are on the Cart Players tab.
3. Click on the Change button.
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4. Type in the amount of Cart Players that you want to use.
5. Click on the Set button.

Next we will see how to change the sound card channel that the Cart Player 
we have just added will use.

6. Make sure that Manually Assign Each Player A Suitable Device is 
selected in the Allocation Of Sound Devices To Players option.

7. Use the drop down list next to the Cart Player you have just added to 
select the sound device that you wish to use.
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Remember, several Cart Players can be assigned to the same sound 
device but fading will not work correctly (or more accurately, when 
Myriad fades a Cart Player, all other Cart Players sharing the sound 
device will be faded at the same time).

8. When you are happy, click on the OK button to return to Myriad.

Symptom > Data Location XXXX Can Not Be Found Error Message On 
Start Up

If Myriad is unable to locate either the Myriad Data Location folder or any of 
the Audio Wall File Location folders when it starts up, it will inform you via a 
message box.

Check Local Drive & Mapped Network Dives / Locations

If you see this message, it means one of two things has happened.
1. The local or network drive location is not accessible or is not 

functioning. If it is a local drive, check that the drive is functioning and 
that you can see it in My Computer. If it is a network location, check 
that the network location is accessible (using My Computer) and that 
the mapped network drive exists. If not then you may need to re-map 
the network drive (see below).

2. The other option is that the drive and folder are there but the data that 
Myriad needs is not. If this is the case then you may have to restore 
from your most recent backup. Please note that Myriad does not have 
the ability to delete key information such as the data locations so if 
important data has been deleted, it is most likely to be human error.

Remapping A Network Drive In XP

1. Double click on My Computer.
2. Click on My Network Places.
3. Click On Entire Network.
4. Double click on Window Microsoft Network (assuming you are using a 

Microsoft network).
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5. Double click on the network you want to access.
6. Double click on the computer that contains the location you want to 

map to (i.e. the server etc).
7. Right click on the resource you want to map to (usually a folder but can 

be a drive) and select Map Network Drive from the right click menu.

8. Select the drive letter that you wish to use for the mapped network 
drive and ensure that the Reconnect At Logon option is selected.

9. Click on the Finish button to complete the procedure.
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Mapped network drives are good for humans needing to be able to browse a 
network but they can be unreliable as Windows does seem to occasionally 
‘forget’ that they exist. Another option is to use UNC’s (\\servername\folder) 
which is harder for a person to use but more reliable for Myriad use. For 
details on UNC’s and Mapped Network Drives, please refer to the Mapped 
Drives V’s UNC’s section of Chapter 1.

Remember that the P Squared Forums (www.forum.psquared.net) provides a 
wealth of trouble shooting knowledge and if you can not find the answer to 
your question listed, you can always post a question and see what answers 
you get. To join the P Squared forum, visit the link above and follow the on 
screen instructions for signing up.

http://www.forum.psquared.net/
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